
 

 

 

 

PAC Mate Omni QX 
Series 

Owner’s Manual 
Version 6.5 

 

 

 

 

 

 

 

 

Freedom Scientific 
August 2010 

 



PUBLISHED BY 
Freedom Scientific 
11800 31st Court North 
St. Petersburg, Florida 33716-1805 
USA 
http://www.FreedomScientific.com 

Information in this document is subject to change without notice. No part 
of this publication may be reproduced or transmitted in any form or any 
means electronic or mechanical, for any purpose, without the express 
written permission of Freedom Scientific. 

Copyright © 2010 Freedom Scientific. All Rights Reserved. 

PAC Mate Omni is a trademark of Freedom Scientific in the United States 
and other countries. Microsoft, Windows 2000, Windows XP Home and 
Professional , and Windows Vista are trademarks of Microsoft 
Corporation in the U.S. and/or other countries. 

Federal Communications Commission Notice 

This equipment has been tested and found to comply with the limits for a 
Class B digital device, pursuant to Part 15 of the FCC Rules. These limits 
are designed to provide reasonable protection against harmful 
interference in a residential installation. This equipment generates, uses, 
and can radiate radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that interference will not 
occur in a particular installation. If this equipment does cause harmful 
interference to radio or television reception, which can be determined by 
turning the equipment off and on, the user is encouraged to try to correct 
the interference by one or more of the following measures: 

 Increase the separation between the equipment and receiver.  

 Connect the equipment into an outlet on a circuit different 
from that to which the receiver is connected.  

 Reorient or relocate the receiving antenna.  

 Consult the dealer or an experienced radio or television 
technician for help. 



Table of Contents 

Getting to Know Your PAC Mate Omni.....................................................1 

What is PAC Mate Omni?........................................................................1 
Documentation Conventions....................................................................2 
Using Windows Mobile with the PAC Mate Omni ....................................2 

Starting the PAC Mate Omni...............................................................3 
Keyboard Orientation and Basic Commands ......................................3 
Overview of Soft Keys.........................................................................6 
Today Screen Orientation ...................................................................7 
Program Layout and Menus................................................................8 
Working with Dialog boxes and Controls ............................................9 
Using the Search Feature .................................................................13 

Personalizing Your PAC Mate Omni......................................................13 
Entering Owner Information ..............................................................14 
Protecting PAC Mate Omni Information ............................................14 
Locating the PAC Mate Omni Serial Number....................................16 
Finding Firmware Information ...........................................................16 
Knowing About Windows Mobile.......................................................16 

Getting Help...........................................................................................17 
Control Help ......................................................................................17 
Context Help .....................................................................................17 
System Help......................................................................................17 
Keyboard Help ..................................................................................18 
WINDOWS Key Help ........................................................................18 

Using Online Help..................................................................................18 

PAC Mate Omni Basics............................................................................20 

Adjusting Speech Settings.....................................................................20 
Understanding Layered Commands ......................................................22 
Working with Text ..................................................................................23 

Typing in Braille.................................................................................23 
Inserting ASCII and Control Characters............................................26 
Reading.............................................................................................26 
Editing ...............................................................................................27 
Formatting .........................................................................................29 
Embossing ........................................................................................30 
Printing ..............................................................................................31 

Copying Files To and From Your PAC Mate Omni ................................31 
Adding Programs ...................................................................................32 
Removing Programs ..............................................................................33 



PAC Mate Omni Hardware ...................................................................... 34 

Ports and Switches ............................................................................... 34 
Battery................................................................................................... 36 

Checking the Available Battery Charge............................................ 36 
Resetting the PAC Mate Omni.............................................................. 37 

Performing a Warm Reset................................................................ 37 
Performing a Cold Reset .................................................................. 37 
Performing a Clean Reset ................................................................ 38 

Carrying Case ....................................................................................... 39 
General Care of Your PAC Mate Omni ................................................. 39 

Setting Up the PAC Mate Omni .............................................................. 40 

Braille Settings ...................................................................................... 40 
General Tab ..................................................................................... 40 
Languages Tab ................................................................................ 42 
Cursors Tab...................................................................................... 44 
Messages Tab.................................................................................. 45 
Focus Braille Display Options .......................................................... 46 

Buttons.................................................................................................. 46 
Dictionary .............................................................................................. 48 
HTML Settings ...................................................................................... 49 

Advanced HTML Settings................................................................. 51 
Input ...................................................................................................... 53 
Keyboard............................................................................................... 53 
Menus ................................................................................................... 54 
System Sounds & Notifications............................................................. 55 
Text Settings ......................................................................................... 56 
Today .................................................................................................... 58 
Verbosity ............................................................................................... 59 
Certificates ............................................................................................ 60 
Clock ..................................................................................................... 61 

Using the Alarm................................................................................ 62 
Changing Time Format..................................................................... 63 

Memory ................................................................................................. 63 
Freeing Memory ............................................................................... 64 

Power.................................................................................................... 65 
Recording Settings................................................................................ 66 
Regional Settings.................................................................................. 67 
Beam..................................................................................................... 68 

Connecting the PAC Mate Omni............................................................. 69 



Connecting with ActiveSync ..................................................................69 
Installing ActiveSync .........................................................................70 
(Optional) Configuring ActiveSync ....................................................71 
Creating a Partnership to Synchronize .............................................71 
Creating a Partnership in the Windows Mobile Device Center .........73 
Using Infrared with ActiveSync .........................................................73 
Troubleshoot an ActiveSync connection ...........................................74 

Connecting with a Network (Ethernet) Card ..........................................76 
Using a Network Card .......................................................................76 

Connecting with a Modem .....................................................................77 
Configuring the Connection Settings.................................................77 

Connecting to a Wireless Local Area Network ......................................78 
Using a Wireless LAN .......................................................................79 

Setting Up Your E-mail Account ............................................................81 
E-mail Settings (Optional) .................................................................83 

Ending a Connection .............................................................................84 
Bluetooth................................................................................................84 

Create a Bluetooth Partnership.........................................................86 
Configure an Outgoing COM Port .....................................................88 
Delete a Bluetooth Partnership .........................................................88 

Beaming Information..............................................................................89 
Receiving a Beam on the PAC Mate Omni .......................................90 
Deactivating the Infrared Port ...........................................................90 

Using PAC Mate Omni Programs............................................................92 

ActiveSync Remote PAC Mate ................................................................93 

Note to Users.........................................................................................93 
What Is ActiveSync Remote PAC Mate?...............................................93 
Getting Started.......................................................................................93 
Establishing a Remote Connection........................................................94 

Multiple Voice Languages .......................................................................96 

RealSpeak Solo Voices............................................................................98 

Multiple Braille Languages....................................................................100 

Braille Study Mode .................................................................................102 



Reader Mode .......................................................................................... 103 

File Explorer........................................................................................... 105 

Using File Explorer.............................................................................. 105 
Moving or copying a file(s) to a CompactFlash® card: ....................... 106 
Sorting files by their type:.................................................................... 106 
Creating a new folder:......................................................................... 106 
Network Log On .................................................................................. 107 

Messaging .............................................................................................. 108 

Downloading E-mail Messages........................................................... 108 
Reading E-Mail ................................................................................... 109 
Composing and Sending a Message .................................................. 109 
Replying or Forwarding a Message .................................................... 110 
Attaching a File to an E-mail Message ............................................... 110 
Receiving Attachments ....................................................................... 110 
Receiving Meeting Requests .............................................................. 111 
Opening a Meeting Request ............................................................... 112 
Printing Messages .............................................................................. 112 
Moving Messages ............................................................................... 112 
Deleting Messages ............................................................................. 113 
Clearing Messages and Folders ......................................................... 113 
Changing Message Options................................................................ 113 
Changing Storage Options.................................................................. 114 

Contacts ................................................................................................. 115 

Creating or Editing a Contact.............................................................. 115 
E-mailing a Contact............................................................................. 116 
Finding a Contact................................................................................ 116 
Changing Contacts Options ................................................................ 117 

Tasks ...................................................................................................... 118 

Creating a Task................................................................................... 118 
Editing a Task ..................................................................................... 119 
Setting a Reminder for a Task ............................................................ 119 
Adding a Note to a Task ..................................................................... 119 
Making a Task Recurring .................................................................... 120 
Completing a Task .............................................................................. 121 
Changing Tasks Options..................................................................... 121 



Calendar ..................................................................................................122 

Creating or Editing an Appointment.....................................................123 
Viewing Appointments .........................................................................123 
Creating an All Day Event....................................................................124 
Making an Appointment Recurring ......................................................124 
Setting a Reminder for an Appointment...............................................125 
Adding a Note to an Appointment........................................................126 
Sending a Meeting Request ................................................................127 
Changing Appointment Options...........................................................128 
Using the Calendar View .....................................................................128 

Notes .......................................................................................................129 

Viewing Notes......................................................................................129 
Creating or Editing a Note ...................................................................129 
Creating a Template ............................................................................130 
Creating a Note with a Template .........................................................130 
Creating a Recording...........................................................................131 
Find a Note ..........................................................................................132 
Attaching a Note to E-mail ...................................................................132 

Calculator................................................................................................133 

Entering Equations ..............................................................................133 
Clearing the Calculator ........................................................................133 

Internet Explorer Mobile ........................................................................134 

Reading and Moving through Web Pages ...........................................134 
Text .................................................................................................134 
Links................................................................................................135 
Headings .........................................................................................137 
Tables .............................................................................................138 
Forms..............................................................................................139 
Frames ............................................................................................141 

Changing Your Home Page.................................................................141 
Changing Security Options ..................................................................142 
Synchronizing Favorite Links...............................................................142 
Viewing Favorites ................................................................................142 
Adding/Deleting a Favorite Link...........................................................143 

FSEdit ......................................................................................................144 

Saving a Document .............................................................................144 



Revert To Saved ................................................................................. 145 
Opening a Document .......................................................................... 145 
Opening a Second Document............................................................. 146 
Switching Between Two Open FSEdit Files........................................ 147 
Braille Input ......................................................................................... 147 
Continuous Braille Mode..................................................................... 148 
Connecting to an Embosser................................................................ 148 
Embossing a Document...................................................................... 149 

Number of Copies .......................................................................... 149 
Emboss Settings ............................................................................ 150 
Changing Emboss Settings ............................................................ 150 
Embossing Using an Infrared Connection...................................... 151 
Resetting the Embosser’s Default Settings .................................... 152 

Printing Documents............................................................................. 152 
Number of Copies .......................................................................... 152 
Changing Printers........................................................................... 153 
Choosing Port Settings................................................................... 153 
Choosing Paper Size...................................................................... 154 
Selecting a Print Range.................................................................. 154 
Page Orientation ............................................................................ 155 
Draft Mode...................................................................................... 155 

Uncontracted Braille vs. Contracted Braille ........................................ 155 
Mark Emphasis Text ........................................................................... 156 

Disabling Mark Emphasis Text....................................................... 156 
Selecting Text vs. Marking Text.......................................................... 156 

Marking Text................................................................................... 157 
Trading Mark and Cursor Positions................................................ 157 
Selecting Text................................................................................. 157 

Cut Text .............................................................................................. 157 
Copy Text............................................................................................ 158 
Paste Text........................................................................................... 158 
Delete Text.......................................................................................... 158 
Find ..................................................................................................... 159 
Replace............................................................................................... 159 
Formatting a Document ...................................................................... 159 
Inserting Text ...................................................................................... 160 
Checking Spelling ............................................................................... 160 

Editing the User Dictionary............................................................. 162 
Word Count......................................................................................... 162 
Cursor Position ................................................................................... 162 
Move Cursor Position.......................................................................... 163 



FSCalc .....................................................................................................164 

Entering Equations and Expressions...................................................164 
Reviewing the History ..........................................................................165 
Saving the Calculation .........................................................................166 
Clearing the Calculator ........................................................................166 
Arithmetic Examples ............................................................................166 
Volatile and Non-Volatile Memory .......................................................167 
Conversion Example............................................................................169 
Statistical Example ..............................................................................169 
Financial Examples..............................................................................170 
Operator and Function Tables .............................................................173 

Operators ........................................................................................174 
General Functions - Display............................................................174 
General Functions - Memory...........................................................175 
Trigonometric Functions..................................................................176 
Hyperbolic Functions.......................................................................183 
Math Functions................................................................................184 
Statistical Functions ........................................................................190 
Base Conversions ...........................................................................193 
Conversion Functions .....................................................................195 
Financial Functions .........................................................................200 

FSReader.................................................................................................205 

The FSReader User Interface..............................................................205 
Opening a File in FSReader ................................................................205 
Exploring the Menus ............................................................................206 

File Menu ........................................................................................206 
Audio Menu .....................................................................................206 
Navigation Menu .............................................................................207 
Help Menu.......................................................................................208 

Reading RFB&D Books .......................................................................208 
Other DAISY Books .............................................................................208 

Stopwatch ...............................................................................................209 

Using the Elapsed Timer .....................................................................209 
Using the Countdown Timer ................................................................209 
Reading the Timer ...............................................................................210 

Windows Media Player...........................................................................211 

Overview of the screens and menus ...................................................211 
Overview of the Playback screen commands .................................211 



Overview of the Now Playing screen commands ........................... 212 
Overview of the Library screen commands .................................... 213 
Switch between screens................................................................. 214 

Copying Sound Files to Your PAC Mate Omni ................................... 215 
Listening to Sound .............................................................................. 216 

Word Mobile ........................................................................................... 217 

Synchronizing Word Mobile Documents ............................................. 219 
File Conversion .............................................................................. 219 

Finding and Replacing Text ................................................................ 221 
Formatting........................................................................................... 221 
Checking Spelling ............................................................................... 222 
Saving, Renaming, Moving, and Deleting........................................... 223 
Printing a Document ........................................................................... 223 
Attaching a Document to E-mail ......................................................... 223 
Changing Default Options................................................................... 223 

Excel Mobile........................................................................................... 225 

Synchronizing Excel Mobile Workbooks ............................................. 226 
Attaching an Excel Mobile File to E-mail............................................. 226 

PowerPoint Mobile................................................................................. 227 

Windows Live Messenger ..................................................................... 228 

Gearing Up to Use Windows Live Messenger .................................... 228 
Signing In ............................................................................................ 228 
Messaging........................................................................................... 229 

Mundu Instant Messenger .................................................................... 230 

Gearing Up to Use Mundu IM ............................................................. 231 
Signing In ............................................................................................ 231 
Messaging........................................................................................... 231 
Mundu IM Keystrokes ......................................................................... 232 

AudiblePlayer......................................................................................... 233 

What is Audible? ................................................................................. 233 
Installing AudiblePlayer....................................................................... 233 
Navigating between Audio Programs.................................................. 233 
Navigating within Audio Programs ...................................................... 234 
Storage Cards..................................................................................... 234 



Resco Audio Recorder...........................................................................235 

What is Resco Audio Recorder?..........................................................235 
Installing Audio Recorder.....................................................................235 
Opening and Setting Up Audio Recorder for the First Time ................237 
Before Using Audio Recorder ..............................................................237 
Creating a Recording...........................................................................238 
Scheduling a Recording.......................................................................239 
Using the Voice Activation System ......................................................239 
Tagging a Recording ...........................................................................240 

Exporting Tags ................................................................................241 
Purchasing Audio Recorder.................................................................242 
Registering Audio Recorder.................................................................243 

Remote Display Control.........................................................................245 

Installing Remote Display Control........................................................245 
Using the Program...............................................................................246 

Contacting Freedom Scientific..............................................................247 

Corporate Headquarters ......................................................................247 
Sales Department ................................................................................247 
Technical Support................................................................................248 

Appendix A: PAC Mate Omni Commands............................................249 

General Commands.............................................................................249 
Quick Navigation Using Hardware Buttons..........................................251 
Dialog Box Navigation Commands ......................................................252 
Information Layer Keystrokes ..............................................................252 
Settings Layer Commands ..................................................................253 
Keystrokes for Reading and Navigating Text ......................................254 
Say All Commands ..............................................................................256 
Selecting, Copying, and Pasting..........................................................257 
Advanced Keystrokes ..........................................................................258 

Home Row Utility Keystrokes..........................................................259 
Online Help ..........................................................................................261 

Navigating Tables in Online Help....................................................262 
File Explorer.........................................................................................262 
Contacts...............................................................................................262 
Calendar ..............................................................................................263 

Calendar View.................................................................................263 
Tasks ...................................................................................................264 
Messaging ...........................................................................................264 



Notes................................................................................................... 265 
Internet Explorer Mobile...................................................................... 265 

Web Page Navigation Commands ................................................. 266 
Table Navigation Commands ......................................................... 267 

FSEdit ................................................................................................. 267 
Editing and Formatting Commands................................................ 268 

FSCalc ................................................................................................ 270 
Word Mobile........................................................................................ 270 
Excel Mobile........................................................................................ 271 
Stopwatch ........................................................................................... 272 
Windows Media Player ....................................................................... 272 
Windows Live Messenger ................................................................... 273 
D-pad Simulation Commands ............................................................. 274 
Audible Player..................................................................................... 274 

Appendix B: Special Considerations................................................... 276 

Lithium Polymer Battery...................................................................... 276 
Protecting Your Hearing...................................................................... 277 

Appendix C: Unsupported Items.......................................................... 278 

Appendix D: Alpha Braille Reference .................................................. 279 

Appendix E: Numeric Braille Reference .............................................. 281 

Appendix F: Grade 2 Braille Reference ............................................... 282 

Appendix G: Computer Braille Reference ........................................... 295 

Appendix H: PAC Mate Omni with a Braille Display........................... 298 

PAC Mate Portable Braille Display ..................................................... 298 
To attach and detach the Braille Display:....................................... 298 
Hotkeys .......................................................................................... 299 
Whiz Wheels .................................................................................. 301 
Cursor Routing Buttons .................................................................. 302 
Right and Left Advance .................................................................. 302 

Focus Series Display .......................................................................... 302 
Convenience Commands ............................................................... 303 
Braille Commands .......................................................................... 306 



Windows Commands ......................................................................307 
JAWS Commands...........................................................................310 
Whiz Wheels ...................................................................................312 
Advance Bars..................................................................................312 
Cursor Routing Keys .......................................................................312 

 





 

 1 

Getting to Know Your PAC Mate Omni 

Congratulations on your purchase of the PAC Mate Omni QX400. The 
QX400 is a Personal Data Assistant designed and developed by 
Freedom Scientific. The QX400 uses X-scale technology for higher 
performance and lower power consumption that results in a longer 
battery life.  

What is PAC Mate Omni? 

The PAC Mate Omni line of computers combines the Windows Mobile® 
6.0 operating system with JAWS® screen reading technology. It offers 
the latest in mobile technology making it a powerful, portable information 
management tool. The combination of blindness-specific features written 
by Freedom Scientific, the rich suite of information management tools 
provided by Microsoft, and the ability to install a wide range of Windows 
Mobile applications makes the PAC Mate Omni the ultimate PDA for blind 
people. 

Key features include: 

 JAWS screen reader for Windows Mobile 

 QWERTY keyboard 

 Intel® X-Scale 400 MHz processor 

 64 MB RAM 

 128 MB Flash memory 

 2 CompactFlash® Type II Card Slots 

 USB On-the-Go automatically sets the PAC Mate Omni to use Host or 
Client mode 

 ActiveSync 

 Standard Infrared Wireless Input and Output Port 

 Rechargeable Battery  
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 Internal microphone and external microphone jack allowing you to 
record quick voice notes 

 Built-in speaker and stereo headphone jack 

 Dual stereo mixer so you can listen to media files and JAWS at the 
same time 

Documentation Conventions 

 A plus sign (+) is used to indicate that keys are pressed together. For 
example, "Press CTRL+RIGHT ARROW to move to and read the next 
word." 

 A layered command is a two-part command. Press the keys in the first 
sequence, release them all, and press the keys in the second 
sequence. For example, "press INSERT+S, DOWN ARROW to 
decrease the volume." 

 The term program is synonymous with the term application and may 
be used interchangeably in this manual. 

 Another convention is the reference regarding the active state of an 
item. When an item is in the active state, this means that the PAC 
Mate Omni is focusing on the item and certain keystrokes performed 
affect that item. The PAC Mate Omni gives auditory feedback to 
indicate the active state.  

 In an effort to comply with the new BANA guidelines, the term 
contracted braille is synonymous with the term Grade 2 braille and the 
term uncontracted braille is synonymous with the term computer 
Braille. These terms are used interchangeably throughout this manual. 

Using Windows Mobile with the PAC Mate Omni 

Using Windows Mobile with the PAC Mate Omni is quite easy once you 
master the basic skills. It is recommended that you read and learn this 
section as it teaches you basic PAC Mate Omni skills needed to operate 
Windows Mobile.  
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Starting the PAC Mate Omni 

Before you start your PAC Mate Omni for the first time, plug the AC 
adapter into a wall plug and then plug the other end into the PAC Mate 
Omni's power jack found on the right back side of the unit. Next, press 
the On/Off switch, which is next to the power jack on the right. To indicate 
that it is on, the PAC Mate Omni uses an audible low high sound, and to 
indicate that it is off, it uses a high low sound.  

After a few seconds you will hear, "JAWS for Pocket PC is ready." 

You can immediately start using your PAC Mate Omni while it is 
charging, but, charge your battery for at least three hours before using 
your PAC Mate Omni without the AC adapter.  

Keyboard Orientation and Basic Commands 

The PAC Mate Omni QX400 keyboard consists of six rows of keys with 
the QWERTY keyboard complete in the first five rows from the bottom up. 
The bottom row, from left to right, includes: FN, CTRL, Windows Key, 
ALT, Backslash, SPACEBAR, INS, ALT, WINDOWS Key, and the 
APPLICATIONS Key.  

The 12 function keys follow the CLOSE button (ESC) key, which is the 
first key on the left in the top row. To help you stay oriented, there are 
three finger bumps on the QX400 surface, above and between the 
Function Keys: F4 and F5, F8 and F9, F12 and the PrtSc Key. 
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The arrow keys are in the lower right corner of the keyboard with the Up 
Arrow above the other three arrows. 

Along the right side of the keyboard, from top to bottom are the DELETE, 
HOME, PAGE UP, PAGE DOWN and END Keys. 

JAWS Laptop keystrokes have been used where possible and with the 
inclusion of the INSERT Key as the JAWS Key, experienced JAWS 
users should have no problem learning the PAC Mate Omni commands. 

To use THE PAC Mate Omni you only need to know the basic function 
keys and six common commands:  

  ESC (more commonly referred to as the CLOSE button) 

 F1 (activates the left soft key) 

 F2 (activates the right soft key) 

 ALT+F3 (announce current soft key assignments) 

 F6 (decrease system volume) 

 F7 (increase system volume) 
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 ALT (Menu Bar) 

 WINDOWS Key (Start Menu)  

 ARROW Keys (UP, DOWN, LEFT and RIGHT ARROW)  

 ENTER 

 SHIFT+TAB 

 TAB 

 CTRL (Stop Speech)  

 INSERT+S, UP ARROW (Increase Volume)  

 INSERT+S, DOWN ARROW (Decrease Volume)  

In addition, many of the PAC Mate Omni menus allow first letter 
navigation.  

These 15 commands are the foundation from which you will become 
familiar with your PAC Mate Omni. For more information on commands, 
please see Appendix A: PAC Mate Omni Commands. 

Another command you should get familiar with right away is the 
APPLICATIONS Key. This command activates the Context Menu, which 
allows you to quickly perform an action on an item. For example, you can 
use a Context Menu to cut, copy, select all, paste, delete or create a new 
folder. To access a Context Menu, select an item such as a word in a 
document, a date in the Calendar View, or a file in a list view and press 
the APPLICATIONS Key. Select a command from the Context Menu with 
the ARROW keys and press ENTER. Press the CLOSE button (ESC) to 
close the menu without performing an action. 

The PAC Mate Omni keyboard also has a NUM PAD layer. The NUM 
PAD feature is useful if you do a large amount of numerical data entry. 
Activate this feature by pressing FN+SCRLK. The FN key is the key in 
the lower left corner and the SCRLK key is the third key from the right in 
the top row. To deactivate the NUM PAD keys, press FN+SCRLK a 
second time.  

The NUM PAD keys are arranged on the QX400 keyboard as follows:  
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 7, 8, 9 on the numbers row are 7, 8, 9 on the NUM PAD.  

 0 on the numbers row is the ASTERISK key on the NUM PAD.  

 U, I, O, and P are 4, 5, 6, and DASH on the NUM PAD.  

 J, K, L, and SEMI COLON are 1, 2, 3, and PLUS on the NUM PAD.  

 M, PERIOD, and SLASH are 0, PERIOD, and SLASH on the NUM 
PAD.  

Overview of Soft Keys 

Soft keys are available in many Windows Mobile applications, so it is 
important to understand how they work as you will use them extensively 
on the PAC Mate Omni. The left and right soft keys are virtual keys that 
perform different functions depending on the program being used. Soft 
keys generally are assigned to the most common action based on the 
current screen. For example, in most programs, the right soft key opens 
the menu while the left soft key may perform some common action such 
as starting a new document, replying to an e-mail message, or going to 
the previous Web page. Once you become familiar with the various 
actions the soft keys perform, you will find they are extremely convenient 
to use. 

As soft key assignments change based on the currently active screen, 
the PAC Mate Omni will automatically announce the current soft key 
assignments when a screen first opens. For example, if you go to the 
Today screen from another program, you will hear "Today," followed by 
"left soft key is Calendar right soft key is Contacts." If you open an 
application or screen and receive no soft key announcement, this means 
that soft keys are not available in the particular program. 

Use F1 to activate the left soft key and F2 to activate the right soft key. In 
addition, use the command ALT+F3 at any time to have the PAC Mate 
Omni announce the current soft key assignments. If soft keys are not 
available, you will be told this as well. 

Once you become more familiar with using soft keys and the various 
functions they perform, you may decide you no longer wish to hear an 
announcement each time they change. To turn off the automatic 
announcement of soft keys, do the following: 
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1. Open the Start menu (WINDOWS Key) and press S to choose 
Settings.  

2. Press V once to move to Verbosity Settings and press ENTER.  

3. When the Verbosity Settings dialog box opens, do one of the 
following:  

 In the Verbosity Level combo box, use the ARROW keys to select 
Advanced. The automatic announcement of soft keys is only 
enabled for Beginner, which is the default verbosity level, and 
Intermediate.  

 If you do not wish to use the Advanced verbosity level, TAB to the 
Preferences button and press ENTER. In the list of message types, 
press DOWN ARROW to move to Soft Keys, press the 
SPACEBAR to uncheck it, then press the CLOSE button (ESC) to 
return to the Verbosity Settings dialog box.  

4. Press the CLOSE button (ESC) to save your changes and close 
the Verbosity Settings dialog box, and once more to close the 
Settings dialog box.  

Remember:  Even if you choose to not have soft keys announced, you 
can still use ALT+F3 at any time to hear the current soft key 
assignments. 

Today Screen Orientation  

When you turn the PAC Mate Omni on, the Today Screen is immediately 
available. On the Today Screen are eight default items: the system date 
and time, Owner's Information, E-mail Messages, Tasks, Appointments, 
Windows Live sign in, Live Search, and Battery Charge. You move to 
these items using the UP or DOWN ARROWS of the keyboard. You 
handle all menu navigation, including the Start Menu, in this manner as 
well. To activate any of the items on the Today Screen and on the 
menus, press the ENTER Key. When you press ENTER on Live Search, 
you are placed in an edit field where you can type in a search string. If 
your PAC Mate Omni is connected to the Internet, pressing ENTER will 
open a page in Internet Explorer Mobile containing a list of search results. 
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Note:  The "Sign into Windows Live" option is different from Windows 
Live Messenger. Using this item allows you to directly sign into the 
main Windows Live service. However, if you have a Windows Live 
Messenger account, your same username and password will work 
here as well. For more details on Windows live, visit the Windows 
Live Web site. 

To refresh the Today Screen so that it reflects the most current 
information, press INSERT+ESC. 

For those items on the Today Screen that open to a dialog box or list 
view, press the CLOSE button (ESC) Key to close the item and return to 
the Today Screen.  

Customizing the Today Screen to show only those items that you use 
often is an option available in the Today dialog box, which is in the 
Settings list view under the Personal page. 

From the Today Screen, you can quickly access your appointments and 
contacts with a single keystroke. Press F1 to open Calendar or F2 to 
open Contacts. 

Regardless of where you are or what you are doing on the PAC Mate 
Omni, the Start Menu is always accessible with the WINDOWS Key.  

Note: As you explore your PAC Mate Omni, you will occasionally come 
across unsupported features or phrases such as the words, "tap 
here." In this instance, instead of tapping, press ENTER. 

Program Layout and Menus 

Typically, most programs have a menu with items such as New, Edit, or 
Tools. In programs that use soft keys, the right soft key or F2 will usually 
open the menu. In applications that do not use soft keys such as FSEdit, 
the command to access the menus is the ALT key. Press ENTER on the 
menu item you want to open. 

Many menus have submenus, which frequently are announced. To open 
a submenu, you can press ENTER or the RIGHT ARROW to open the 
submenu and use the LEFT ARROW to return to the previous menu. 
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Note:  In programs where the right soft key F2 opens the menu, you can 
still use the ALT Key to open the menu as well. In this situation, 
pressing ALT brings up a small menu containing the left and right 
soft key assignments. DOWN ARROW to Menu and press 
ENTER TO OPEN THE PROGRAM'S MAIN MENU. In most 
cases however, it is much faster to just use F2 when available. 

Working with Dialog boxes and Controls 

Dialog boxes are smaller windows that usually appear from a menu 
choice. They contain controls used to configure various settings.  

There are many types of controls in a dialog box, such as edit fields, 
combo boxes, and slide controls.  

In dialog boxes, the TAB key moves you forward through the controls, 
while SHIFT+TAB moves you backwards.  

Multi-Page Dialog boxes 

A Multi-Page dialog box is a dialog box with multiple pages. When you 
open a multi-page dialog box, the name of the current page is announced 
after the name of the dialog box. For example, "Sounds and Notifications, 
Sounds page." 

To quickly move between pages of a multi-page dialog box, press 
CTRL+TAB or SHIFT+CTRL+TAB.  

When you press CTRL+TAB or CTRL+SHIFT+TAB, you are first placed 
on the name of the currently active page. Continue pressing these 
keystrokes to move through the pages until you hear the one you want, 
then press TAB to move to the first control on the page. 
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HTML Dialog boxes 

Windows Mobile uses HTML dialog boxes, better known as Information 
Bubbles, to display information in HTML text, hyperlinks, and buttons. 
Typically these dialog boxes are available only with software and 
hardware devices that support this type of dialog box. Use the arrow keys 
to navigate this dialog box and use ENTER to activate a button, hyperlink 
or radio button.  

Radio Buttons 

Radio buttons are presented in a dialog box as two or more small circles. 
This control type allows exclusive selections in that only one radio button 
in a group can be selected. Use the DOWN ARROW key to move 
through the radio buttons, and when you land on the appropriate choice, 
press TAB to move to the next control.  

Note: Only one radio button in a group can be selected at a time.  

Edit Fields 

Edit fields are similar to the edit fields in word processing programs. You 
can type text into an edit field and use any of the Reading Commands to 
move about your typed text. A multi-line edit field allows you to type more 
than one line in an edit field.  

Edit Combo Boxes 

An edit combo box is a combination of two controls: an edit field and a list 
box. You can either type in a value or press ALT+DOWN ARROW to 
open a list box. The list contains suggestions for the contents of this field. 
Use the UP and DOWN ARROW keys to move through the list, and use 
ALT+UP ARROW or the CLOSE button (ESC) to close the list box. If you 
do not find your choice in the list box, type it in the edit field.  
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Combo Boxes 

A plain combo box differs from the edit combo box. You must make your 
selection from suggestions provided by the program. Either press DOWN 
ARROW to move through the choices, or press the first letter of the 
choice you want to make.  

Note: When you encounter a combo box you may need to press DOWN 
ARROW twice in order to move to the next item. 

Edit Spin Boxes 

The edit spin box is also a combination of two controls. You can type in 
this field, or use the arrow keys to move through the list of suggestions. 
Edit spin boxes are common for fields that require numeric values.  

Left/Right Sliders 

Left/right sliders are oriented horizontally. You can use your LEFT and 
RIGHT ARROW keys to adjust this control. For some left/right slider 
controls, you can use PAGE UP and PAGE DOWN to move by larger 
increments.  

Check Boxes 

A check box can be checked or unchecked. The PAC Mate Omni 
announces the current state of a check box when you move to it. Press 
SPACEBAR or ENTER to check or clear a check box.  

In an extended select list box, use the arrow keys to navigate the list of 
options that have check boxes associated with them, and press 
SPACEBAR or ENTER to check or clear the check boxes.  

Buttons 

Buttons are common in dialog boxes and in the Windows Mobile 
environment require special consideration. In most dialog boxes, pressing 
ENTER activates a button. 
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In dialog boxes that contain OK and Cancel buttons, you can not press 
ENTER while on another control and have the OK button activated as 
you can with Windows dialog boxes on the desktop. You must TAB to the 
OK button and then press ENTER to activate it and close the dialog box. 

In dialog boxes that do not contain OK and Cancel buttons, you must 
press the CLOSE button (ESC) to exit the dialog box. If you have made 
any changes, they are automatically applied. Otherwise, the dialog box is 
simply closed. 

List Views 

When you start using the PAC Mate Omni regularly, you will notice that 
one of the items common among all Microsoft programs is the list view. 
The list view lists the files you have created in a particular program and is 
seen whenever you open a program or close a file. To hear the available 
items in a list view, press UP or DOWN ARROW. As you move through 
the list, the first column of information is read. To hear information from 
all columns for the current item, press INSERT+I, the Read Current Line 
command. 

In the list view, you always have the context menu (APPLICATIONS 
Key) available. This context menu offers a quick way of performing 
actions such as cut, copy, delete, rename, move, select all etc. To 
perform an action on an item(s), use the DOWN ARROW to select an 
item or if you want to select multiple items press SHIFT+DOWN ARROW. 
To select items non-contiguously, press and hold the CTRL key while 
moving up and down the list with the arrow keys. Press the SPACEBAR 
to select or unselect an item. JAWS says "not selected" for items that you 
have not selected. Once the items are selected, press the 
APPLICATIONS Key on the selected item(s). From the context menu 
select a command and press ENTER. 

Of course, instead of pressing the APPLICATIONS Key you can always 
use equivalent commands such as CTRL+X, CTRL+C, DEL or CTRL+A. 



 

 13 

Tree Views 

In a tree view, items are presented in a hierarchical format, which is 
organized vertically on the screen. Press UP or DOWN ARROW to move 
through the tree view. When you hear, "level zero closed," you press 
RIGHT ARROW to open that level. If an item is closed, press RIGHT 
ARROW again to expand that item. If you want to close a level, press 
LEFT ARROW.  

Note:  The PAC Mate Omni only announces the level number when it 
changes. 

Using the Search Feature 

1. Open the Start menu (WINDOWS Key), P for programs, move to 
Search, and press ENTER.  

2. Enter the text, topic or subject you are trying to find. 

Tip:  If you have looked for this text before, press DOWN ARROW in the 
Find box and select the name from the list.  

3. In the Type combo box, use your arrow keys to narrow your 
search by selecting the appropriate item in the combo where you 
will find it.  

4. Press ENTER when you are ready to begin the search. If your 
PAC Mate Omni or any attached storage devices contain a large 
number of files, the search may take some time to complete. 

5. Press TAB to move to the Results list, use the arrow keys to 
select what you are looking for and then press ENTER to open it. 

Personalizing Your PAC Mate Omni  

If you will be using your PAC Mate Omni in public places, then this 
section is important because it discusses how to personalize, password 
protect, and identify your PAC Mate Omni.  
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This section is also important if you want to purchase any of the off-the-
shelf programs available for the PAC Mate Omni as it discusses how to 
locate hardware and software information.  

Entering Owner Information 

You can enter this information in the Owner Information dialog box of the 
PAC Mate Omni. 

To do this, from the Today screen, use the arrow keys to locate the item 
“Tap here to set owner information,” and press ENTER. You can also 
access this dialog box by going to the Start Menu (WINDOWS Key) and 
pressing S. This opens the Settings multi-page dialog box. Use the arrow 
keys to move to Owner Information and press ENTER. 

 When this dialog box opens, the Identification page is active for you to 
enter your personal information. You can press the SPACEBAR to check 
the "Show information when device is turned on" check box so that if you 
lose your PAC Mate Omni, it can be returned to you.  

If you want to add any additional information, press CTRL+TAB to move 
to the Notes page. Type the information you want to add and press the 
SPACEBAR to select the check box if you want to display this 
information when the PAC Mate Omni is on. Press the CLOSE button 
(ESC) to save the changes and close the dialog box, and once more to 
return to the Today Screen. 

Protecting PAC Mate Omni Information 

As you become familiar with your PAC Mate Omni and begin to truly use 
it as your personal data assistant, you may find that you are storing more 
and more personal or confidential information. For example, names and 
phone numbers of important contacts, credit card numbers, and work or 
school related documents. To protect you from data theft, your PAC Mate 
Omni allows you to password protect your information as well as encrypt 
any files you save to a storage card.  

To set up a password, go to the Start menu (WINDOWS Key), press S to 
choose Settings. Press L to move to Lock and then press ENTER.  
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In the Password Settings dialog box, use the SPACEBAR to select how 
long your PAC Mate Omni must be idle before the password is required 
check box. Use the arrow keys to choose the idle time. Press TAB and 
select one of the two radio buttons to indicate the type of password you 
would like to use: simple 4-digit password or strong alphanumeric 
password.  

To type the password, press TAB to move to the Password edit box and, 
if necessary, confirm the password. It is helpful to record this password 
and store it elsewhere for safekeeping. 

You can also provide a hint in case you forget your password. From the 
Password Settings dialog box, press CTRL+TAB to access the Hint 
page. Press TAB and enter your hint in the edit box. 

Note:  If you choose to use an alphanumeric password it must be at least 
seven characters long and contain a combination of uppercase 
and lowercase letters, numerals, or punctuation. 

When you are done press the CLOSE button (ESC) twice to return to the 
Today Screen. Now, when you turn your PAC Mate Omni on it will require 
the password to access it. 

Caution:  If you forget your password, you must perform a clean reset to 
clear the memory before you can access your PAC Mate Omni. 
This erases all files and data you have created and programs you 
have installed. For this reason, it is recommended that you use 
ActiveSync to regularly synchronize your data or use Sprite 
Backup to create a complete backup file of all of your programs 
and data so they can be restored. 

To encrypt files saved on a storage card, go to the Start menu 
(WINDOWS Key), press S to choose Settings. Press CTRL+TAB to 
move to the System page, then E to move to Encryption, and press 
ENTER.  

In the Encryption dialog box, press SPACEBAR to check the "Encrypt 
files placed on storage cards" check box. Since this is the only control in 
this dialog box, press the CLOSE button (ESC) twice to return to the 
Today Screen. 
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Now, any files that are located on your storage card, or any files that you 
save to your card in the future, will only be readable on your PAC Mate 
Omni. If your card is lost or stolen, none of your files will be readable on 
any other device. 

Locating the PAC Mate Omni Serial Number  

The PAC Mate Omni serial number identifies your PAC Mate Omni in 
Freedom Scientific’s product database. This number, found in the center 
of the bottom surface, is printed and brailled. It may be helpful to record 
and store this number for safekeeping. 

Finding Firmware Information 

Anytime you call Freedom Scientific Technical Support, you will need to 
have your serial number and other information available. This information 
is found in the Version Information dialog box, which is accessed using 
the command INSERT+ENTER, A. 

Knowing About Windows Mobile 

To learn more about your PAC Mate Omni system go to the About multi-
page dialog box. Here you will find information on Windows Mobile 
software version, processor type, memory amount, device ID, and 
Copyright notifications. 

To view this information, go to the Start menu (WINDOWS Key) and 
press S to choose Settings. Press CTRL+TAB to move to the System 
page. Press A to move to About and then press ENTER.  

When the About dialog box first opens, you are on the Version page. The 
PAC Mate Omni will automatically read the contents of this page, which 
includes software version, processor, memory, and expansion slot.  
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When you are done with this page press CTRL+TAB to move to the 
Device ID page. On this page there is a Device Name edit field and a 
Description edit field. Your PAC Mate Omni uses the Device name to 
identify itself when connecting to other computers. If you cannot connect 
to a network because another device is already connected using the 
same name, type a new name in the Device edit field. You may include a 
description to go with the identification. 

To read the copyright notice, press CTRL+TAB to move to the Copyright 
page. To read the copyright notice follow the previous steps to move to 
the Copyright tab. 

Getting Help 

The PAC Mate Omni has a variety of ways to get help and provides this 
help as conveniently as possible. The following paragraphs provide a 
brief description of each type of help available. Or if you prefer you can 
quickly access the list of Help Commands by going to Appendix A: PAC 
Mate Omni Commands. 

Control Help 

A control is any object or field that appears in a dialog box. To hear a 
description of the currently selected control, press INSERT+F1. 

Context Help 

Context help provides a complete description of the entire dialog box, 
application, or window that is currently open. Press INSERT+F1 twice 
quickly to obtain Context help.  

System Help  

Press WINDOWS Key, H to access and hear in-depth help about the 
current application or dialog box.  
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Keyboard Help 

Keyboard help allows you to safely explore keyboard commands without 
actually performing the command. For example, when you turn on 
Keyboard Help mode, and press a key, the PAC Mate Omni tells you 
what the selected key does without executing the function. To turn on 
Keyboard Help mode, press INSERT+1. To quit Keyboard Help mode, 
press INSERT+1 again.  

WINDOWS Key Help 

The command INSERT+W gives a list of Windows Commands frequently 
used to operate the PAC Mate Omni. Use the JAWS reading keys to 
review the messages. 

Using Online Help 

Tip:  The fastest way to open Help is to go to the Start Menu (WINDOWS 
Key), press the UP ARROW once and then press ENTER or 
press WINDOWS Key, H. 

The online help in the PAC Mate Omni uses a task-oriented approach 
and briefly covers the steps necessary to complete a task. To aid you, the 
online help is specific to the program that is running. For example, while 
in FSEdit, if you open Help from the Start Menu, only FSEdit Help opens. 
While Help is open, press ALT and select Contents to open a complete 
list of all the help topics that you can browse. 

In addition, because the PAC Mate Omni online help is written in HTML, 
you can use many of the Internet Explorer Mobile commands to navigate 
and read each help topic. For example, you can navigate to a topic 
quickly by opening a list of links with the command INSERT+F7. Or you 
can move easily through a table using ALT+CTRL+ARROW Keys. 

For added convenience, next links have been added to Help so you can 
easily move to the next consecutive topic. To move back, just press 
ALT+LEFT ARROW. If, after you go back to the previous help topic, you 
are not at the top of the page, press CTRL+HOME and then use the 
reading commands. 
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To hear a list of commands that you can use to navigate the online help, 
go to Appendix A. 
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PAC Mate Omni Basics 

Adjusting Speech Settings 

The Voice Settings multi-page dialog box configures the PAC Mate Omni 
to speak the way that suits you best. There are two approaches you can 
take to adjust speech.  

Open the Start menu and press S to choose Settings. Next, press V twice 
to move to Voice Settings and press ENTER.  

When this dialog box opens, you are placed on the Primary page in a 
combo box where you can select the "voice" you want to modify. There 
are five choices:  

 Global Voice: When this voice is selected, you can modify only the 
Rate, Upper Case Pitch Increment, and Punctuation settings (see 
below). Changes made here apply to the other four voices unless 
changed individually. 

 Message Voice: This is the voice that is used to announce all system, 
JAWS, and other messages. 

 Keyboard Voice: This is the voice that is used when you have Typing 
Echo turned on. It is the voice that is used to speak as you enter data 
on your PAC Mate Omni. 

 PC Cursor Voice: The PC Cursor Voice is the ordinary speaking 
voice that you hear when your PAC Mate Omni is announcing the 
contents of a Web page or file, a new dialog box, and so on. It is the 
most commonly heard voice. 

 JAWS Cursor Voice: When you switch from the PC Cursor to the 
JAWS Cursor to explore the contents of a window, this is the voice you 
hear. 

Press TAB to move to the Speech Rate slider control. Press the LEFT 
and RIGHT arrow keys to increase or decrease the speech rate. To 
increase or decrease the speech rate by larger increments, press PAGE 
UP or PAGE DOWN. To move forward to the next control, press TAB.  
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The voices control is a combo box that allows you to choose from a 
selection of eight voices. With combo boxes, use the UP or DOWN 
ARROW keys to make your selection. You will hear the actual voice as 
you arrow through this list. This combo box is not available if you are 
modifying the Global voice. 

Each time you move to a control, you should notice that JAWS indicates 
what type of control it is. For the voice pitch slide control, use the LEFT 
and RIGHT ARROWS to adjust the pitch to your liking. When you are 
done, press TAB to move forward to the next control. This control is not 
available if you are modifying the Global voice. 

The next control, Upper Case Pitch, is a little different than anything 
discussed so far. It is an edit box and when you pressed TAB to move to 
it, you should have heard JAWS say, "Upper Case Pitch increment edit 
twenty." This means that the number twenty is the increment that JAWS 
uses when it reads an upper case letter. To change the pitch, type a new 
number. When you are done, press TAB to move to the next control. 

The Punctuation combo box has four choices that you can use to control 
the amount of punctuation that you hear. They are none, some, most or 
all. Use the arrow keys to select your choice. When you are done, press 
TAB to move to the next control. 

The last control is the Enable Secondary Voice check box. This check 
box allows you to specify whether or not the Secondary page is enabled. 
If you uncheck this option, only the Primary voice can be configured. This 
item is checked by default. 

Press CONTROL+TAB to move to the Secondary page if you want to 
configure secondary voice settings. For example, if you have installed an 
additional Eloquence language, or a Realspeak Solo voice, you can 
configure the settings for the additional voice. The Secondary page 
mirrors the Primary page described above with the exception of the 
following: 

 Speech Synthesizer: This combo box is available if you have installed 
one or more Realspeak Solo voices. Use the ARROW keys to change 
the synthesizer from Eloquence to Realspeak Solo. You can only 
change the synthesizer for the secondary voice.  
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 Language: This combo box allows you to select the language that is 
used for the secondary voice. This option is only available if you have 
additional Eloquence or Realspeak Solo languages installed. You can 
only change the language for the secondary voice.  

 The Voice Pitch slider and the Uppercase Pitch Increment edit are not 
available when Realspeak Solo is the active synthesizer.  

To toggle between the primary and secondary voice language, press 
INSERT+S, L. 

Note: If you attempt to change the secondary voice back to Eloquence 
and you do not hear the Eloquence speech as expected, save any 
open documents then perform a warm reset and Eloquence will 
load correctly. You will not lose any data during a warm reset. 

When you have finished configuring the voice settings, press the CLOSE 
button (ESC) to return to the Settings Multi-page dialog box. To exit the 
Settings dialog box and return to the Today Screen, press the CLOSE 
BUTTON (ESC) again. 

The second approach to adjust speech settings uses INSERT+S, which 
you can press at anytime, in any program. 

Note: If you adjust speech with INSERT+S and later perform a warm 
reset (CTRL+ALT+DELETE) your speech settings will revert to 
the previous adjustments made from the Settings dialog box.  

The commands introduced here are called layered commands because 
you only have to press INSERT+S once to have all the speech 
parameters settings available. For example, press INSERT+S, and then 
use the ARROW keys to adjust the voice rate and volume. When you are 
done, press P until you set the punctuation to the level you want and so 
on. To move out of settings, press FN. 

Appendix A lists all the commands used to adjust speech. 

Understanding Layered Commands 

There are several types of keyboard combinations in the PAC Mate 
Omni. Most key combinations are pressed once and released. 
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There are also layered commands. These are layered key combinations, 
where one set of keys is pressed and released, then another set of keys 
are pressed and released resulting in the command performing a 
function. For example, press INSERT+S, P to set the punctuation level. 

Repeating layered commands allow you to press the second key 
combination in the sequence multiple times. For example, press 
INSERT+S, RIGHT ARROW to increase the speech rate. After pressing 
INSERT+S, press RIGHT ARROW repeatedly until the speech rate you 
desire is reached. If you think it's too fast, press LEFT ARROW to 
decrease the rate. You don't have to press INSERT+S again unless you 
pressed a key combination that is not assigned to the second layer for 
repeating commands that start with INSERT+S. 

If you do press the first key combination in a layered command, followed 
by a key combination that is not assigned to the second layer, the PAC 
Mate Omni plays a sound to indicate that the command is invalid. 

Press FN to exit the layer.  

Working with Text 

This section explains how to read and manipulate text, lists all the 
associated commands and provides examples on the more frequently 
used actions performed with text. 

Typing in Braille 

Using the PAC Mate Omni QX400 QWERTY keyboard, you can write in 
uncontracted or contracted Braille from anywhere in the PAC Mate Omni. 
This includes the Notes, Word Mobile, Windows Live Messenger, 
Messaging, Contacts, Calendar, and Tasks applications, as well as 
various dialog boxes that contain edit fields such as the Owner 
Information dialog box. You can even type braille in edit fields on Web 
Forms in Internet Explorer Mobile. 

To turn on Braille input, press INSERT+SHIFT+F9. The Braille key 
assignments are: 

 F = DOT 1  
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 D = DOT 2  

 S = DOT 3  

 A = DOT 7  

 J = DOT 4  

 K = DOT 5  

 L = DOT 6  

 Semicolon = DOT 8  

When in Braille input mode, DOT 7 (the letter A) functions as the SHIFT 
key when held down as you enter a character or as the BACKSPACE 
when pressed by itself. The Semicolon functions as a NEW LINE key. In 
addition, while the ALT, WINDOWS, and ESC keys as well as the arrow 
and function keys perform the same functions in Braille input mode, you 
must use chorded commands to perform other actions. A chorded 
command is a command that includes the SPACEBAR. For instance, to 
hear the title of the current window, you would normally press INSERT+T. 
In Braille input mode however, you would press I CHORD, T which is the 
same command used on the PAC Mate Omni BX. For more information 
on what chorded commands are available, please refer to the BX manual 
located on your Documentation CD. 



 

 25 

Once the braille keyboard is enabled, you can enter text into any 
standard single-line or multi-line edit field using contracted braille. As 
soon as you press the CLOSE button (ESC) or any other command 
which moves you out of the edit field, the text is automatically back-
translated to computer braille so the particular item is readable on your 
computer if you synchronize, or by a friend or co-worker if you e-mail it. 
When you open an item such as a note, Word Mobile document, 
Calendar appointment, etc. the text is automatically translated back into 
contracted braille so you can make any changes. If the PAC Mate Omni 
says "Computer Braille" and shows dots 4-5-6, dots 3-4-6 on the braille 
display when you open an application or navigate to an edit field, this 
means that the particular edit field requires text be entered in computer 
braille even though contracted braille input is enabled. Currently, 
computer braille must be used in the equation entry window in FSCalc, 
Calculator, and when entering data into a spreadsheet in Excel Mobile. In 
addition, edit fields that prompt for an e-mail or Web page address as 
well as fields that only accept numbers, require computer braille. To turn 
off the braille keyboard and return to normal QWERTY operation, press 
INSERT+SHIFT+F9 again. 

Notes: 

 If you want to write literary braille using grade 1, you should enable 
contracted braille input and write using the rules for contracted braille. 
For example, single letters should be preceded by a letter sign (DOTS 
5-6). 

 If you need to write a string of text that contains both letters and 
numbers, such as an amateur radio call sign or a confirmation number, 
you should use the letter sign (DOTS 5-6) before the lettor or group of 
letters prior to a number sign (DOTS 3-4-5-6) and the letter or group of 
letters that follow a number. This ensures that the PAC Mate Omni 
correctly back-translates the number sign instead of rendering it as the 
letters "ble" and any letters that follow one or more numbers are 
correctly translated as letters instead of digits. For example, the string 
"t4qrs" would be written as dots 5-6 t dots 3-4-5-6 4 dots 5-6 qrs. 

Because FSEdit was developed to include Braille input and output, Braille 
input mode works differently in FSEdit than it does in Windows Mobile 
programs. For more information on FSEdit and contracted braille, please 
see Using PAC Mate Omni Programs, FSEdit. 
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When working in Windows Mobile applications that support contracted 
Braille, it is important to remember that this feature has been 
implemented for input convenience only. Thus, in situations where you 
are co-creating or co-editing a document with a colleague, it is 
recommended that when working on the PAC Mate Omni QX you use 
FSEdit as your word processor. In addition, please note that any text 
formatting such as bold, italics, and list formatting, is lost during forward 
translation. 

Inserting ASCII and Control Characters 

You can enter ASCII values or control characters on the PAC Mate Omni. 
To enter ASCII values, do the following:  

1. Press FN+SCROLL LOCK to turn on the numeric keypad. The 
FN key is located farthest to the left on the bottom row of the 
keyboard; the SCROLL LOCK key is the third key from the right 
on the top row. 

2. While holding down the ALT key, press the letters that represent 
the NUM PAD numbers. For example, to enter a sign for British 
pounds sterling, press j, o, and l, or the equivalents of 163, the 
ASCII value for this character. 

Reading 

Depending on what you are trying to achieve, you may find reading by 
character, sentence or paragraph more suitable than reading with the 
Say All command (INSERT+A). For instance, if you are trying to 
understand the syntax of a paragraph, you may want to read by line or by 
sentence. If you want to know how a word is spelled, you would want to 
read by character or press the command for "Spell Current Word" 
(INSERT+K twice quickly). To access the table that lists all the 
reading/moving commands available on the PAC Mate Omni, go to 
Appendix A: PAC Mate Omni Commands. 
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Alternate Reading Commands 

Alternate reading commands use the ARROW keys. The LEFT and 
RIGHT ARROW move and read horizontally. LEFT ARROW is for prior, 
RIGHT ARROW is for next. 

The UP and DOWN ARROW move and read vertically. UP ARROW is for 
prior; DOWN ARROW is for next. Press them individually for line, add 
CTRL for paragraph, or press PAGE UP or PAGE DOWN to move by 
page. 

File Margins 

The HOME and END keys let you move to the margins of your document 
(i.e., beginning/end of the current line, or top/bottom of the file). Just 
press HOME to move to the beginning of a line or END to move to the 
end. To read from the beginning of the line to the current cursor position, 
press INSERT+HOME. To read from the cursor position to the end of the 
line, press INSERT+END. To move to the top of a file, press 
CTRL+HOME. To move to the bottom of a file, press CTRL+END. 

Say All 

When you want to read text in its entirety without stopping, use the Say 
All command (INSERT+A). With Say All, the PAC Mate Omni reads text 
from the point where you initiate the command to the end of the 
document or until you press the Stop Speech command (CTRL). During a 
"Say All" there are several commands you can use to move swiftly 
through the text you are reading. For example, you can press the LEFT 
or RIGHT ARROW to rewind or fast-forward through a document. In 
addition, you can decrease or increase the speech rate and volume. The 
commands available during a Say All are listed in Appendix A. 

Editing 

While there are many aspects to editing a document, this section focuses 
on the Edit commands used to edit text and provides an example with 
their implementation.  
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First, it is helpful to know that while most programs have an Edit Menu 
from which you can select an action, the PAC Mate Omni has its own 
keyboard edit commands. Appendix A lists these editing commands, 
which can be used in any program. 

In many cases, any editing that you do requires that you select text.  

Example: In the following two sentences, cut the word "pen," copy the 
word "stylus," and then paste the word "stylus" in the place of 
"pen."  
 
Do you have a pen?  
 
No, I have a stylus. 
 
If you typed these sentences into one of the word processing 
applications on your PAC Mate Omni and then followed the 
directions, you would have had to select text twice. (Once to cut 
pen, and once to copy stylus.) 

 
Using the previous example, the following procedure describes how to 
cut and paste using commands from the Edit menu.  

1. Open FSEdit by pressing WINDOWS Key, P. Then press F until 
you hear FSEdit and press ENTER. 

2. In the edit field type: Example1. When done, press ENTER. 

3. Type the sentence: Do you have a pen? When you are done, 
press ENTER. Then type: No, I have a stylus. 

4. Press UP ARROW to move up to the prior sentence.  

5. Press CTRL+RIGHT ARROW or CTRL+LEFT ARROW until you 
hear the word "pen," then press CTRL+SHIFT+RIGHT ARROW 
to select pen or you can press SHIFT+RIGHT ARROW to select 
it by character so the question mark is not included. 

6. Press CTRL+X to cut the word pen. 
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7. Next, Press DOWN ARROW to move down to the next 
sentence. 

8. Press CTRL+RIGHT ARROW or CTRL+LEFT ARROW until you 
hear the word "stylus," then press CTRL+SHIFT+RIGHT 
ARROW to select stylus or you can press SHIFT+RIGHT 
ARROW to select it by character so the period is not included. 

9. Press CTRL+C to copy the word stylus. 

10. Finally, press UP ARROW to move up to the prior sentence, 
press LEFT ARROW to move left one character, and press 
CTRL+V to paste the word stylus. 

To view all of the selecting commands available on the PAC Mate Omni, 
please see Appendix A: PAC Mate Omni Commands. 

Alternate Selecting Commands 

Alternate selection commands are extensions of the alternate reading 
commands. For example, SHIFT+LEFT ARROW selects the prior 
character, and SHIFT+RIGHT ARROW selects to the next character. Add 
CTRL to select by word. 

SHIFT+UP ARROW selects the prior line, and SHIFT+DOWN ARROW 
selects to the next line. 

Formatting 

Like the Edit Menu, many programs provide a Format Menu or dialog box 
where you can change the appearance of text. But rather than use a 
menu or dialog box, you should get familiar with the PAC Mate Omni’s 
keyboard formatting commands as they are quick and easy to use. 
Appendix A lists the formatting commands available on the PAC Mate 
Omni.  

Much of the process used to format text is similar to the process involved 
in editing text.  

Example: Center the following word "PAC Mate Omni." Capitalize p, a, c 
and m. Then bold the whole word.  
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1. Open FSEdit by pressing WINDOWS Key, P. Then press F until 
you hear FSEdit and press ENTER. 

2. In the edit field type: Example2. When done, press ENTER. 

3. Type the word: PAC Mate Omni.  

4. Press ALT+F, C to center the word. (There is no need to move 
to the beginning of the word to center it.) 

5. Press the LEFT ARROW to move left by character. Stop when 
you hear the letter "a."  

6. Select to the beginning of the line with SHIFT+HOME.  

7. Next, press CAPS LOCK and retype p, a, c and m in uppercase. 

8. Now, press HOME, and SHIFT+END. This moves you to the 
beginning of the line so you can select all the text to the end of 
the line. 

9. Last, to make everything bold, press ALT+F, B. (To unselect the 
word PAC Mate Omni, press any of the ARROW keys.) 

Now that you have created a title for your document, you are on your way 
to writing its content. When you press ENTER to start your first sentence, 
it will be centered. To left justify, press ALT+F, L. 

Embossing 

Embossing a document can be done only in the FSEdit program. This 
section covers only the basics of embossing. For more information on this 
topic, please see FSEdit, Embossing a Document.  

Embossing is initiated from FSEdit’s Emboss dialog box. To open the 
Emboss dialog box you must open the File Menu (ALT, ENTER) and 
select Emboss (E). With the Emboss dialog box open, you have several 
controls that allow you to change the way your document is embossed. If 
you do not want to change any of the parameters and are ready to 
emboss, press ENTER.  
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Printing  

Your PAC Mate Omni offers several printing solutions. Perhaps the most 
widely known solution is to synchronize your PAC Mate Omni documents 
and print from your desktop or laptop computer and printer. With this 
solution, you create a standard partnership with ActiveSync through the 
USB client or infrared. 

Another solution uses a Windows Mobile printing utility called PrintBoy. 
This easy-to-use program lets you print Word Mobile and e-mail 
messages directly from your PAC Mate Omni to a PrintBoy compatible 
printer. Once you add the program to your PAC Mate Omni, go to the 
Start menu and select PrintBoy. For more information, visit 
http://www.bachmannsoftware.com. 

 Additionally, you can print directly to a printer from FSEdit.  

Copying Files To and From Your PAC Mate Omni 

A procedure that has received little coverage is your ability to copy all 
program files to and from your PAC Mate Omni and PC regardless of the 
type of partnership you establish in ActiveSync. 

To copy files from your PC to your PAC Mate Omni, first locate, select, 
and copy the desired file(s). Then in ActiveSync on your PC, press 
ALT+T. From the Tools menu select Explore Device. This directly opens 
Mobile Device on your PC.  

Next, select a folder and paste your files. Your files immediately go 
through the conversion process and transfer to the PAC Mate Omni. To 
copy files to your PC, the process is the same except that you go to 
Mobile Device first, copy the files, and then paste the files in the desired 
folder on your PC. 
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Adding Programs 

Before you purchase an off-the-shelf program for your PAC Mate Omni, 
make sure JAWS supports it and that it is compatible with the Windows 
Mobile 6.0 operating system and your PAC Mate Omni’s processor. For 
more information on the processor, please see Personalizing Your PAC 
Mate Omni, Knowing About Pocket PC.  

Any application that you want to add to your PAC Mate Omni must be 
installed using ActiveSync and your computer. For more information on 
ActiveSync, please see Connecting the PAC Mate Omni, Connecting to a 
PC with ActiveSync. 

Before you can add a program to the PAC Mate Omni, you must install it 
on your PC. You do not need to be connected or have a partnership 
established. After you install the program, it remains on your PC in 
ActiveSync so you can add or remove it from your PAC Mate Omni when 
needed.  

If you have yet to make a connection between your PAC Mate Omni and 
your PC and only want to add or remove programs, establish a guest 
partnership in ActiveSync. If you want to synchronize as well as add or 
remove programs, establish a standard partnership.  

Whether you have a guest or standard partnership, you go to the Tools 
Menu (ALT+T) in ActiveSync on your PC and select Add/Remove 
Programs. Once you have checked the program(s) you want to add, 
press TAB to move to the OK button and press ENTER to close the 
dialog box. 

Note:  Any listed program that does not have a check in the box is 
removed from the PAC Mate Omni. 

If additional installation is required, installation dialog boxes will 
automatically open on your PAC Mate Omni and step you through the 
rest of the process.  
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Removing Programs 

Programs that come with your PAC Mate Omni cannot be removed. Only 
programs that you install can be removed.  

There are a couple of ways to remove programs from your PAC Mate 
Omni. The easiest way is to use the Add/Remove Programs dialog box in 
ActiveSync on your PC. This dialog box lets you remove any applications 
you are not currently using, but because they remain on your PC, you 
can re-add them to your PAC Mate Omni at anytime.  

To remove programs, establish a partnership in ActiveSync. With 
ActiveSync open on your PC desktop, go to the Tools Menu (ALT+T) and 
select Add/Remove Programs from the menu. In the Add/Remove 
Programs dialog box, uncheck the box next to the program(s) you want 
removed from your PAC Mate Omni. Once you have unchecked the 
program(s) you want removed, move to the OK button and press ENTER. 
The program(s) are automatically removed from your PAC Mate Omni. 

Note:  Any listed program that has a check in the box remains on the 
PAC Mate Omni. 

The second way to remove programs installed is to use the Remove 
Programs dialog box on your PAC Mate Omni. To do this, open the Start 
menu and press S to choose Settings. Press CTRL+TAB to move to the 
System page. Press R twice to select Remove Programs and then press 
ENTER.  

In the Remove Programs dialog box use the DOWN ARROW to select 
the program(s) you want removed. Press TAB to move to the Remove 
button and press ENTER. 
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PAC Mate Omni Hardware 

The PAC Mate Omni has keys on the top with the ports and switches in 
the back. The overall size of the QX400 is 12.3 inches (31.24 cm) x 6.27 
inches (15.93 cm) x 1.62 inches (4.11 cm) and it weighs 2 lbs (.90kg). 

Ports and Switches  

With the PAC Mate Omni positioned on your lap or on a desktop as if you 
are going to type, you will find on the back surface from right to left: the 
On/Off switch, the Power Jack, the Mini A/B USB port, two 
CompactFlash® Slots, the Infrared Port, the 3/32 inch (2.5 mm) external 
headset/Microphone Jack and the 1/8 inch (3.5 mm) Headphone Jack.  

 

The CompactFlash slots on the QX400 support both CompactFlash Type 
I and Type II cards and peripherals. For more information on peripherals 
that have been tested for the PAC Mate Omni, please visit our web site. 

The CompactFlash cards plug into the PAC Mate Omni in one direction 
only. If you insert the card the wrong way, simply remove the card, turn it 
over and gently reinsert the card. Never push or force the card. When 
you correctly insert the card, you can feel it gently plug into place. 

To remove a CompactFlash card, grasp and pull the card with your index 
finger and thumb.  
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On the top surface, just above the F3 key on the QWERTY keyboard, is 
the speaker and just above the Print Screen and Scroll Lock keys is the 
internal microphone. 

The reset button is on the bottom surface of the PAC Mate Omni. To find 
the reset button, turn the PAC Mate Omni bottom side up so that the rear 
panel is facing you. With your left hand, locate the rectangular depression 
that contains the serial number sticker. Just above this depression is a 
small, round protuberance with a hole. This is the reset button. Use an 
unbent paper clip, Braille stylus, or similar object to press the reset button 
by inserting it into this hole and pressing. 

 

Also located on the bottom surface is the drawer/display release. You can 
find this release on the right side across from the reset button. To 
disengage the drawer or display, pull the release gently towards the right 
side of the unit.  

To connect the PAC Mate Portable Braille Display, align the display so 
that it slides easily into the PAC Mate Omni. Then press against each unit 
until they are firmly engaged.  
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Battery 

The PAC Mate Omni is powered with a high-density lithium polymer 
battery that may be charged repeatedly and at any time within the battery 
cycle without losing capacity. When the battery has only 30% of its 
charge remaining, the PAC Mate Omni announces a warning that the 
battery is low. At 12% of battery life, the PAC Mate Omni alerts you that 
the battery is critically low, and at 0% the PAC Mate Omni will 
automatically turn off within a few minutes. 

Note: Since all user data and installed programs are stored in Flash 
memory as of version 6.0, your information will not be lost if the 
battery completely discharges. All of your files, installed programs, 
and settings will still be there when you connect the PAC Mate 
Omni to the AC adapter and charge it. 

Once the battery charger is connected, the battery takes approximately 4 
hours to recharge. You can work with your PAC Mate Omni while your 
battery is recharging without harming the unit. When you get ready to 
charge your PAC Mate Omni, you must charge the battery with the AC 
adapter supplied with the unit.  

Warning: This device has no user-serviceable components. Any 
unauthorized attempt to service or replace internal components by 
opening the case will void the product warranty.  

Checking the Available Battery Charge 

For convenience, the Today Screen indicates the percentage of battery 
charge available. To refresh the Today Screen so that it reflects the most 
current battery charge, press INSERT+ESC.  

Note: If you do not refresh the screen before checking the percentage of 
battery charge available, you may not receive an accurate 
measurement. 

For additional information on the PAC Mate Omni battery, please see 
Appendix B: Special Considerations, Lithium Polymer Battery. 
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Resetting the PAC Mate Omni  

Occasionally it may be necessary for you to reset your PAC Mate Omni. 
This is true if it is operating slowly and sluggishly or if it stops responding 
completely. If this occurs often, contact Freedom Scientific's hardware 
technical support. However, if this occurs infrequently, perform the 
following to get your PAC Mate Omni running normally again. 

Performing a Warm Reset  

A warm reset does not affect your files, programs or settings. Instead, it 
closes all running applications, restarts the PAC Mate Omni,  and places 
you on the Today Screen. This means that any data that you have written 
but not saved will be lost in a warm reset. To perform a warm reset, press 
CTRL+ALT+DELETE. After about a minute, during which time the 
Windows Mobile operating system is being restarted, you will hear 
"JAWS for Pocket PC is ready" followed by the version. You are then 
placed on the Today screen. 

In the event that your PAC Mate Omni keyboard becomes unresponsive, 
you can also perform a warm reset by holding the power switch in the on 
position (toward the CompactFlash slots) for approximately 10 seconds 
and releasing it. The PAC Mate Omni will then perform a warm reset. 

Performing a Cold Reset 

A cold reset is similar to a warm reset in that all running programs are 
closed and the operating system is restarted. However, some additional 
initializations to the internal hardware are performed that are not done 
during a warm reset. While a cold reset will not erase any of your files, 
you will need to reset the time and date as these will be returned to their 
factory defaults. See Clock for information on setting the clock. 

To cold reset your PAC Mate Omni, use a straightened paper clip or a 
toothpick and press down gently on the reset button. You should feel the 
button move slightly as you press. After about a minute you will hear 
"JAWS for Pocket PC is ready" followed by the version. You are then 
placed on the Today screen. 
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Note:  If you have upgraded from a version of the PAC Mate prior to the 
Omni, please note that performing a cold reset will no longer 
erase any of your files or installed programs. Do not hesitate to try 
a cold reset if you think it may resolve an issue you are 
experiencing as your data is secure. 

Performing a Clean Reset 

Warning:  A clean reset should be used only as a last resort as this 
erases all files and data you have created and programs you have 
installed. Usually, you should never have to perform a clean reset. 
However, if you are in a situation where you need to perform one, 
make sure you first synchronize any important data with your 
computer, or perform a complete backup of your PAC Mate Omni 
to a storage card using Sprite Backup. 

To clean reset your PAC Mate Omni, use a straightened paper clip or a 
toothpick and press down gently on the reset button while simultaneously 
holding the power switch in the off position - away from the 
CompactFlash slots. Once you begin holding the power switch, you can 
release the reset button. When you begin holding the power switch, you 
will hear a low-high beep. Continue holding the switch for about six 
seconds until you hear a second low-high beep and release the switch. 
The reset process may take up to 10 minutes, depending on how much 
data is stored on your PAC Mate Omni. Once completed, you will hear a 
chime followed by the message "JAWS for Pocket PC is loading” and the 
version number, followed shortly after by another chime. After the second 
chime, you are placed on the Today screen ready to use your PAC Mate 
Omni.  

At this point, the PAC Mate Omni has been reset to factory settings and 
any user data including programs you installed are gone. You will need to 
restore from your backup file, or synchronize with your computer in order 
to restore your data. 

If you accidentally release the switch before the second low-high beep, a 
cold reset (described above) is performed instead and your data is not 
erased. 
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Carrying Case 

The PAC Mate Omni carrying case is specifically designed to protect your 
unit. It is lightweight and water-resistant. 

There are two straps supplied with the carrying case:  

 A wide strap with a shoulder pad. This strap attaches to the carrying 
case, itself. 

 A narrow strap that attaches to the posts on the front edge of the PAC 
Mate Omni or, if installed, your braille display. 

These straps are adjustable to maximize comfort during transport. In 
addition, you can easily remove the straps and store them along with 
other items in the case's zippered pocket.  

The case can be used when the braille display is attached as well as 
when it is not attached. 

General Care of Your PAC Mate Omni 

The plastic body of the PAC Mate Omni is made of a blend of high impact 
polycarbonate and heat resistant polymers that meet strict environmental 
standards. In order to keep your PAC Mate Omni in good working 
condition, it is recommended that you store your unit in a dry place away 
from direct sunlight. Avoid operating the unit around liquids or food, and 
always operate the unit with clean, dry hands. 

Clean the unit with a dry cloth and do not use commercial cleaners on 
any part of the unit. 

Never use or store the PAC Mate Omni in an environment where it will be 
exposed to extremes of light, temperature, moisture or vibration. 
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Setting Up the PAC Mate Omni 

The PAC Mate Omni allows you to modify many settings that determine 
what and how much information JAWS reads. In addition: you can set 
alarm notifications, choose to read time in different formats, select what 
programs appear in the Start Menu and in the Programs submenu, and 
customize the Today Screen to view only those items you want. 

For ease of reading and usability, this section mirrors the list view 
sequence in the Settings multipage dialog box found in the Start Menu. 

Braille Settings 

The Braille Settings multipage dialog box configures the behavior of your 
braille display. 

To configure your braille display, press WINDOWS Key, S, and if 
necessary B to select Braille Settings, otherwise press ENTER to open 
the Braille Settings dialog box. When the dialog box opens, press 
CTRL+TAB to navigate from tab to tab. 

General Tab 

Braille Mode: This combo box is used to determine the format of the 
information sent to the braille display. The following options are available: 

 Line: The line of text at the current cursor position is sent to the braille 
display.  

 Structured: The information relevant to the current cursor position is 
sent to the braille display. This is the default option.  

 Speech Box: The same information is sent to the braille display as is 
sent to the synthesizer.  

Reverse Advance Buttons: If this check box is checked, pressing an 
advance button that ordinarily pans left will result in advancing to the right 
and pressing an advance button that ordinarily pans right will advance to 
the left. This item is not checked by default. 
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8 Dot Braille: If this check box is checked, the display uses 8 dot braille. 
This item is checked by default. 

Braille Follows Active: If this check box is checked, the Braille Cursor 
follows as you move the active cursor, but is not limited to where the 
active cursor can move. For example, when moving through a dialog box, 
the Braille Cursor moves to each control as you press TAB. This item is 
checked by default. 

Active Follows Braille: If this check box is checked, the Braille Cursor 
and the active cursor are linked together. When you move the Braille 
Cursor, the active cursor also moves. However, you cannot move the 
Braille Cursor where the active cursor cannot move. For example, with 
the PC cursor active, you cannot read down to the status line of a 
window. This item is checked by default. 

PC Follows Braille: If this check box is checked, only the PC cursor 
follows when you move the Braille cursor. This allows you to use another 
cursor, such as the JAWS cursor, to review the screen without it being 
routed to the location of the Braille cursor. This item is not checked by 
default. 

Highlight: When this check box is checked, text that is highlighted is 
indicated with the addition of dots 7 and 8. Unchecking this may help new 
braille users become accustomed to working with a braille display. This 
item is checked by default.  

Suppress Capital Signs: When this item is checked, capital signs are 
not shown on your braille display. This item is unchecked by default. 

Word Wrap: If this check box is checked, PAC Mate Omni does not split 
a word that is too large to be shown on the Braille display. When you pan 
to the next increment, you can read the word in its entirety. If you clear 
this check box, PAC Mate Omni displays as much of the word as 
possible, but a portion may be cut off. PAC Mate Omni shows the 
remainder of the word when you pan to the next increment. This item is 
checked by default. 
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Dot Firmness: Specifies the firmness of braille dots on the PAC Mate 
Omni and Focus displays. There are five levels of firmness. Adjust the 
display to the level of firmness most suited to the sensitivity of your 
fingers. 

Focus Braille Display Options Button: This button is only available 
when a Focus Braille display is connected to your PAC Mate Omni. Use 
this button to open the Focus Braille Display Options dialog box where 
you can adjust settings for a Focus Braille display. 

Languages Tab 

Primary Language: This combo box allows you to select the primary 
braille language. You can choose from the following languages: English, 
French European, French Canadian, German, Italian, Portuguese, 
Spanish, Polish, Dutch, Danish, Russian, and Greek. 

Primary Braille Format: This combo box is used to determine how text 
is displayed on your braille display. The following options are available: 

 Computer Braille: Computer braille text is shown as computer braille 
on your braille display unless a file containing contracted braille text, 
such as a BRF file, is open. This is the default setting.  

 Contracted Output: Computer braille text is shown in contracted 
braille on your braille display.  

 Contracted Input: This option is only available when Braille input 
mode (INSERT+SHIFT+F9) is active and allows you to use the Braille 
Keyboard to enter text into documents or other edit fields using 
contracted braille. Computer braille text is shown in contracted braille 
on your braille display. For more information on Braille input mode, 
see Typing in Braille.  

If the language you selected in the Primary Language combo box does 
not support contracted braille, this combo box will be unavailable. 
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Primary Expand Current Word: Available when contracted output or 
contracted input is selected, if this check box is checked and computer 
braille text is shown in contracted braille on your braille display, then the 
word at the position of the Braille cursor is displayed in computer braille. 
If this check box is not checked and computer braille text is displayed in 
contracted braille, then the Braille cursor rests at the beginning of the 
current word and moves as you navigate from word to word. This item is 
checked by default.  

Primary Enable UEB: If this check box is checked, and Contracted 
Output is selected, computer braille text is shown in Unified English 
Braille on the braille display. If Braille input mode is active, you can write 
text into a document using Unified English Braille. This item is not 
checked by default. You should only enable this option if you regularly 
read and write UEB files. This option is not available if the Primary Braille 
Format is set to computer braille or if the braille language is set to any 
language other than English.  

Secondary Language: This combo box allows you to select the 
secondary braille language that is enabled when you use INSERT+S, T 
to switch between the primary and secondary braille language. You can 
choose from the following languages: English, French European, French 
Canadian, German, Italian, Portuguese, Spanish, Polish, Dutch, Danish, 
Russian, Greek, or None.  

Secondary Braille Format: This combo box is identical to the Primary 
Braille Format combo box described above. It is used to determine how 
text is displayed on your braille display. If the language you selected in 
the Secondary Language combo box does not support contracted braille, 
this combo box will be unavailable. 

Secondary Expand Current Word: Available when contracted output or 
contracted input is selected, if this check box is checked and computer 
braille text is shown in contracted braille on your braille display, then the 
word at the position of the Braille cursor is displayed in computer braille. 
If this check box is not checked and computer braille text is shown in 
contracted braille on your braille display, then the Braille cursor rests at 
the beginning of the current word and moves as you navigate from word 
to word. This item is checked by default.  
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Secondary Enable UEB: If this check box is checked, and contracted 
output is selected, computer braille text is shown in Unified English Braille 
on the braille display. If contracted input is selected, you can write text 
into a document using Unified English Braille. This item is not checked by 
default. You should only enable this option if you regularly read and write 
UEB files. This option is not available if the Secondary Braille Format is 
set to computer braille or if the Secondary braille language is set to any 
language other than English. 

Cursors Tab 

Use the Cursors tab to configure cursor behavior on a braille display 
attached to your PAC Mate Omni.  

Cursor Type: This list box contains three cursor types that you can 
configure:  

 PC Cursor: This cursor is linked to the keyboard functions of Windows 
and applications. This is the cursor that is used when typing 
information, moving through options in dialog boxes, and selecting 
options or icons. As you type information, the PC Cursor follows along 
with each key you press. If you are making a selection in a menu or 
dialog box, the PC Cursor highlights the currently selected object. The 
PC Cursor is activated by default when your PAC Mate Omni starts. If 
you are using a different cursor, pressing INSERT+SEMICOLON re-
activates the PC Cursor. 

 JAWS Cursor: The JAWS Cursor is linked to mouse pointer functions 
in Windows and other applications. It is used to read information the 
PC Cursor cannot read, such as toolbar information. In the Windows 
Mobile environment on the PAC Mate Omni, it can also be used to tap 
items on the screen. When the JAWS cursor is on a control or item 
that can be tapped, pressing INSERT+8 or pressing a cursor router 
button will activate that item. You therefore have access to information 
in an application window that is beyond the scope of the PC Cursor. 
To activate the JAWS Cursor, press INSERT+P. 
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 Invisible Cursor: The Invisible Cursor is similar to the JAWS Cursor. 
It is used solely for reviewing text on the screen and is most often 
used in applications where moving the mouse pointer changes the text 
being displayed. To turn on the Invisible Cursor, press INSERT+P 
twice quickly. 

Dot Pattern: The braille dots that will be used to represent the cursor. By 
default, these are DOTS 7-8 for each cursor type, but you can change 
these if you want to do so. 

Cursor: There are three radio buttons from which to choose:  

 Always up: The Braille Cursor is displayed as a steady 
representation. 

 Always down: The Braille Cursor is not displayed. 

 Blinking: The Braille Cursor blinks, providing an easily distinguished 
tactile reference point. 

Blink Rate: This setting controls the rate at which the Braille Cursor, if 
set to "Blinking," moves up and down. The smaller this number is, the 
faster the blink rate. The default is 500 milliseconds. 

Messages Tab 

Show Messages: This check box determines whether messages are 
shown on your braille display. It is checked by default. 

Duration: This combo box allows you to select the length of time 
messages are displayed. The default is 5 seconds and the range is from 
1 second to 10 seconds. 

Show Message Prefix: This check box allows you to determine whether 
message prefixes; which indicate what kind of message is being 
displayed; are shown. It is checked by default. 

Message Level: This combo box allows you to choose the level of 
messages to be displayed. The choices are Beginner, Intermediate, and 
Advanced. 
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Preferences: When you press ENTER on this button, a dialog box opens 
that allows you to choose the types of messages that will be displayed. 

Messages: This list box allows you to check the types of messages that 
will be displayed. The choices are:  

 JAWS Messages  

 Smart Help Messages  

 Status Messages  

 User Request Messages  

 Soft Key Messages 

Note: The message prefix is shown in parentheses following the 
message type. 

Focus Braille Display Options 

Placement of Status Cells: Specifies if the informational status cells are 
located on the left or right end of the display, or not displayed at all. The 
status cells are located at the left end of the display by default. 

Reading Line: Use the Reading Line edit spin boxes to show information 
within the portion of the display you want to use. The default settings are 
determined by the location of the status cells, and the length of the 
display. 

See Also: 

PAC Mate Omni with a Braille Display 

Buttons  

You can assign eight hotkey commands to any of the programs on your 
PAC Mate Omni from within the Buttons dialog box. This feature is 
convenient because anytime you want to open a program all you have to 
do is press the hotkey command. The following table lists the default 
program for each command.  
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Program Command 

Record INSERT+SPACEBAR, 1 

Calendar INSERT+SPACEBAR, 2 

Contacts INSERT+SPACEBAR, 3 

Tasks INSERT+SPACEBAR, 4 

Messaging INSERT+SPACEBAR, 5 

File Explorer INSERT+SPACEBAR, 6 

FSEdit INSERT+SPACEBAR, 7 

FSCalc INSERT+SPACEBAR, 8 

To assign a different program to a command, open the Buttons dialog 
box by pressing WINDOWS Key, S. Move to Buttons with the DOWN 
ARROW and press ENTER.  

The Buttons dialog box opens with the Program Buttons page. The list 
view, which has the eight hotkey commands and default programs, is 
active.  

Select a hotkey command by moving up or down with the arrow keys, 
then press TAB to move to the Button Assignment combo box. Use the 
arrow keys to move through the list and select a program you want to 
associate with the hotkey command.  

To assign the next program to a hotkey, press SHIFT+TAB to move back 
to the list view. Press DOWN ARROW to move to 
INSERT+SPACEBAR+2. By default this button is set to Contacts. To 
change the program, repeat the steps discussed above.  
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In addition to assigning programs to hotkey commands, you can assign 
commands for scrolling. These options are also listed in the Button 
Assignment combo box.  

Dictionary  

Use the Dictionary Settings dialog box (INSERT+S, D) to change the way 
PAC Mate Omni pronounces words, phrases, abbreviations, acronyms or 
ANSI symbols. The pronunciation changes you make are global so they 
occur in all programs on the PAC Mate Omni. 

To add a word to the Dictionary: 

1. Place the cursor in front of the word. 

2. Press INSERT+S, D to open the Dictionary Settings dialog box. 

3. Press ENTER to activate the Add button and open the Add 
Dictionary Definition dialog box. 

4. In the Actual Word edit field, type in the word that is at the cursor 
location. 

5. Press TAB to move to the Replacement Word edit field and type 
how you would like the word(s) pronounced. Do not include any 
punctuation marks. 

6. Press ALT+A to hear the actual word, and press ALT+R to hear 
the replacement word. 

7. When you are satisfied with the way JAWS pronounces the 
word, press the CLOSE button (ESC) to add the word. 

8. Press the CLOSE button (ESC) to exit. 

To Change or Delete Existing Entries: 

1. Press TAB to move to the Dictionary Entries extended list box. 
Use the arrow keys or first letter navigation to locate the entry 
you want to change or delete. 
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2. Press TAB to move to either the Change or Delete button and 
press ENTER. 

3. If you are changing an entry, press TAB to move to the 
Replacement Word edit field and type how you would like to 
have the text pronounced. Do not use any punctuation marks. 

4. Press ALT+A to hear the actual word, and press ALT+R to hear 
the replacement. 

5. When you are satisfied with the way JAWS pronounces the 
word, press the CLOSE button (ESC) to save the changed word. 

6. Press the CLOSE button (ESC) to exit. 

Alternatively, you can press TAB to move to the Search for Entries edit 
field and type the text you want to change or delete, then press TAB to 
move to the appropriate button and press ENTER. 

HTML Settings 

This dialog box controls the way the PAC Mate Omni reads pages written 
in html. If you intend to browse the web, understanding this dialog box is 
imperative.  

Open the Start menu (WINDOWS Key), press S to choose Settings. 
Press H once to select HTML Settings or use the arrow keys to select it. 
If an item is not selected, press the SPACEBAR first, and then use first 
letter navigation. Once HTML Settings is selected, press ENTER.  

When you open HTML Settings, you will hear the PAC Mate Omni say, 
"JAWS HTML Settings dialog box, Skip Past Repeated Text On New 
Pages check box, checked." With this control checked, the PAC Mate 
Omni skips text that is repeated on web pages within the same web site 
and automatically moves the cursor to new text found on the page.  
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When you press TAB to move forward, the next control you encounter is 
the "Lines Per Page" edit field. This setting determines how many lines 
the cursor moves when pressing PAGE UP or PAGE DOWN. With the 
default value set to twenty-four, the cursor moves twenty-four lines. For 
more information on moving through and reading text, please see PAC 
Mate Omni Basics, Working with Text. 

The next control is the "Maximum Line Length" edit field, which controls 
how many characters the cursor treats as one line of text. The default 
value is 150 characters.  

Headings are used to understand how each section of text relates to the 
web page as a whole. Press TAB to move to the "Headings Verbosity" 
combo box. With the Headings Verbosity combo box, use the arrow keys 
to choose whether the PAC Mate Omni announces headings and 
whether this includes heading levels. The default setting is Headings with 
levels indicated. 

Many web sites use Graphics as links. If you want the PAC Mate Omni to 
announce only graphical links that use alternate text, use the arrow keys 
to select Tagged Graphical Links in the Graphical Link Verbosity combo 
box.  

In addition to graphical links, frames are another web structure you will 
encounter. To control how the PAC Mate Omni responds to frames, 
choose one of the three options in the New Frame Indication combo box. 
Your options are:  

 No Indication: The PAC Mate Omni does not indicate when frames 
are entered or exited. 

 Say Frame Name: The PAC Mate Omni announces the frame name 
when it is entered or exited. This is the default option. 

 Say New Frame: The PAC Mate Omni announces when a frame is 
entered only. 

If you want to continue with adjusting HTML settings, press TAB to move 
to the Advanced button and press ENTER. If you are finished, press the 
CLOSE button (ESC) to return to the Settings dialog box. Press the 
CLOSE button (ESC) again to return to the Today Screen.  
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Advanced HTML Settings 

When you press SPACEBAR on the Advanced button in the JAWS 
HTML Settings dialog box, you open the HTML Advanced dialog box. 
The first three controls are check boxes, which are checked by default. 
To uncheck the boxes, press the SPACEBAR.  

The first check box is the "Say Link Type" check box, which sets the PAC 
Mate Omni to announce the type of links encountered when navigating 
an HTML document. To move to the next control, press TAB. 

With the "Identify Same Page Links" check box checked, the PAC Mate 
Omni announces when links point to other locations on the same page by 
stating, "Same page link."  

The "Indicate Tables" check box sets the PAC Mate Omni to announce 
the start of a table by declaring its number of columns and rows and 
when the end of the table is reached. To move to the next control, press 
TAB. 

The "Text Block Length" edit box lets you specify the number of 
characters in a block of text. This control affects the N command used in 
Internet Explorer Mobile. When you press this command, the PAC Mate 
Omni moves to the next block of non-link text that is equal to or greater 
than the number of characters specified in this edit box. The default value 
is 25. 

The "Text Link Verbosity" combo box determines what information the 
PAC Mate Omni speaks when a text-based link is encountered. The 
following options are available: 

 Speak Title Text: When this option is selected, the PAC Mate Omni 
speaks information provided by the HTML title attribute, which is not 
displayed on the screen. If no title text is found, the PAC Mate Omni 
reads the on-screen text. 

 Speak Screen Text: The PAC Mate Omni reads the on-screen text of 
the link only. This is the default option. 
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 Speak Longest: The PAC Mate Omni reads the longer string of text 
whether it is the on-screen text displayed as a link or a title tag 
attribute. This option is meant to provide you with the most information 
possibly available on an HTML page. 

To move to the next control, press TAB. 

Similar to the "Text Link Verbosity" combo box, the "Graphic Verbosity" 
combo box allows you to specify how you want the PAC Mate Omni to 
announce graphics within HTML documents. The following options are 
available: 

 No Graphics: Graphics are not announced. 

 Tagged Graphics: Graphics that have alternate text specified within 
the HTML document are announced. The PAC Mate Omni states 
"graphic" and then reads the alternate text. This is the default option. 

 All Graphics: All graphics are announced. 

The last control in this dialog box is the "Image Map Link Verbosity" 
combo box. This control determines how images, mapped with 
coordinates for use as links, are announced. The PAC Mate Omni offers 
the following options: 

 No Image Map Links: Image map links are not announced. 

 Tagged Image Map Links: Image map links that have Alternate text 
specified within the HTML document are announced. 

 All Image Map Links: All image map links are announced. This is the 
default option. 

If you are done, press the CLOSE button (ESC) to return to the HTML 
Settings dialog box. Press the CLOSE button (ESC) again to return to the 
Settings dialog box and once more to return to the Today Screen. 
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Input 

While this dialog box has limited support, it does contain two controls that 
may be beneficial for you to know about. The first control is the "Voice 
Recording Format" combo box. The settings in this combo box determine 
the quality of your voice recording. The default setting is 8000 Hz, Mono 
(2 KB/s), which gives you the longest possible recording time, but with 
the lowest recording quality. Naturally, Windows Mobile offers you a wide 
variety of settings to choose from. To learn more about the Voice 
Recording Feature, please see Notes, Creating a Recording. 

The second control in this dialog box is the "Capitalize first letter of 
sentence" check box. When this box is checked, anytime you press 
ENTER to start a new line in an edit field, the first letter of the line is 
capitalized. This control works only with Windows Mobile programs. 

To access these controls, go to the Input dialog box (WINDOWS Key, S, 
I, ENTER) and move to the Options page with CTRL+TAB. As the page 
opens the first active control is the "Voice Recording Format" combo box. 
Make your selection using the arrow keys and then press TAB until you 
reach the "Capitalize the first letter of sentence" check box. Use the 
SPACEBAR to disable or enable this control. 

Keyboard 

When you want to adjust the amount of feedback you receive as you type 
in an edit field, use the "JAWS Keyboard Settings" dialog box.  

To use this dialog box, open the Start menu (WINDOWS Key) and press 
S to choose Settings. Press K to move to Keyboard Settings and then 
press ENTER. When you open the Keyboard Settings dialog box, the 
Typing Echo combo box is active and ready for you to use the UP and 
DOWN ARROW keys to select an option. Your options in this combo box 
are:  

 Off: The PAC Mate Omni is silent as you type.  

 Characters: Each character you type is echoed.  

 Words: Each word you type is echoed after pressing SPACEBAR or 
ENTER.  
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 Characters and Words: Characters are echoed as you type them and 
words are echoed after you press SPACEBAR or ENTER. 

When you are done making your selection, press TAB to move to the 
next control. 

Tip:  You can also change these options with INSERT+S, K. Continue to 
press K until you select the option you want.  

The next control in this dialog box allows you to use the CAPS LOCK 
Key in addition to the INSERT as your JAWS Key command. To enable 
this control, use the SPACEBAR to place a check in the box. To use the 
CAPS LOCK Key you double press the key to toggle it on or off. 

The last control is a combo box that allows you to select your input 
language. Use the UP and DOWN ARROW keys to select an option. 

To save your settings and return to the Settings dialog box, press the 
CLOSE button (ESC). Press this key again to close the Settings dialog 
box and return to the Today Screen. Or if you want to explore the other 
pages in the Settings dialog box, press CTRL+TAB to move to the other 
pages. 

Menus 

Depending on the programs you use most, you may find it useful to 
arrange the Start Menu differently than the default. This is done from the 
Menus dialog box. 

To customize your menus, open the Start menu and press S to choose 
Settings. Press M to move to Menus and then press ENTER.  

The Menus dialog box opens in a list view. Use the UP and DOWN 
ARROW keys to move up and down the list. Programs with a selected 
check box appear in the Start menu, while programs with a clear check 
box appear in the Programs submenu. Press the SPACEBAR to select or 
clear a check box. The Start menu can only hold nine programs.  

When you are finished setting the Start menu, press the CLOSE button 
(ESC) to save your changes and return to the Settings dialog box. 
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System Sounds & Notifications  

The Notification System on the PAC Mate Omni is controlled from the 
Sounds & Notifications dialog box. In this dialog box, you can choose 
what events you'd like to receive notifications for, and how you'd like to 
be notified.  

Note:  The PAC Mate Omni does not support pop-up screen display 
notifications or screen taps. 

You open the Sounds & Notifications dialog box from the Settings list 
view on the Personal page. To quickly move to the Sounds & 
Notifications dialog box from the Today Screen, open the Start menu and 
press S to choose Settings. Press S to move to Sounds & Notifications 
and press ENTER. 

The Sounds & Notifications dialog box opens on the Sounds page. The 
first control is the "Enable sounds for Events (warnings, system events)" 
check box. Press the SPACEBAR to enable this control if you want to be 
alerted to system events such as the start and/or completion of 
synchronization or when e-mail arrives in your inbox. The next two 
controls are similar, except that they apply to program notifications such 
as reminders and alarms. Be sure to enable both the Programs and 
Notifications check boxes if you want to use appointment/task reminders 
and the alarms on the clock. The last control in this dialog box is the 
"Enable sounds for Hardware buttons" check box. This control is similar 
to the Typing Echo control in the Keyboard Settings dialog box, except 
that it is a key click. If you check this box, be sure to move to the 
accompanying radio buttons where you can use the LEFT and RIGHT 
ARROWS to decide how loud you’d like the "clicks" to be.  

When you are done with the Sounds page, press CTRL+TAB to move to 
the Notifications page.  

On this page, the Select an Event and the Select How to be Notified, Play 
Sound controls work in tandem. That is, as you select an event from the 
combo box, move forward and enable the Play sound check box. Then 
move to the next control, which is a combo box, and choose the sound 
you want to hear for this event’s notification. Remember in combo boxes, 
the UP and DOWN ARROW selects, while ENTER activates buttons.  
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When you are done with these settings, press the CLOSE button (ESC) 
twice to save and close this dialog box and return to the Today Screen. 

To adjust the system volume, from any program, press F6 to decrease 
the volume and F7 to increase the volume. When you use these 
keystrokes, the PAC Mate Omni will announce the current setting and 
then return to the currently open program. 

When you use F6 and F7 to set the volume, it is adjusted in increments of 
20 percent between 0 and 100. To adjust the volume in smaller 
increments, press INSERT+S to activate the Settings layer and use the 
UP and DOWN ARROW keys to raise and lower the volume. 

Text Settings  

Use the Text Settings dialog box to set preferences for how JAWS reads 
various text elements.  

To use this dialog box, open the Start menu (WINDOWS Key) and press 
S to choose Settings. Press T to move to Text Settings and then press 
ENTER. 

The Say All combo box determines how the PAC Mate Omni reads when 
you use the Say All command, INSERT+A. It also determines the 
element of text to be spoken when the Fast Forward and Rewind 
commands, RIGHT ARROW and LEFT ARROW, are used during the 
Say All to move through your document. Use the arrow keys to make a 
selection in this combo box. Your choices are: 

 Line with Pauses: This option reads by line, pausing slightly at the end 
of each line. Using the Fast Forward or Rewind commands causes 
the PAC Mate Omni to stop reading the current line and jump to the 
next or previous line where it immediately continues reading. 

 Line without Pauses: This option allows for smoother reading, pausing 
only at punctuation marks. As with the Lines with Pauses setting, 
using the Fast Forward or Rewind commands causes the PAC Mate 
Omni to stop reading the current line and jump to the next or 
previous line where it immediately continues reading.  

 Sentence: Select this option for applications in which Say All sounds 
choppy. This moves the pauses between elements to the ends of 
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sentences, and makes the reading sound smoother. Using the Fast 
Forward or Rewind commands causes the PAC Mate Omni to stop 
reading the current sentence and jump to the next or previous 
sentence where it immediately continues reading. 

 Paragraph: This inserts an extra pause between paragraphs. Using 
the Fast Forward or Rewind commands causes the PAC Mate Omni 
to stop reading the current paragraph and jump to the next or 
previous paragraph where it immediately continues reading. This 
option is very useful in large documents as you can fast forward or 
rewind quickly through the paragraphs without needing to interrupt 
Say All.  

The next control in this dialog box is the Say Blank Lines check box. 
Use the SPACEBAR to check it if you want blank lines announced 
when using the Say All command. This control is unchecked by 
default. 

If you want JAWS to speak numeric dates in a different format, use the 
Numeric Date Processing combo box to select a format. Your choices 
are: 

 No Translation: If this option is selected, numeric dates are read as 
numbers. This option is selected by default.  

 Some Translation: If this option is selected, numeric dates of month 
followed by day followed by year and separated by slashes or dashes 
are translated. For example, 03-16-00 is read as "March sixteenth two 
thousand."  

 Full Translation: If this option is selected, numeric dates of month 
followed by day and separated by slashes or dashes are translated in 
addition to those dates translated with Some Translation selected. For 
example, 03-16 is read as "March sixteen."  

Use the TAB command again to move to the Number Processing 
combo box. This combo box allows you to determine how numbers are 
read. Use the arrow keys to make your selection. Your choices are: 

 Digits: If this option is selected, numbers are read as a series of 
single numbers. For example, 123 is read "one two three."  
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 Pairs: If this option is selected, numbers are read as a series of paired 
numbers. For example, 1050 is read as "ten fifty." If the number has 
an odd number of digits, the first digit is read as a single digit and the 
rest are paired. For example, 123 is read "one twenty three."  

 Whole Numbers: If this option is selected, numbers are always read 
as complete numbers. For example, 123 is read as "one hundred 
twenty three." This is the default option.  

The next control in this dialog box is called Mixed Case Processing. This 
control causes JAWS to speak words that are joined together with capital 
letters, such as Say All, as two words. This check box is enabled by 
default. To disable, use the SPACEBAR. 

Immediately after the Mixed Case Processing check box, is the Speak 
Dollars check box. With this check box enabled, JAWS reads numbers 
preceded by a dollar sign ($) in the format of number of dollars and 
number of cents. For example, $9.95 is read as "nine dollars and ninety 
five cents." For monetary values less than a dollar, type a zero to the left 
of the decimal. For example, $0.02 is read as "two cents." This check box 
is disabled by default.  

To close this dialog box, press the CLOSE button (ESC). If you want to 
explore the other pages in the Settings dialog box, press CTRL+TAB to 
move to the other pages. 

Today  

Use the Today dialog box to change the items and their information listed 
on your Today Screen.  

To use the Today dialog box, open the Start menu (WINDOWS Key) and 
press S to choose Settings. Next, press T twice to move to Today and 
then press ENTER.  

Note: When the Today dialog box opens, the PAC Mate Omni 
announces "Today dialog, Appearance page." This page allows 
you to change the Appearance of the Windows Mobile user 
interface and is not supported in the PAC Mate Omni. 
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Press CTRL+TAB to move to the Items page. Use the UP and DOWN 
ARROW keys to move up and down the list of items and press the 
SPACEBAR to select or clear the associated check boxes.  

You can rearrange the order in which the items appear on the Today 
Screen. Use the arrow keys to move to each item in the list view. Press 
TAB to see which of the three buttons, the Move Down, Move Up, and 
Options, become available for each item. Press ENTER to activate the 
buttons. The Options button lets you alter the information that is 
displayed for Calendar and Tasks. 

To save your settings and return to the Settings dialog box, press the 
CLOSE button (ESC). To close the Settings dialog box and return to the 
Today Screen, press the CLOSE button (ESC) again. 

Verbosity  

Use the JAWS Verbosity dialog box to set JAWS verbosity levels: 
Beginner, Intermediate, or Advanced. This determines how much 
information JAWS speaks.  

Open the Start menu (WINDOWS Key) and press S to choose Settings. 
Press V once to move to Verbosity Settings and press ENTER. 

With the JAWS Verbosity Settings dialog box open, use the UP and 
DOWN ARROW keys to select the Verbosity Level in the combo box. 
Move to the Preferences button and press ENTER. This opens the 
Advanced Preferences dialog box, where you can choose how much 
information JAWS speaks. Press TAB to move about the dialog box. Use 
the SPACEBAR to select the check boxes next to the type of message 
you want to hear. In the Message Length combo box, use the UP and 
DOWN ARROW keys to select long or short, and then press TAB. If you 
want to restore the default settings, move to the Restore Default Settings 
button and press ENTER. To close the Preferences dialog box and save 
the settings, press the CLOSE button (ESC).  
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Before you exit out of JAWS Verbosity Settings, there are two more 
controls in this dialog box that you should know about. They are the Tutor 
Messages and the Access Key Messages. These check boxes are 
unchecked by default. Tutor Messages provide navigational tips, while 
Access Key Messages provide information on the access key that moves 
you directly to a control or to an item in a menu. If you prefer to enable 
this additional verbosity, use the SPACEBAR to check these controls. 

If you want to continue adjusting features on your PAC Mate Omni, return 
to the Settings dialog box by pressing the CLOSE button (ESC) and use 
first letter navigation or the arrow keys to move through the list view. 

To close the Settings dialog box, press the CLOSE button (ESC) key 
again.  

Certificates 

Certificates establish your identity and the identity of other computers 
when you are logging onto a secured network. On the PAC Mate Omni, 
you can store three types of certificates: personal certificates that 
establish your identity, intermediate certificates that help authenticate 
other certificates, and root certificates that establish the identity of servers 
with which you connect. 

To access the Certificates multipage dialog box, press WINDOWS Key, S 
to open the Settings dialog box, then press CTRL+TAB to move to the 
System page. Use the arrow keys to move to Certificates and press 
ENTER. 

On the Personal page of the Certificates dialog box is a list that displays 
the name of the certificate issuer and the expiration date. 

To read more information about a certificate, press ENTER on a 
certificate in the list. To delete a certificate, select a certificate and press 
the APPLICATIONS Key, and then from the Context Menu choose 
Delete. 

To view intermediate or root certificates, press CTRL+TAB to move to 
the particular page and follow the directions given above to read more 
information or delete a certificate.  
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Clock 

The Clock dialog box features two clocks: one for home and one for 
visiting. So if you visit or have family that lives in a particular time zone 
you may want to adjust your Visiting clock to reflect that time zone. The 
Home clock is intended to keep time for the zone that you live in. 

To set the time and date on your PAC Mate Omni: 

1. Open the Start menu (WINDOWS Key) and press S to choose 
Settings. 

2. Press CTRL+TAB to move to the System page, press C twice to 
select Clock and Alarms, and then press ENTER. Note: You can 
also access this dialog box from the Today screen by pressing 
ENTER on the time or date items. 

3. Use the UP or DOWN ARROW to choose the appropriate radio 
button and view either the Home or Visiting clock. Each clock 
allows you to change the time zone, the time, and the date.  

4. Press TAB to move to the Time Zone combo box and use UP or 
DOWN ARROW to select your time zone.  

5. Press TAB to move to the Time field. To move between the 
hour, minutes, and seconds of the time control, use the LEFT 
and RIGHT ARROWS. To set these parameters, use the UP and 
DOWN ARROWS.  

6. Press TAB to move to the Date field. To move between the day, 
year, and month of the date control, use the LEFT and RIGHT 
ARROWS. To set these parameters, use the UP and DOWN 
ARROWS.  

7. When you are finished setting the time and date, press the 
CLOSE button (ESC). The PAC Mate Omni asks, "Save 
changes to clock settings?" Select the Yes button to confirm and 
save the settings. 
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Using the Alarm 

This feature accommodates up to three alarm settings and requires that 
you enable the "Notifications (alarms, reminders) check box in the 
Sounds & Notifications dialog box. For more information, please see 
Setting Up the PAC Mate Omni, System Sounds & Notifications. 

To set an alarm:  

1. Open the Start menu (WINDOWS Key) and press S to choose 
Settings.  

2. Press CTRL+TAB to move to the System page, press C twice to 
select Clock and Alarms, and then press ENTER. Note that you 
can also access this dialog box from the Today screen by 
pressing ENTER on the time or date items. 

3. Once this dialog box opens, press CTRL+TAB to move to the 
Alarms page.  

4. Now, press TAB once to hear, "Alarm 1 check box not checked." 
Use the SPACEBAR to select this check box.  

5. Press TAB and The next control you encounter is an edit field 
where you can type in a reason for the alarm. For example, 
"Wake up."  

6. To choose how you would like to be notified, TAB to the Set 
Notification Sound button and press ENTER. This opens a new 
dialog box, which consists of two check boxes and a combo box. 
Use the appropriate commands to navigate and activate the 
controls on this page. Use the combo box to select the sound 
you want to hear when your alarm goes off. When you are done, 
press the CLOSE button (ESC) to return to the Alarms page.  
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7. The last control to set for the alarm is the day(s) you want it to 
sound. For instance, you would like your alarm to sound off 
everyday except Saturday and Sunday. To select Monday 
through Friday, move to each day with the LEFT or RIGHT 
ARROW and press the SPACEBAR. You should hear "Monday 
selected," "Tuesday selected," etc., but for each weekend day 
you will only hear Saturday and Sunday. To unselect a day, 
press the SPACEBAR again.  

If you want to set Alarm 2 or Alarm 3, select the respective check box and 
follow the steps above. 

Note: Only WAV files are displayed in the list of available alarm sounds. 

Changing Time Format 

If you prefer reading time in 24 hour format, close the Clock dialog box by 
pressing the CLOSE button (ESC) to return to the System page in the 
Settings dialog box. Press R to move to Regional Settings and then press 
ENTER. Press CTRL+TAB to move to the Time page. To change the 
time display to 24 hours, choose a time style that starts with a capital "H."  

Memory  

The Memory dialog box displays information on the available and used 
memory on your PAC Mate Omni as well as any storage cards or USB 
thumb drives you have connected. 

To check memory, open the Start menu (WINDOWS Key), S for Settings, 
CTRL+TAB to the System page, press M to select Memory, and press 
ENTER. Press CTRL+TAB to move between the pages in this dialog box 
and press TAB to move through the various controls on each page. 
Press the CLOSE button (ESC) when finished. 
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The Main page displays the internal memory on the PAC Mate Omni. 
First, it shows the total amount of storage memory installed, how much is 
currently being used, and how much is free. Storage memory refers to 
the PAC Mate Omni’s onboard Flash memory where all of your files and 
installed programs are kept. Next, you will then see the total amount of 
program memory installed, how much is in use, and how much is free. 
Program memory refers to the PAC Mate Omni’s internal RAM where the 
operating system and other installed programs run. Program memory is 
managed automatically by the operating system. Use the arrow keys to 
read this information. 

The Storage Card page is similar to the Main page except it shows 
memory information for any storage cards or USB thumb drives that are 
inserted in your PAC Mate Omni. If you have multiple storage cards 
inserted, TAB to the Storage combo box, press ALT+DOWN ARROW to 
open this combo box, and select the storage card you want to view. If no 
storage devices are connected, this page is blank. 

Freeing Memory 

When a program becomes unstable or when program memory is low, the 
first step to take is to free memory manually by stopping any active 
programs on your PAC Mate Omni.  

To do this, open the Start menu (WINDOWS Key) and press S to choose 
Settings. Press CTRL+TAB to move to the System page. Now, press M 
to move to Memory and press ENTER to open the Memory multi-page 
dialog box. Next, press CTRL+TAB to move to the Running Programs 
page. To move to the list view on the Running Programs page press TAB 
and select the Program(s) in the list using the DOWN ARROW. Press 
ENTER on the Stop button to stop the currently selected program. Press 
ENTER on the Activate button to switch to the currently selected 
program. Press ENTER on Stop All button to stop all programs currently 
running on the PAC Mate Omni.  

Tip:  Press CTRL+ALT+M from anywhere in the PAC Mate Omni to 
quickly open the Running Programs page. 
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The second step would be to store files on a CompactFlash® card. Open 
the Start menu, move to Programs, and press ENTER. Move to File 
Explorer and press ENTER again. Select the file with the DOWN or UP 
ARROW, or select multiple files with SHIFT+DOWN ARROW or 
SHIFT+UP ARROW. Next, press the APPLICATIONS Key and from the 
context menu, choose Cut and press ENTER. Press ALT, select Show 
By, then use the DOWN ARROW to select Storage Card and press 
ENTER. With Storage Card open, press the APPLICATIONS Key again, 
choose Paste and press ENTER. For more information on working with 
File Explorer, please see Using File Explorer. 

If the first two steps do not free enough memory, the third step would be 
to delete unnecessary files. In File Explorer, choose a file(s), press the 
APPLICATIONS Key, and select Delete.  

To find and delete your largest files, Go to the Start menu (WINDOWS 
Key), move to Programs, and choose Search. Press TAB to move into 
the Type combo box, and select Larger than 64 KB, then press ENTER.  

In Internet Explorer, delete all files and clear history.  

The last step would be to remove the programs you are not currently 
using. For more information on removing programs, please see PAC 
Mate Omni Basics, Removing Programs.  

Power  

Use the Power dialog box to view the charging status of the battery and 
to set the length of time that will expire before the PAC Mate Omni 
automatically shuts off. When you have finished, press the CLOSE 
button (ESC) to save your settings. 

To open the Power dialog box, press WINDOWS Key, S, press 
CTRL+TAB to move to the System page, use the ARROW Keys to move 
to Power and press ENTER. 

 The Battery page displays the amount of battery power remaining. 
How long your battery power lasts depends on how you use your PAC 
Mate Omni. 
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 On the Advanced page, you can select options for turning off your 
PAC Mate Omni to conserve battery power. To conserve the most 
power, select the Turn off device if not used for check box. If you press 
TAB, you will find a combo box that lets you adjust how long the PAC 
Mate Omni waits before turning off if it is not being used. By default, 
the PAC Mate Omni will automatically turn off if it is not used for five 
minutes.  

Recording Settings 

Use the Recording Settings dialog box to configure some of the recording 
functions. When you have finished, press the CLOSE button (ESC) to 
save your settings. 

To open the Recording Settings dialog box, press WINDOWS Key, S. 
Then, press CTRL+TAB to move to the System page. Use the arrow 
keys to select Recording Settings and press ENTER. 

You can use the headset/external microphone jack to create recordings 
from other audio devices such as cassette recorders, radios, musical 
instruments, and so on. Use the settings on this page to configure the 
PAC Mate Omni for maximum flexibility when using the headset/external 
microphone jack as a line-in recording source. For more information on 
the headset/external microphone jack, please see Ports for details. 

 Reduce Headset Microphone Level: Use the SPACEBAR to select 
this choice when you intend to use the headset/external microphone 
jack as a line-in source without an attenuated patch cord (see below). 
Selecting this item changes the electrical characteristics of the jack so 
that you can use a standard patch cord (available from most 
electronics stores) to connect the audio source to your PAC Mate 
Omni. When selected, the headset microphone and earphone are 
disabled. This item is cleared by default. 

 Monitor Using Headphones: Selecting this item enables you to 
monitor recordings through headphones as they are being made. This 
also activates the PAC Mate Omni's built-in microphone, allowing you 
to insert voiceover notes while recording. This choice is cleared by 
default. 
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 Disable Automatic Level Control: Selecting this item disables 
Automatic Level Control (ALC). This choice is cleared by default, 
causing ALC to be enabled. If you select this item, there is no way to 
independently adjust recording volume. 

Notes: If you plan to use the line-in recording feature frequently, you may 
want to purchase an attenuated patch cord. These cords, 
available from most electronics stores, decrease the volume level 
that is sent to the recording circuit of the PAC Mate Omni, 
reducing the possibility of damage from "overdriving" the circuit. 
When using an attenuated patch cord, be sure that the 
headset/external microphone jack is not attenuated. 

You will need an adapter plug to convert one end of the regular or 
attenuated patch cord to a 2.5 mm plug to fit the PAC Mate Omni's 
headset/external microphone jack. 

Freedom Scientific does not provide technical support for any external 
audio devices other than those included with the unit. While it is unlikely, 
it is possible that an external device could damage your unit or that an 
external device could be damaged while using this feature. Damage to 
your PAC Mate Omni caused by external devices may not be covered 
under your warranty or Product Maintenance Agreement (PMA). In 
addition, Freedom scientific assumes no liability for damage to any third 
party device that may be incurred while using the PAC Mate Omni in this 
configuration. 

Regional Settings  

To set your PAC Mate Omni to reflect the currency, time, date and 
numbers of a specific country, use the Regional Settings dialog box. 
Windows Mobile has over 80 regional settings to choose from. 

To open the Regional Settings dialog box, open the Start menu 
(WINDOWS Key) and press S to choose Settings. Press CTRL+TAB to 
move to the System page. Press R to select Regional Settings and then 
press ENTER. The Regional Settings dialog box opens with the Region 
page active. There is only one control on this page. For this combo box 
control, use the arrow keys to select a region.  
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If you want to make further changes or just explore the other pages in this 
dialog box, press CTRL+TAB to move back and forth between pages. To 
move onto a page and navigate through the controls use the TAB and 
SHIFT+TAB commands. To make a selection in combo boxes, use the 
UP and DOWN ARROWS.  

Beam 

The PAC Mate Omni allows beaming of information to and from other 
infrared compliant devices. The infrared port is active by default. In 
certain situations or if you are not using the port you may want to 
consider deactivating it as its activation uses up battery life. 

Deactivating the Infrared Port: 

1. Press WINDOWS Key to go to the Start Menu. 

2. Press S to select Settings. 

3. Press CTRL+TAB to move to the Connections page. 

4. Move to Beam and then press ENTER. 

5. Press SPACEBAR to clear the "Receive all incoming beams" 
check box. 
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Connecting the PAC Mate Omni 

In keeping with the latest technology, the PAC Mate Omni features a 
variety of connectivity options that let you transfer and receive information 
easily. With the QX400, you can: 

 Use a USB cable or an infrared beam with ActiveSync to connect your 
PAC Mate Omni to a computer and share information or files. 

 Use a modem or Ethernet card to connect to the Internet or a local 
network, where you can browse Web pages, send/receive e-mail, or 
share files. 

 Output information to other devices using USB data transfer.  

 Beam information to another device using the infrared port. 

 Use WiFi and Bluetooth Technologies to connect to the Internet, 
private networks, and any compatible device. 

To view a hardware compatibility list, please visit www.pacmategear.com. 

Connecting with ActiveSync 

This section provides instructions on how to install ActiveSync, set up a 
partnership, and use some of the more popular features. For more 
information about using ActiveSync, refer to the ActiveSync help topics 
on your PC. 

Tip: The PAC Mate Omni QX400 Quick Start Guide contains JAWS 
related instructions on using ActiveSync Help on the PC. 

Microsoft® ActiveSync® is already installed on your PAC Mate Omni. 
However, you must install ActiveSync 4.5 on your PC.  

If you want to synchronize e-mail, Calendar Appointments, Contacts, and 
Tasks with your computer, make sure you have Outlook® 2002 or later 
on your computer. If you do not have Outlook, the Companion CD 
provides a link to download a 60-day trial of Outlook 2007. 
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Installing ActiveSync  

If your computer is running Windows 2000 or XP, you must use 
ActiveSync 4.5 or later in order to set up a partnership and synchronize 
information with your PAC Mate Omni. If your computer is running 
Windows Vista, you will use the Windows Mobile Device Center. You will 
not be able to synchronize the PAC Mate Omni with any computer 
running Windows 95, 98, or Me as ActiveSync 4.5 does not support these 
operating systems. 

ActiveSync 4.5 and the Windows Mobile Device Center are available on 
the Companion CD. To install, follow these steps: 

1. Plug in the PAC Mate Omni using the AC adapter.  

2. Put the PAC Mate Omni Companion CD in your CD-ROM drive. 
The set up program will automatically detect the version of 
Windows you are running and will offer you either ActiveSync or 
the Windows Mobile Device Center. Follow the instructions to 
install the software on your PC. If the Setup program does not 
automatically start, do the following depending on your version of 
Windows: 

 If you are running Windows 2000 or Windows XP, open the 
Start Menu and select Run. Use the browse button to move to 
D:\ACTIVESYNC\WWE, where D is the letter of your CD-
ROM drive. Go to the Setup.msi file and press ENTER to start 
installation.  

 If you are running Windows Vista, open the Start Menu and 
select Run. Use the browse button to move to 
D:\WMDC\WWE, where D is the letter of your CD-ROM drive. 
Depending on whether you are running a 32-bit or 64-bit 
version of Vista, select either drvupdate-x86.msi or 
drvupdate-amd64.msi and press ENTER to start installation.  
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3. When you are prompted, turn on and connect the PAC Mate 
Omni to the PC using the USB cable. Once you do this, 
ActiveSync or the Windows Mobile Device Center should 
automatically detect your PAC Mate Omni and the 
Synchronization Setup wizard will launch. Select Next to begin 
setting up a standard partnership or choose Cancel to 
synchronize as a guest. In the Windows Mobile Device Center, 
select the Setup your device lynk to establish a partnership or 
the Connect without setting up your device link to connect as a 
guest. 

(Optional) Configuring ActiveSync  

To prevent your PAC Mate Omni from trying to synchronize when it is not 
connected to a server, you will need to configure the options in the 
schedule dialog box in ActiveSync on your PAC Mate Omni. 

1. Open the Start menu, press P to open the Programs menu, and 
choose ActiveSync.  

2. Press F2 to open the menu, and choose Schedule.  

3. Press TAB to move to the different controls in this dialog box.  

4. Make the appropriate changes.  

5. Press the CLOSE button (ESC) to save changes and close the 
dialog box. 

Creating a Partnership to Synchronize 

With ActiveSync, you can establish two types of partnerships: standard 
and guest.  

 A standard partnership allows for synchronization of data. With a 
standard partnership you can specify what data you want synched as 
well as copy and move information and/or add and remove programs.  

 A guest partnership does not allow synchronization, you can only copy 
and move information, and/or add and remove programs.  



 

72 

1. With the Synchronization Setup Wizard open on your desktop, 
press ENTER on the Next button.  

2. When the next page of the Wizard opens, the default selection is 
to "synchronize with a server running Microsoft Exchange." If 
you want to synchronize with an exchange server, do not clear 
the check box, press ENTER, and proceed to the next step. If 
you want to only synchronize with your computer, use 
SPACEBAR to clear the check box, press ENTER, and skip to 
step four.  

3. (Optional) Type in the requested information, pressing TAB to 
move to the next edit field. If you want to save your password so 
you do not have to retype it, press SPACEBAR to check the 
"Save Password" check box. After entering your information, 
press ENTER.  

4. To control which and how much information gets synchronized, 
move to the item in the list view, and press SPACEBAR to check 
the item.  

5. After checking an item, press TAB to move to the Settings 
button and press ENTER. (This button is only available for 
certain items in the list view.) 

6. Choose the parameters you want for synchronization, and press 
ENTER on the OK button to close the "Synchronization Settings" 
dialog box.  

7. Press TAB to move to the Next button and press ENTER.  

8. Use the SPACEBAR to check the Allow wireless data 
connections check box if you want to continue using your PAC 
Mate Omni to access your wireless network while synchronizing 
and press ENTER on the Next button. 

Note:  Beginning with ActiveSync 4.0, it is no longer possible to 
synchronize with a computer over a wireless network. 

9. Press ENTER again to complete the Synchronization Setup 
Wizard. ActiveSync automatically starts synchronizing. 
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Creating a Partnership in the Windows Mobile Device 
Center 

10. Press ENTER on the Setup Your Device link.  

11. On the next screen, move through the list view and use the 
SPACEBAR to check the items you want to synchronize. After 
selecting the items you want, press ENTER on the Next button.  

12. If you want to synchronize with an exchange server, press TAB 
to move through this screen and enter your server information 
and choose Next. If you do not want to synchronize with an 
exchange server, choose Skip. 

13. If you want to specify a name for your partnership, type it into the 
edit field or use the default name. Press ENTER on the Setup 
button to complete the wizard and begin synchronization.  

For more information on using Windows Mobile Device Center, select the 
Help and About link. 

Using Infrared with ActiveSync 

1. In ActiveSync on your PC, press ALT+F, C to open the File 
Menu and the Connection Settings dialog box. 

2. Press TAB to move to the Allow connections to one of the 
following check box and press the SPACEBAR to check this 
box. 

3. Press TAB to move to the associated combo box, and use the 
arrow keys to select Infrared Port (IR). 

Line up the infrared (IR) ports on the devices so that they are 
unobstructed and within a close range. The IR port window is to 
the left on the back side of the PAC Mate Omni. 

4. On your PAC Mate Omni, press the WINDOWS Key to go to the 
Start Menu and press P to move to Programs. 
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5. Select ActiveSync. 

6. Press F2 to open the menu and press ENTER on Connect via 
IR. Synchronization will begin. 

7. To end an infrared connection, move the PAC Mate Omni away 
from the PC. 

You can beam a file using infrared to and from a PC with the following 
applications: 

 Tasks  

 Contacts  

 Calendar  

 Notes  

 File Explorer  

 Excel Mobile  

 PowerPoint Mobile  

 Word Mobile 

Troubleshoot an ActiveSync connection 

Try the following if you are attempting to connect your PAC Mate Omni to 
a computer, and ActiveSync does not recognize it, or the program stops 
responding (or hangs) while connecting to ActiveSync. Troubleshooting is 
often a matter of systematically testing the possible solutions, usually 
beginning with the simplest for speed and convenience and moving on to 
more complex solution tasks. Perform the following steps in order, one at 
a time, until one works for you. For more detailed information, go to the 
troubleshooting page on the Windows Mobile Web site located at 
http://go.microsoft.com/fwlink/?linkid=56375&clcid=0x409. 

1. Disconnect and reconnect the PAC Mate Omni.  

2. Disconnect, restart, and reconnect the PAC Mate Omni.  
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3. Disconnect the PAC Mate Omni, restart the computer, then 
reconnect the PAC Mate Omni.  

4. On the PAC Mate Omni, change the USB to PC setting:  

 Go to the Start menu, Settings, Connections.  

 Select USB to PC.  

 Use the SPACEBAR to check or uncheck the Enable advanced 
network functionality check box. By default, this option is checked.  

5. Do the following:  

 Disconnect the PAC Mate Omni.  

 Disable the firewall on the computer.  

 Reconnect the PAC Mate Omni.  

6. Do the following:  

 Disconnect the PAC Mate Omni.  

 Disable any antivirus software.  

 Reconnect the PAC Mate Omni.  

7. Do the following:  

 Disconnect the PAC Mate Omni.  

 Remove ActiveSync using Add/Remove Programs.  

 Install ActiveSync.  

 Reconnect the PAC Mate Omni.  

8. Do the following:  

 While the PAC Mate Omni is connected, Open Network Connections 
in Control Panel on the computer. Note If your Control Panel is set to 
Category View, open Network and Internet Connections, then open 
Network Connections 
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 Press the APPLICATIONS Key on the local area connection created 
by ActiveSync, and choose Properties. In the Connect using box, 
Windows Mobile-based device is displayed.  

 In This connection uses the following items, select every check box (to 
select all protocols), then select OK.  

 Disconnect then Reconnect the PAC Mate Omni. 

If you are still unable to connect to ActiveSync, even after performing 
these steps, contact Technical Support for more assistance. 

Connecting with a Network (Ethernet) Card  

An Ethernet card connects the PAC Mate Omni directly to a network or a 
high-speed Internet connection such as a cable or DSL modem.  

The PAC Mate Omni includes pre-installed drivers for the Rugged CF 
10/100 card from Socket Mobile (http://www.socketmobile.com), which 
means you can insert this card into your PAC Mate Omni and 
immediately begin using it. The following instructions assume the use of 
this particular card. If you choose to use a different network card, you will 
first need to install the appropriate Windows Mobile driver onto your PAC 
Mate Omni so the card will be recognized when you insert it. Check with 
the card manufacturer to make sure it is compatible with Windows Mobile 
6.0. 

Using a Network Card 

Once you have connected the network cable to the network card and 
inserted it into the CompactFlash® slot, the PAC Mate Omni 
automatically opens the Establishing Connection dialog box where you 
can choose to connect to the Internet or Work. This dialog box is an 
HTML window so it operates differently than most dialog boxes. To 
navigate this dialog box, use the arrow keys. To enable either radio 
button, press ENTER. If you need to change a connection setting, press 
ENTER on the Settings link. To close this dialog box, press ENTER on 
the Dismiss button. 
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For the most part, you should not have to do anything else except open 
Internet Explorer, Windows Live Messenger, Messaging or any other 
program that uses a network or the Internet. If you have not yet 
configured your e-mail account within Messaging, you will need to do so 
before you can send or receive e-mail. 

Connecting with a Modem 

A modem is a piece of hardware that uses a telephone line to dial into a 
network or Internet service. To connect your PAC Mate Omni to the 
Internet or network using a modem, you must first configure the 
connection settings. 

The PAC Mate Omni includes pre-installed drivers for the CF 56K Modem 
Card from Socket Mobile, which means you can insert this card into your 
PAC Mate Omni and immediately begin using it. The following 
instructions assume the use of this particular card. If you choose to use a 
different modem card, you will first need to install the appropriate 
Windows Mobile driver onto your PAC Mate Omni so the card will be 
recognized when you insert it. Check with the card manufacturer to make 
sure it is compatible with Windows Mobile 6.0. 

Configuring the Connection Settings 

When you first insert your modem in the PAC Mate Omni, a New Modem 
Detected dialog box automatically opens. In this dialog box there are two 
links that let you choose between connecting to the Internet or Work. To 
move around in this dialog box, use the arrow keys. To activate any of 
the controls, press ENTER. 

When you activate either the Internet or Work link, the Make New 
Connection dialog box in Settings automatically opens for you to begin 
configuring your modem connection settings. 

1. In the Enter a Name for the Connection edit field, type the name 
of the connection.  

2. Press TAB to move to the Select a Modem combo box. Your 
modem should be selected.  

3. Press F2 to move to the next screen. 



 

78 

4. In the next dialog box, type the Work or ISP phone number as it 
should be dialed. You can enter the phone number without 
spaces or dashes. Be sure to include any additional numbers 
such as '9,' for an outside line or '*70,' to disable call waiting. 

Note: The comma introduces a one second pause which allows the 
phone company's switching equipment to dependably prepare for 
the rest of the dialing sequence.  

5. Press ENTER on the "Use Dialing Rules" link only if you are 
dialing long distance and need to include the area code of your 
work or ISP phone number. 

6. Press F2 to move to the next screen. 

7. In the edit fields, type in your User Name and Password.  

8. Press TAB to move to the Advanced button and press ENTER. 

9. In the BAUD rate combo box, use the arrow keys to select 57600 
for a 56K modem. When you're done, press the CLOSE button 
(ESC) to close this dialog box and return to the previous dialog 
box. 

10. Press F2 to finish the connection setup.  

This finishes the steps of creating a connection and places you back at 
the Today Screen. 

From this point, the PAC Mate Omni will automatically connect as needed 
while you use Internet Explorer Mobile and Messaging. If you have not 
yet configured your e-mail service within Messaging, you will need to do 
so before you can send or receive e-mail. 

Connecting to a Wireless Local Area Network 

Wireless LAN connectivity allows for mobile computing in an open 
environment using a wireless network adapter and a compatible base 
station. 
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A wireless LAN can be any of the following technologies: 802.11a, 
802.11b, or 802.11g. 

The PAC Mate Omni includes pre-installed drivers for the Go Wi-Fi!™ 
P500 Card – CF from Socket Mobile and the Ambicom WL54CF WiFi 
card (http://www.ambicom.com), which means you can insert one of 
these cards into your PAC Mate Omni and immediately begin using it. 
The following instructions assume the use of these particular cards. If you 
choose to use a different wireless card, you will first need to install the 
appropriate Windows Mobile driver onto your PAC Mate Omni so the card 
will be recognized when you insert it. Check with the card manufacturer 
to make sure it is compatible with Windows Mobile 6.0. 

Using a Wireless LAN 

When the wireless card is first inserted, a dialog box will open that looks 
similar to a web page. This dialog box shows the router that is available, 
whether it is secure or not, and gives you the opportunity to connect to 
that router. Use the arrow keys to navigate this dialog box and press 
ENTER to enable the Internet or Work radio button depending on the 
type of connection. Then, press F1 to connect. 

In some cases, when you insert the card, a Multiple Networks Detected 
dialog box might open. This means that there is more than one wireless 
network in range that you can connect to. Each network name is 
displayed as a radio button and specifies whether it is secure or not. Use 
the arrow keys to navigate to the network you want to connect to and 
press ENTER to select it, and then press F1 to move to the next screen 
where you select the connection type. 

After you select the connection type, if the network is not secured, you 
are simply returned to the Today screen with the connection established. 
Otherwise, a dialog box is displayed that asks for a network key. It is 
necessary to enter forms mode to enter the key if you are connecting to 
an encrypted network. Use the arrow keys to move through the dialog 
box until you reach the edit field and press ENTER. This will activate 
forms mode and allow you to enter the key. Next, press F1 again to 
connect. You will be returned to the Today screen. 
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At this point, the status of your wireless connection is displayed on the 
Today screen directly between the date and owner information. If it says 
“Wi-Fi: Network Name,” then you have successfully connected to the 
router and you can begin accessing the network or Internet. If it says 
“Available,” then the router is in range, but you must now modify the 
configuration in order to actually connect to the router. This is done 
through the Wireless Manager. 

1. Open the Start Menu and choose Settings and press ENTER. 

2. Press CTRL+TAB to move to the Connections tab, use the 
arrow keys to select Wireless Manager, and press ENTER. 
Please note that the Wireless Manager only appears if a wireless 
card is inserted. 

Tip: You can also access the Wireless Manager directly from the Today 
screen by moving to and pressing ENTER on the Wi-Fi item. 

3. From the list view, which displays your current Wi-Fi status, 
press F2 to open the menu and press ENTER on Wi-Fi Settings. 

4. In the list of networks, press the DOWN ARROW Key to Move to 
the router that you want to connect to. You should see 
"Available" after the network name, unless a connection has 
already been established. Press ENTER to open the Wireless 
Network configuration wizard. 

5. In most cases, problems connecting are usually due to an 
incorrect network key or having the wrong authentication set. 
Press F2 to move to the next screen which is where you can 
configure these settings. 

6. Press TAB to move to the Authentication combo box and select 
the authentication mode required by the router such as WEP or 
WPA. You may need to contact the network administrator to 
obtain this information. You should also verify that you have the 
correct network key, TAB to the Network Key edit box and 
reenter it in case it was entered incorrectly when the network 
was first detected. 
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7. Press F2 twice to exit the wizard and you will be placed back into 
the list of available networks. 

8. Again highlight the connection and press the APPLICATIONS 
Key and choose Connect. At this point, your PAC Mate Omni 
should establish a connection to the router. To confirm this, use 
the arrow keys to select the connection and JAWS should report 
“Connected” if the configuration was successful. If you see 
“available,” the connection failed. If you see “Unavailable,” the 
wireless access point has moved out of range or is offline. Press 
the CLOSE button (ESC) twice to close the Wireless Manager. 

Setting Up Your E-mail Account 

Before you begin this procedure you will need the following information 
from your ISP.  

 Your e-mail address  

 Your user name  

 Your password  

 Service type: POP3 or IMAP4  

 Server Information: Incoming mail, Outgoing mail, Domain (optional) 

To create a POP3 or IMAP4 E-mail Service:  

1. Enter the Start Menu (WINDOWS Key), press ENTER on 
Messaging, and choose New Account. 

2. Enter the e-mail address provided by your ISP or network 
administrator, such as username@servername.com or 
username@servername.net. 

3. To allow Auto configuration to connect to the Internet, obtain e-
mail server settings (if possible) and enter this information for 
you, select the Try to get e-mail settings automatically from the 
Internet check box. 

mailto:username@servername.net
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Note:  When Auto configuration connects to the Internet, it will transmit 
your e-mail address and other information. To prevent Auto 
configuration from connecting to the Internet, clear the check box 
and enter the e-mail settings yourself. You may need to get e-mail 
server information from your service provider. Press F2 to move to 
the next screen. 

4. Auto configuration attempts to connect to your e-mail server and 
download the settings so that you do not need to enter them 
manually. If Auto configuration is successful, press F2 to move 
to the next screen. If Auto configuration is unsuccessful, contact 
your ISP or network administrator for the following information:  

 Server type 

 POP3 or IMAP4 server name 

 Domain name (for network connections only) 

Once you have the above information, continue with the E-mail 
Setup Wizard.  

5. Enter your name (the name you want displayed when you send 
e-mail), and the name of the account as it will appear in the list 
of e-mail accounts. 

6. If you chose not to use Auto Configuration, enter the name of the 
incoming mail server and whether it is a POP3 or IMAP4 server. 
Press F2 to go to the next screen. 

7. In the Username edit field, enter the user name assigned to you 
by your ISP or network administrator. This is often the same user 
name you use to sign into your ISP or network. This edit box is 
pre-populated with the information you entered in step 2 above. 
If the information is different, type in the correct information. 

8. In the Password edit field, enter your password and press 
SPACEBAR to check the Save password check box. Press F2 
to move to the next screen. 
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9. If you chose not to use Auto Configuration, enter the details of 
the outgoing mail server and Press F2. Activate the Advanced 
button to configure advanced server settings. 

10. Select the time interval that Messaging waits before downloading 
new messages, then review your account information, make any 
necessary changes, and press F2. 

Before you select Finish, you can press ENTER on Review all 
download settings to access additional options (see E-mail 
Settings Optional). For example:  

 Specify whether or not messages are deleted from the server.  

 Display messages from the last number of days you specify.  

 Change the size limit for downloaded messages or choose to 
download the entire message.  

When you are finished with the E-mail Setup Wizard, Messaging 
automatically attempts to download e-mail. If you are currently 
not connected to the Internet you can download your e-mails 
when you are connected by pressing F2 to open the menu and 
selecting Send/Receive. 

E-mail Settings (Optional) 

When you press ENTER on Review all download settings, the E-mail 
Setup Wizard adds some additional screens.  

The first two combo boxes let you specify the interval Messaging waits to 
send and receive messages automatically, and the age of messages that 
are downloaded. For example, the default is to perform a send/receive 
every two hours and to download messages from the last three days. You 
can also press ENTER on the Advanced button to specify whether 
Messaging leaves messages on the server or not when you delete them. 
The default is to delete them off the server. Press F2 to move to the next 
screen. 
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On the last screen, press TAB to move to the Message Download Limit 
and select the size limit for downloaded messages. The default is 2 KB. 
You can also choose to get headers only or the entire message. 

When using an IMAP4 connection this screen also lets you choose to 
download attachments. Press TAB to move to the Download Attachments 
combo box and choose the option you want. You can choose not to 
download attachments, select a size limit, or download all attachments. 

Press F2 to complete the E-mail Setup Wizard. 

Ending a Connection 

You can end a connection with the End Connection dialog box, which is 
accessible from any running application on the PAC Mate Omni. The 
command to open the End Connection dialog box is CTRL+SHIFT+M. 
Next, you must press TAB to move to Disconnect, ENTER, which 
activates the End link. Your PAC Mate Omni should disconnect within a 
few seconds.  

Note: The End Connection dialog box is a Microsoft bubble dialog box. 
Once activated, bubble dialog boxes automatically close in about 
seven seconds. So it is important that you press the commands 
successively when the PAC Mate Omni begins speaking the 
dialog box. 

Bluetooth 

Bluetooth is a short-range wireless communications technology. Devices 
with Bluetooth capabilities can beam (exchange information) over a 
distance of about 10 meters (30 feet) without requiring a physical 
connection. 

Unlike infrared, you don't need to line up the devices to beam information 
with Bluetooth. You can even beam information to a device in a different 
room, as long as it's within range. 

You can use Bluetooth as follows: 
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 Beam information, such as files, appointments, tasks, and contact 
cards, between your PAC Mate Omni and other devices that have 
Bluetooth capabilities.  

 Create a connection between your PAC Mate Omni and a Bluetooth-
enabled phone to use the phone as a modem.  

 Use a Bluetooth service. Once you connect to another device or 
computer using Bluetooth, you can locate and use any of the services 
available on that device.  

To add Bluetooth capabilities to your PAC Mate Omni, you need to 
purchase the Bluetooth hardware. The PAC Mate Omni contains pre-
installed drivers for the Bluetooth CompactFlash cards from Socket 
Mobile, which means you can insert this card into your PAC Mate Omni 
and immediately begin using it. The following instructions assume the use 
of this particular card. Once the card is inserted, the Bluetooth status is 
displayed on the Today screen between the date/time and owner 
information. "Off" indicates that Bluetooth is disabled, while "on" means 
that it is transmitting. To change Bluetooth settings, navigate to the status 
indicator, press ENTER to open the Wireless Manager, then press F2 
and choose Bluetooth Settings to open the Bluetooth settings multipage 
dialog box. Alternatively, you can press WINDOWS Key, S, press 
CTRL+TAB to move to the Connections page, and press ENTER on 
Bluetooth to access these settings. 

if you have a different Bluetooth card, you will need to install the 
appropriate driver onto your PAC Mate Omni. Check with the 
manufacturer of the hardware to determine if a driver is available for 
Windows Mobile 6.0.  

Do the following to turn Bluetooth on or off: 

1. From the Today screen, navigate to the Bluetooth status 
indicator, which displays "off" or "on" depending on the state, 
and press ENTER. When the Wireless Manager opens, press F2 
and choose Bluetooth Settings to open the Bluetooth settings 
multipage dialog box.  

2. Press CTRL+TAB to move to the Mode tab.<.  
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3. Use the SPACEBAR to select or clear the Turn on Bluetooth 
check box.  

4. If you want to make it possible for Other Bluetooth devices to 
detect your PAC Mate Omni and attempt to beam information to 
it or establish a partnership, press TAB to move to the Make this 
device visible to other devices check box and press the 
SPACEBAR to check it.  

5. Press the CLOSE button (ESC) to close the Bluetooth settings 
multipage dialog box and once more to close the Wireless 
Manager.  

Note: By default, Bluetooth is turned off. If you turn it on, then turn off 
your PAC Mate Omni, Bluetooth also turns off. When you turn on 
your PAC Mate Omni again, Bluetooth turns on automatically. 

Create a Bluetooth Partnership 

You can create a partnership between your PAC Mate Omni and another 
device that has Bluetooth capabilities. Once you do this, the two devices 
must have Bluetooth turned on but don't need to be visible for you to 
beam information between them. 

To create a Bluetooth partnership, do the following: 

1. Ensure that the PAC Mate Omni and the other device are turned 
on, visible, and within close range.  

2. From the Today screen, navigate to the Bluetooth status 
indicator and press ENTER. When the Wireless Manager opens, 
press F2 and choose Bluetooth Settings to open the Bluetooth 
settings multipage dialog box.  

3. From the Devices tab, press ENTER on Add new device. Your 
PAC Mate Omni searches for other devices with Bluetooth 
capabilities and displays them in a list view.  

4. If more than one bluetooth device is found, use the arrow keys to 
select the one you want, then press F2 to go to the next screen.  
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5. In the Passcode edit field, if you want to use a passcode 
(recommended for enhanced security), enter an alphanumeric 
passcode between 1 and 16 characters, and press F2 to go to 
the next screen. Otherwise, leave the passcode blank, and press 
F2. If you are setting up a partnership with a device such as a 
Bluetooth printer, you must enter a pre-determined passcode. 
For instance, you can try 0000 when attempting to connect to a 
printer, however, if this code does not work, refer to the 
documentation that came with the device for the correct 
passcode. 

6. If Prompted, enter the same passcode on the other device.  

7. In the Partnership Settings dialog box, you can change the name 
of the device that appears in the Display Name edit field if you 
would like to give the partnership a more meaningful name.  

8. Press TAB to move to the list of services and press the 
SPACEBAR to check the services you want to use if any are 
available. For example, if you want to print to a Bluetooth printer, 
you would check the Serial Port service. 

9. Press F2 to finish creating the partnership and return to the list of 
devices.  

10. Press the CLOSE button (ESC) to close the Bluetooth settings 
multipage dialog box and once more to close the Wireless 
Manager.  

If a Bluetooth device attempts to establish a partnership with your PAC 
Mate Omni, an HTML dialog box opens asking if you want to create a 
partnership with the device making the request. Activate the Yes button if 
you wish to create a partnership and if prompted, enter an alphanumeric 
passcode between 1 and 16 characters in the Passcode edit field, 
followed by F2 to go to the next screen. You must enter the same 
passcode that was entered on the device requesting the partnership. 
Using a passcode provides enhanced security. 

To give the partnership a more meaningful name, change the name of 
the device that appears in the Display Name edit field, then Press F2 to 
finish creating the partnership. 
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Configure an Outgoing COM Port 

In order to use a Bluetooth serial device, you must add an outgoing COM 
port. To configure an outgoing port, do the following: 

1. From the Today screen, navigate to the Bluetooth status 
indicator and press ENTER. When the Wireless Manager opens, 
press F2 and choose Bluetooth Settings to open the Bluetooth 
settings multipage dialog box.  

2. Press CTRL+TAB to move to the COM ports tab.  

3. Press ENTER on New Outgoing Port.  

4. In the Add a Device dialog box, choose the device you want from 
the list and press F2.  

5. In the Port dialog box, choose a COM port from the list and 
press F2 to finish adding the port. 

Note: If you want to print to a Bluetooth printer from FSEdit, you must add 
COM2 for the printer. This means you can only set up a 
partnership with one Bluetooth printer at a time.  

6. Press the CLOSE button (ESC) to close the Bluetooth settings 
multipage dialog box and once more to close the Wireless 
Manager. 

Delete a Bluetooth Partnership 

Do the following to delete a Bluetooth partnership from the PAC Mate 
Omni: 

1. From the Today screen, navigate to the Bluetooth status 
indicator and press ENTER. When the Wireless Manager opens, 
press F2 and choose Bluetooth Settings to open the Bluetooth 
settings multipage dialog box.  

2. From the list of partnerships, navigate to the partnership you 
want to delete and press the APPLICATIONS Key.  
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3. Move to Delete and press ENTER. Select the Yest button when 
asked if you are sure you want to delete the partnership.  

4. Press the CLOSE button (ESC) to close the Bluetooth settings 
multipage dialog box and once more to close the Wireless 
Manager.  

Beaming Information 

Using the infrared port or a Bluetooth card, your PAC Mate Omni is 
capable of beaming information to other devices including PDA's, 
printers, desktop or laptop computers, and phones that have an infrared 
port, or support the obex Bluetooth service. 

To beam using infrared, align the IR ports so that they are unobstructed 
and within close range. To beam using Bluetooth, make sure you are 
within 30 feet (10 meters) of the receiving device and the device is visible 
so the PAC Mate Omni can detect it. 

Go into the program's list view, use the DOWN ARROW to select an item 
or if you want to select multiple items, press SHIFT+DOWN ARROW and 
then press the APPLICATIONS Key. On the Context menu, select 
Beam… and press ENTER. If you are using infrared and the ports are 
aligned, the transmission begins automatically. Otherwise, press TAB to 
move to the list of devices, use the arrow keys to locate the device you 
want to beam to, and press ENTER. 

Tip: You can beam an FSEdit file to another PAC Mate Omni using the 
Beam Feature in File Explorer.  

If you are unable to beam information, try the following:  

 Transfer only one file, or no more than 25 contact cards, at a time. 

 When using IR, make sure nothing is between the two IR ports.  

 Adjust the room lighting or move to another location (some types of 
light interfere with beaming).  
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 When using Bluetooth, make sure your Bluetooth card is inserted into 
the PAC Mate Omni, and the device you are attempting to send to is 
visible. 

Receiving a Beam on the PAC Mate Omni 

Your PAC Mate Omni is set to automatically receive all incoming beams. 
When receiving data, an HTML dialog box opens asking you if you want 
to save the item. Press F1 to save the item to the PAC Mate Omni or F2 
to not save the item. 

If you receive multiple items, the HTML dialog box which asks if you want 
to save the item will contain Yes and No buttons. To save or discard the 
items one at a time, navigate to the Yes or No button and press ENTER. 
To save all of the items at once, press F1, or press F2 to discard all of the 
items. 

If you are unable to receive a beam from another device, do the following: 

1. Press WINDOWS Key, S to open the Settings dialog box. 

2. Press CTRL+TAB to move to the Connections page. 

3. Press B for Beam and ENTER to open this dialog box. 

4. Press the SPACEBAR to check the Receive All Incoming Beams 
check box. 

If receiving a beam over Bluetooth, make sure your Bluetooth card is 
inserted in the PAC Mate Omni, Bluetooth is turned on, and your PAC 
Mate Omni is visible. 

Deactivating the Infrared Port 

The infrared port is active by default. In certain situations or if you are not 
using the port you may want to consider deactivating it as its activation 
uses up battery life. 

1. Press the WINDOWS Key to go to the Start Menu. 
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2. Press S to select Settings. 

3. Press CTRL+TAB to move to the Connections page. 

4. Move to Beam and then press ENTER. 

5. Press SPACEBAR to clear the "Receive all incoming beams" 
check box.  
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Using PAC Mate Omni Programs 

This section offers a brief introduction to all of the PAC Mate Omni's 
programs discussing the key features in each. To read comprehensive 
help about each program, open the program and then open Help in the 
Start Menu. In addition, you can get specific help instructions on a 
particular dialog box when you open Help from within that dialog box. 
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ActiveSync Remote PAC Mate 

Note to Users 

It is strongly recommended that you not use ActiveSync Remote PAC 
Mate with any version of JAWS earlier than 6.20. Version 6.20 is a free 
update for authorized JAWS 6.0 users and it contains many code fixes 
that are specific to this feature. You can download JAWS 6.20 from 
Freedom Scientific's JAWS for Windows Headquarters page at 
http://www.freedomscientific.com/fs_products/JAWS_HQ.asp.  

If you have upgraded from a previous version of the PAC Mate Omni, 
please note that ActiveSync Remote PAC Mate will not work over WiFi as 
Microsoft has removed the ability to synchronize over a wireless local 
area network in ActiveSync 4.5. See below for a list of connection types 
supported by ActiveSync Remote PAC Mate. 

What Is ActiveSync Remote PAC Mate? 

ActiveSync Remote PAC Mate is a program that allows you to establish a 
connection between your PAC Mate Omni and a computer with JAWS 
installed. You can connect your PAC Mate Omni and computer using a 
USB cable, network connection, modem, or Bluetooth. Once you 
establish a connection, you can run programs, read documents and Web 
pages, and work with files and folders on your computer using only your 
PAC Mate Omni. Commands that you issue and text that you type are 
sent to your computer, and you receive speech and braille feedback on 
the PAC Mate Omni. 

Getting Started 

To use ActiveSync Remote PAC Mate, install JAWS 6.20 or later on the 
computer you want to connect to. During the installation process, 
required JAWS remote access server components will be installed 
automatically. 
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Establishing a Remote Connection 

After you have installed and activated JAWS on the computer, you can 
begin using ActiveSync Remote PAC Mate. Establish an ActiveSync 
standard or guest connection between your PAC Mate Omni and your 
computer. Information on using ActiveSync can be found in your PAC 
Mate Omni Owner's Manual. You can use the supplied USB cable, a 
network connection, modem, or Bluetooth. For information on the 
different ways you can connect your PAC Mate Omni to your computer, 
refer to your PAC Mate Omni Owner's Manual. 

After you connect your PAC Mate Omni and computer, do the following: 

1. On your computer, open the Start menu and choose Programs 
or All Programs. Open the JAWS program group, Tools, PAC 
Mate Desktop. ActiveSync Remote PAC Mate starts and an icon 
appears in your Windows system tray. 

Tip: If you want ActiveSync Remote PAC Mate to start automatically 
when JAWS starts, open the Options menu and choose Basics. 
Locate the Automatically Start PAC Mate Omni Desktop check 
box and press the SPACEBAR to select it. 

2. On your PAC Mate Omni, press INSERT+SHIFT+F4. You hear, 
"PAC Mate Omni remote mode on.” 

3. After Remote JAWS starts on the computer, you can issue 
commands, read documents and Web pages, and work with files 
and folders on your computer through your PAC Mate Omni.  

4. You can press INSERT+SHIFT+F4 to toggle between using the 
PAC Mate Omni and the remote computer. This lets you work 
with your PAC Mate Omni without disconnecting from the remote 
computer. 

5. To stop working in remote mode, press INSERT+F4 ON THE 
PAC MATE OMNI. You hear, "Do you really want to quit JAWS? 
Press Enter to quit now and the PAC Mate Omni returns to its 
normal mode of operation. To resume use of your computer, you 
will have to reload JAWS. 
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Note: If you are using JAWS 6.2, 7.0, or 7.1, there is a known problem 
when the RIGHT SHIFT Key is pressed in combination with the 
TAB Key. To resolve this issue, update to version 8.0. Otherwise, 
when you need to press the SHIFT+TAB combination, be sure to 
use the LEFT SHIFT Key. 
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Multiple Voice Languages 

The PAC Mate Omni supports multiple voice languages by means of 
language modules that you can install when connected to your computer 
using ActiveSync. You can install as many languages as you wish 
assuming you have enough memory available. However, you can only 
have one selected as your secondary language. Switching between the 
primary and secondary languages is easily accomplished by pressing 
INSERT+S, L. In addition, the following keystrokes are available: 

 Use INSERT+ENTER, C to hear which language is currently in use.  

 Use INSERT+ENTER, P to hear which language is configured as the 
primary language.  

 Use INSERT+ENTER, S to hear which language is configured as the 
secondary language. 

Language modules can be downloaded free of charge from the Freedom 
Scientific Web site. Note that installation of these modules does not result 
in changes to the installed braille translation tables or to the keyboard 
layout. These modules cause the PAC Mate Omni to speak in a different 
language. 

To install a language module:  

1. Ensure that you have your PAC Mate Omni connected by means 
of an ActiveSync session. This can be either a standard or guest 
connection.  

2. Locate the language module file that you downloaded from the 
Freedom Scientific Web site and press ENTER. This will begin 
the installation process. Follow the prompts.  

3. After installation has completed, perform a warm reset on your 
PAC Mate Omni. Please see Performing a Warm Reset for 
details if you're not sure how to do this.  
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For information on setting the voice parameters for installed languages 
and for determining the language that is spoken when you press 
INSERT+S, L, please see Adjusting Speech Settings for details. 
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RealSpeak Solo Voices 

The PAC Mate Omni supports the RealSpeak™ Solo voices from 
Nuance® Communications. Voices can be downloaded from the 
Freedom Scientific Web site and are available in a variety of languages. 
Voices can be installed directly into main memory or on a CompactFlash 
card. You can install as many voices as you wish assuming you have 
enough memory available. As each voice requires several megabytes of 
space, it is recommended that you install each voice onto a 
CompactFlash card to ensure you have enough room in main memory for 
other tasks. 

You can only configure RealSpeak as a secondary voice. Eloquence is 
always used as the primary voice. While you can have as many 
RealSpeak voices installed as you want, you can only have one selected 
as your secondary voice. Switching between the primary and secondary 
voices is easily accomplished by pressing INSERT+S, L. In addition, the 
following keystrokes are available: 

 Use INSERT+ENTER, C to hear which language is currently in use.  

 Use INSERT+ENTER, P to hear which language is configured as the 
primary language.  

 Use INSERT+ENTER, S to hear which language is configured as the 
secondary language.  

RealSpeak voices can be downloaded free of charge from the Freedom 
Scientific Web site. Note that installing any voices other than English 
does not result in changes to the installed braille translation tables or to 
the keyboard layout. The voice language will cause the PAC Mate Omni 
to speak in a different language. 

You can install a RealSpeak voice on your PAC Mate Omni either 
through your computer using ActiveSync or Windows Mobile Device 
center, or by copying a CAB file to the PAC Mate and running the 
installation directly on the device. 

To install a voice using ActiveSync, do the following: 
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1. From the Web page, locate the voice you want and choose the 
link to download the EXE file.  

2. Ensure that you have your PAC Mate Omni connected by means 
of an ActiveSync session. This can be either a standard or guest 
connection.  

3. Locate the file that you downloaded from the Freedom Scientific 
Web site and press ENTER. This will begin the installation 
process. Follow the prompts. 

4. After installation has completed, press ENTER on your PAC 
Mate Omni when prompted to perform a warm reset.  

To install a voice using the CAB file, do the following: 

1. From the Web page, locate the voice you want and choose the 
link to download the CAB file.  

2. Transfer the CAB file to a location on your PAC Mate Omni. You 
can run the file from main memory or a CompactFlash card.  

3. Use File Explorer to locate the CAB file and press ENTER to 
begin the installation, then follow the prompts.  

4. Once the installation completes, press ENTER when prompted 
to perform a warm reset.  

For information on setting the voice parameters for installed voices and 
for determining the language that is spoken when you press INSERT+S, 
L, please see Adjusting Speech Settings for details. 
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Multiple Braille Languages 

You can configure the PAC Mate Omni for a primary and secondary 
braille language. You can also configure braille translation settings 
independently for each language. For example, your primary language 
could be set to English with contracted input enabled while the secondary 
language could be set to Spanish using computer braille. Switching 
between primary and secondary languages is easily accomplished by 
pressing INSERT+S, T. In addition, the following keystrokes are 
available: 

 Use INSERT+Enter, C to hear which language is currently in use.  

 Use INSERT+Enter, P to hear which language is configured as the 
primary language.  

 Use INSERT+Enter, S to hear which language is configured as the 
secondary language. 

To configure braille languages, do the following:  

1. From the Today screen, press WINDOWS Key, S to open the 
Settings dialog box.  

2. Use the arrow keys to move to Braille Settings and press 
ENTER.  

3. Press CONTROL+TAB to move to the Languages tab. 

4. Press TAB to move to the Primary Language combo box. Use 
the arrow keys to select a language.  

5. Press TAB to move to the Secondary Language combo box, and 
use the arrow keys to select a language.  

6. Press the CLOSE button (ESC) to save and close the Braille 
Settings dialog box.  
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For information on setting the braille parameters and for determining the 
language that is used when you press INSERT+S, T, please see Braille 
Settings for details. 
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Braille Study Mode 

Braille Study Mode is designed to assist in the teaching and learning of 
uncontracted and contracted braille. It announces the braille character at 
the cursor position or speaks and spells the word. 

Braille Study Mode can be used from anywhere in the PAC Mate Omni. 
This allows you to learn braille no matter what application you are in. For 
instance, you can use Braille Study mode while reading documents in 
FSEdit or Word Mobile, from the Today screen, when changing options in 
a dialog box, or while surfing the Web in Internet Explorer Mobile. 

To use Braille Study Mode, do the following: 

1. Ensure that your PAC Mate Portable Braille Display is connected 
to your PAC Mate Omni.  

2. Press INSERT+S, B to turn on Braille Study Mode.  

3. Use the arrow keys to move the cursor to any braille contraction.  

4. Press the cursor routing button located directly above the braille 
contraction. The cursor routing buttons are the row of buttons 
directly above the braille cells on the display. The PAC Mate 
Omni will announce the contraction.  

5. Press the hot key button immediately above the cursor routing 
button you just pressed. The hot key buttons are the row of 
buttons located immediately behind the cursor routing buttons. 
The PAC Mate Omni will first pronounce the word of which the 
contraction is a part and will then spell the word. When spelled, 
the contraction is not indicated; that is, the word is spelled 
character by character. 
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Reader Mode 

Reader mode provides access to unsupported applications that display 
text in a read-only window. Some examples of such applications include 
PDF viewers, eBook readers, text adventure game interpreters, telnet 
clients - essentially any application that contains a reading area that can 
be scrolled or updates with new text when a command is typed. An 
unsupported application is one where you must frequently use the JAWS 
cursor in order to navigate an read text in various screens as well as 
activate controls. It does not mean that the program is completely 
inaccessible. 

Reader mode consists of three settings, Off, On, and On with Auto Top of 
Screen. Press INSERT+SHIFT+R to cycle between the three settings. 
The default setting is on. If you choose to turn it off, or use On with Auto 
Top of Screen, performing a warm reset will set Reader mode back to on. 

When you open an unsupported application that contains a reading area 
and Reader mode is enabled, the Reader cursor is automatically 
activated. You can verify if the Virtual PC cursor or the Reader cursor is 
active by pressing INSERT+SEMICOLON or ALT+DELETE. If you hear 
"Reader cursor," then you are in the reading area of the unsupported 
application. Otherwise, if you hear "Virtual PC cursor," or "Pocket PC 
cursor," you are either not positioned in the reading area of the 
application, you are in a PAC Mate Omni supported program, or Reader 
mode is currently set to Off and you need to press INSERT+SHIFT+R to 
enable it. 
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The Reader cursor allows you to use standard reading commands to 
read the text in the viewing area. If the application accepts input, such as 
a telnet client, you can type a command, press ENTER, and then use the 
arrow keys to read the new text that is displayed. Additionally, you can 
use INSERT+8 or the cursor routers on your braille display to activate 
specific items on the screen, such as an entry in a table of contents. Use 
CTRL+HOME or CTRL+END to move to the top or bottom of the current 
screen. For reading areas that require you to scroll the screen in order to 
access additional text, the commands to do this depend on the 
application being used. In some programs, you can use PAGE DOWN or 
PAGE UP to scroll the text down or up respectively, while in others, you 
will need to use the D-pad simulation keys, down (ALT+INSERT+DOWN 
ARROW), up (ALT+INSERT+UP ARROW), next (ALT+RIGHT ARROW), 
or back (ALT+LEFT ARROW) to scroll the text. Moving out of the reading 
area causes the Virtual PC cursor to become active again. 

Use the On with Auto Top of Screen setting if you are reading a 
document in a PDF viewer, an eBook reading application, or any 
application where the reading area contains several screens of text which 
require you to scroll the window. If this setting is enabled, after you press 
one of the D-pad simulation keys, or PAGE UP or PAGE DOWN (if 
available), once the text finishes scrolling, the Reader cursor is 
automatically positioned at the top of the current screen so you can 
immediately continue reading without having to locate the beginning of 
the text. 

Important note: While Reader mode improves access to applications not 
directly supported by the PAC Mate Omni, which means that 
eBook reading programs are now more useable, it does not mean 
that the particular application is fully supported. For instance, in 
certain applications that contain non-standard Windows controls, 
you may still need to use the JAWS cursor to navigate and 
activate controls in dialog boxes or other non-standard screens. 
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File Explorer 

Using File Explorer 

Just like Windows Explorer on a PC, File Explorer gives you access to all 
the files on your PAC Mate Omni. To open File Explorer, press 
WINDOWS Key, P to open the Programs submenu. Then press F to 
move to File Explorer and press ENTER. 

When you first launch File Explorer, you hear "My Documents list view, 
Business folder, one of six." The phrase, "My Documents list view," 
means that the My Documents folder is open listing all of its folders and 
files. The phrases, "Business folder, one of six," means that the Business 
folder is selected and it is one of the six subfolders in the My Documents 
folder. If you have added additional files or folders to My Documents, you 
will receive a different number. 

To view all the files and folders on your PAC Mate Omni, from the list 
view press ALT. Move to Show By and press ENTER. Then move to My 
Device and press ENTER again. 

To navigate among the folders and files, use these commands. 

In File Explorer, the menu (F2) contains: My Documents, Open Path, 
Send, Beam File, Refresh, Show All Files, New Folder, Rename, Delete, 
and Edit. To open a file or folder, select it from the list view and press 
ENTER. 

To quickly delete, rename, copy, or move a file or folder, select it from the 
list view by pressing the SPACEBAR and open the Context Menu with 
the APPLICATIONS Key and choose the action you want. To select 
multiple items, hold down the SHIFT key and use the arrow keys to 
select. You can also select non-contiguously by holding down CTRL 
while using the arrow keys and pressing SPACEBAR on the files you 
want to select. 

Here are some examples of how File Explorer can help you maintain and 
manage your files.  
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Moving or copying a file(s) to a CompactFlash® 
card: 

1. Select the file(s) you want to move. 

2. Open the context menu.  

3. Use the UP and DOWN ARROW keys to select Copy or Cut and 
press ENTER. Alternatively, instead of opening the context 
menu, you can simply press CTRL+C to copy or CTRL+X to cut. 

4. Next, press ALT, move to Show By, and select Storage Card.  

5. Navigate to the folder you want to store the files in and open it. 

6. Press F2 and select Edit, then Paste. Alternatively, instead of 
opening the Edit menu, you can simply press CTRL+V to paste. 

Sorting files by their type: 

1. From the list view, press ALT, DOWN ARROW to Sort by, and 
press ENTER. 

2. Use the UP and DOWN ARROW keys to select a Type and 
press ENTER.  

Creating a new folder: 

1. In File Explorer, decide where you want to create a new folder. 
You can create folders at every level except at My Device. 

2. Press F2, move to New Folder, and press ENTER. 

3. When you hear the prompt, "New Folder," type in a name for the 
folder and press ENTER to create it. 
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Network Log On 

Anytime you want to access a network device with your PAC Mate Omni, 
you must enter the network path and then log on with a username and 
password. In the following directions, a network embosser is used as the 
example. 

1. In File Explorer, press F2 and choose Open Path from the menu. 

2. In the Open Path submenu, select New Path. 

3. Type the path to your embosser and press ENTER. The PAC 
Mate Omni places the two backslashes at the beginning of the 
edit field for you. The path will look something like, 
\\servername\Braille_device. 

4. When done, TAB to OK and press ENTER. 

5. When prompted, press TAB to move through the fields and type 
the username and password required to log into the network 
resource where the embosser is located. You may also need to 
type your domain name if required. 

6. After filling in the required fields, pressing ENTER should 
connect you to the server (network resource) where the 
embosser is located. 

If you choose to save your password in File Explorer, you will not need to 
open File Explorer each time you want to emboss to a network embosser. 

Tip:  Once you have opened a network path for the first time, it is 
automatically saved to the Open Path submenu. The next time 
you want to open a previously used network path, press F2, select 
Open Path, and choose the network path you want from the 
submenu. 
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Messaging 

In other versions of Windows, Outlook opens as a single program with 
links to sub-programs that appear on the Folders List. On the PAC Mate 
Omni, these programs appear as separate programs in the Start and 
Programs Menu and include: Messaging, Contacts, Tasks, Calendar, and 
Notes. 

You can send and receive e-mail using any of the following methods: 

 ActiveSync 

 Post Office Protocol 3 (POP 3) 

 Internet Message Access Protocol 4 (IMAP4)  

For POP 3 and IMAP 4 you will need to set up an e-mail account. For 
more information about setting up an e-mail account, see Connecting the 
PAC Mate Omni, Setting Up an E-Mail Account. 

To view a table of commands that can be used in Messaging, please see 
Appendix A: PAC Mate Omni Commands.  

Downloading E-mail Messages  

If you have more than one account established, use the LEFT and 
RIGHT ARROW keys to move between accounts. 

To download your e-mail messages, press F2 move to Send/Receive and 
press ENTER. The messages on your PAC Mate Omni and mail server 
are synchronized. This means that new messages are downloaded to the 
PAC Mate Omni Inbox folder, while messages in the PAC Mate Omni 
Outbox folder are sent. Also, if you specified that messages be deleted 
from the server in the options for your currently selected account, 
messages you have deleted from your PAC Mate Omni are removed 
from the server. Any messages that have been deleted from the server 
will be deleted from the PAC Mate Omni Inbox. 
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Reading E-Mail 

If you have more than one e-mail account set up, messages for each 
account are stored in separate folders. The names of the folders 
correspond to the names of the e-mail account. 

To open a message, press ENTER on a message in the message list. 
When the message opens, you are placed in the message body and the 
PAC Mate Omni begins reading automatically. Use the arrow keys to 
read the contents of the message. Use CTRL+TAB to move between the 
message body and the header information. 

If you chose to only download message headers when you set up the 
account and you decide you want the full copy of a particular message, 
you will need to get the full copy. Press F2, and then press ENTER on 
Download Message. You can do this while the message is open, or from 
the message list with the current message selected. You will then need to 
perform a Send/Receive again to download the full message. This will 
also download message attachments if you selected those options when 
you set up the mail account. You can also choose to download full copies 
of messages by default. 

Composing and Sending a Message 

1. In the e-mail message list, press F2, N to open a new blank 
message.  

2. Enter the e-mail addresses separating them with a semicolon. 

3. Press TAB and SHIFT+TAB to move about the Header area.  

4. Press TAB to enter the message area. Type in your message.  

5. To check spelling, press F2 and select Spell Check. The spell 
checker in Messaging is very similar to the spell checker in Word 
Mobile. Refer to Checking Spelling in the section on using Word 
Mobile for more information. 
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6. When you are finished, Press F1 to Send. By default, your 
message is automatically sent and new e-mail is downloaded 
when you press F1. However, when setting up your account, you 
can specify that a Send/Receive is not performed when you 
send the message. If you select this option, messages you send 
are saved to the Outbox folder until you manually perform a 
Send/Receive. In addition, if you are working offline, your 
message is saved in the Outbox folder until you connect. 

Replying or Forwarding a Message 

Open the message, press the APPLICATIONS Key then move to and 
press ENTER on the action you want to perform (Reply, Reply All, or 
Forward).  

In the message area, type your response. 

When you are done, press F1 to Send. 

Note:  Selections in the Message page found under the Tools Menu in 
Options determine whether the original text is included. 

To see header information, press SHIFT+TAB. Press TAB to move back 
to the message body. 

Attaching a File to an E-mail Message 

With the message open, press F2, move to Insert, and press ENTER. In 
the Insert menu, press ENTER on File. Then, select the file you want to 
attach. OLE objects cannot be attached to Inbox messages. 

Receiving Attachments 

If your e-mail is set to get message headers only, then before you can 
recognize that an e-mail has an attachment, you must download the 
whole e-mail message. To do this from an open message, press F2, 
move to Download Message, and press ENTER. 
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If you receive messages through synchronization, in ActiveSync on your 
PC, go to Tools (ALT+T) and press ENTER on Options. Select E-mail 
from the list of synchronization types, then press TAB to move to the 
Settings button, and press SPACEBAR. In the Mail Synchronization 
dialog box, press TAB to move to the "Include File Attachments check 
box" and press SPACEBAR to check it.  

If you receive messages through a remote mail server using the IMAP4 
or POP3 mail protocol, you will need to configure your e-mail service to 
download attachments. To do this, press F2, T to open the Tools Menu. 
From this menu, select Options and press ENTER. In the Options dialog 
box, press DOWN ARROW to select the service whose settings you want 
to change and press ENTER. This opens the E-mail Setup Wizard. Move 
forward through the Wizard until you reach the Server Information page. 
On this page, press TAB to move to the Options button and press 
SPACEBAR.  

Note:  Embedded images and OLE objects cannot be received as 
attachments. 

An embedded message can be viewed as an attachment when using 
IMAP4 to receive e-mail. However, this feature does not work if Transport 
Neutral Encapsulation Format (TNEF) is enabled so that you can receive 
meeting requests. 

Receiving Meeting Requests 

If you receive your e-mail messages through ActiveSync, you will 
automatically receive meeting requests. If you connect directly to a mail 
server, the server must be running Microsoft Exchange Server 2000 or 
later in order for you to receive meeting requests. If you are running 
Microsoft Exchange Server, you will automatically receive meeting 
requests in your Inbox.  
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Opening a Meeting Request 

Meeting requests that you synchronize with ActiveSync appear on the 
Today Screen as an appointment. Use the arrow keys to move to 
Appointments and press ENTER. If you want, you can include a written 
message with your response. The response will be sent the next time that 
you synchronize or connect to your mail server, and your PAC Mate 
Omni Calendar will be updated.  

Printing Messages 

You can print messages from Inbox if you download and install the 
PrintBoy utility. For more information on PrintBoy, visit 
http://www.bachmannsoftware.com. 

Moving Messages 

In the message list, select the message and press the APPLICATIONS 
Key. To select multiple messages, press SHIFT+DOWN ARROW. Then, 
press the APPLICATIONS Key on the selected messages.  

On the menu, select Move and then select the folder where you want to 
move the messages.  

Caution: When you move a message that you have received through 
POP3 or synchronization to a folder you created on your PAC 
Mate Omni, the copy of the message on the server is deleted the 
next time you connect. This prevents duplicate copies of 
messages. Although the complete message is moved, message 
attachments will be deleted if you have not selected the option to 
download attachments. Once the message is moved, you will be 
able to access the message only from your PAC Mate Omni. 
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Deleting Messages  

To delete a message in the message list, select the message. To select 
multiple messages, press SHIFT+DOWN ARROW. Press DELETE and 
the messages are moved to the Deleted Items folder and deleted 
according to the option that you have selected in the Message tab of the 
Options dialog box. Press F2, T to open the Tools Menu. Move to 
Options and press ENTER. Press CTRL+TAB to move to the Message 
page.  

Note: If you are working offline, messages that have been deleted from 
the server will be deleted from the PAC Mate Omni the next time 
you connect or according to the options you have selected. 

To permanently delete messages in the Deleted Items folder, press F2, T 
to open the Tools Menu. Move to Empty Deleted Items and press 
ENTER. 

Clearing Messages and Folders 

When receiving e-mail messages from a POP3 or IMAP4 server, select 
the account on the PAC Mate Omni containing the folders and messages 
you want to clear, and then press F2, T to open the Tools menu. Move to 
Clear “account name” and press ENTER. All messages and folders that 
are linked to the selected account are cleared, and memory space is 
expanded on the PAC Mate Omni without deleting messages on the 
server. The next time you connect, the messages and folders are 
downloaded again.  

You cannot clear messages and folders from the Outlook E-mail account.  

Changing Message Options 

In the message list, press F2, T to open the Tools Menu. Move to Options 
and press ENTER. Press CTRL+TAB to move to the Message page.  

To place a copy of the original message beneath your response, press 
the SPACEBAR to check "When replying, include body" check box.  
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By default, e-mail messages you send are not saved on your PAC Mate 
Omni. This helps conserve memory space. If you want to keep copies of 
sent e-mail messages, press the SPACEBAR to check "Keep copy of 
sent mail in Sent folder" check box.  

Changing Storage Options 

In the message list, press F2, T to open the Tools menu. Move to Options 
and press ENTER. Press CTRL+TAB to move to the Storage page.  

To store attachments on a storage card rather than main memory, press 
the SPACEBAR to check the " When available, use this storage card to 
store attachments" check box. All attachments will move to the selected 
card.  
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Contacts 

Maintain a list of your family, friends, and colleagues so you can easily 
find the information and stay in touch, regardless of where you are. You 
can enter both personal and business information.  

Creating or Editing a Contact 

To create a contact, press F1. When the Contact details page initially 
opens, the Name expand field is active. Type in the name of your contact 
and press ENTER to move out of the edit field or if you want to add a title, 
middle name or suffix, press ALT+F to expand the field. Press DOWN 
ARROW to move to the next item in the expand field. To close an expand 
field, press the CLOSE button (ESC). 

Press DOWN ARROW to move to the next edit field. Press ENTER to 
move into the field and type in the information. Press ENTER again to 
move out of the field and press DOWN ARROW again to move to the 
next field. You enter information about a contact by using this command 
sequence of ENTER and DOWN ARROW.  

When you move to the "Birthday" and "Anniversary" items, press ENTER 
and use the arrow keys to move between month, day, and year. As you 
move to each part of the date, type in the new month, day and year. You 
can also press ALT+DOWN ARROW to open the Date Selector where 
you use the Date Selector commands to select a date. When finished, 
press ENTER to return to the list of fields. 

Note: If you are using a braille display and you select the Street edit field 
in any of the Address expand fields, the display will initially be 
blank as this is a multi-line edit field where you can enter address 
information. 

To add additional information about your contact, like when is it 
appropriate to call etc., press CTRL+TAB to move to the Notes page. 
When finished, press the CLOSE button (ESC) to return to the contact list 
view.  

To edit contact information, you have two options: 
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 Select the contact in the Contacts list view and press ENTER. A 
Summary page opens displaying a list of only the fields used in the 
selected contact. For example, in the selected contact, you may have 
only included the name, home address, and home telephone. Use the 
arrow keys to locate the information you want to edit, such as the 
phone number, and press F1. Edit the item then press ENTER to 
return to the contact details page. At this point you can add additional 
information to the contact if necessary. When done, press the CLOSE 
button (ESC) to return to the Contacts list view. 

 Select the contact in the Contacts list view, press F2 to open the 
menu, and choose Edit. You are placed in the Name edit field which 
contains the name of the selected contact. Follow the steps above to 
modify the contact then press the CLOSE button (ESC) to return to the 
Contacts list view. 

New contacts are added to the category that is currently displayed. 

E-mailing a Contact 

In the contact list, select the contact and press the APPLICATIONS Key. 
On the menu, press ENTER on Send E-mail.  

Finding a Contact 

There are several ways to find a contact:  

 Use the Search Feature in the Programs Menu. 

 In the contact list, press F2 and select Filter. Select the type of contact 
that you want displayed. To show all contacts again, select All 
Contacts. To view a contact not assigned to a category, select No 
Categories. 

 Press TAB to move to the Contacts filter edit box and begin typing 
the contact name. As you type, the PAC Mate Omni will speak the 
first contact name that matches the letters you have entered. Press 
TAB to move back to the Contacts list view and only the contacts 
that match what you typed are displayed. To display all of your 
contacts again, press BACKSPACE until the first contact is 
displayed. 
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  To view the names of companies your contacts work for, in the 
contact list, press ALT and select View, then select By Company. The 
number of contacts that work for that company will be displayed to the 
right of the company name.  

Tip: In the Search dialog box, you can select from a list of contacts that 
you already looked for in the Search edit combo box. Use the 
arrow keys to open the list. 

Changing Contacts Options 

In the contact list view, press F2, choose Options, and press ENTER.  

 Select the Show Contact Names Only check box to have only the 
names of your contacts displayed in the list view.  

 In the Area Code edit field, enter the area code you would like to have 
automatically entered when specifying a phone number for a contact.  

The PAC Mate Omni does not directly support the Show Alphabetical 
Index check box. However, this feature can be accessed to some extent 
using the JAWS Cursor. When this check box is checked, the letters of 
the alphabet are displayed in groups of three near the top of the screen 
directly above the first listed contact. Navigate to a letter group with the 
JAWS cursor and if you are using a braille display, press a cursor router 
on that group. Otherwise, use the LEFT and RIGHT ARROW keys to 
navigate to one of the groups and press INSERT+8 to perform a Left 
Mouse Click. When you select one of these letter groups, you are placed 
in the list of contacts whose names begin with the selected letter. 
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Tasks 

You can use Tasks to help you organize and set your day’s schedule. 
You can create a list of things to do and prioritize them by their 
importance. Any task that needs to be accomplished today is displayed 
on the Today screen.  

To help you stay on task, ActiveSync automatically synchronizes your 
tasks between your PAC Mate Omni and PC.  

Creating a Task  

To create a task, press F2 and press ENTER on New Task. The Task 
details page initially opens with the Subject edit combo box active. You 
can type in the subject of your task or use the arrow keys to choose one 
of the items in the combo box. When you are done press ENTER to move 
out of the edit combo box. Next, press the DOWN ARROW to move to 
the next edit field. Press ENTER again, but this time to move into the edit 
field. When you are done, press ENTER again to move out of the field 
and press DOWN ARROW to move to the next field. You enter 
information about a task by using this command sequence of ENTER and 
DOWN ARROW.  

When you move to the "Start" and "Due" items, press ENTER to open the 
Date Selector. For more information on the commands associated with 
the Date Selector, please see Calendar, Using the Date Selector. 

To add additional information about your task, press CTRL+TAB to move 
to the Notes page. When finished, press the CLOSE button (ESC) to 
return to the task list view. 

Note: New tasks are added to the category that is currently selected. 

If you find that creating a detailed task is too time consuming, you can 
quickly create a task by using the entry bar. The entry bar is located at 
the top of your task list and lets you quickly enter a one-sentence task. 
Press TAB until you enter the field and type in your task. When you are 
done press ENTER to add the new task to the list view.  
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Editing a Task 

To edit a task, select it in the Task list view and press ENTER. Use the 
arrow keys to move through the dialog box. Press ENTER to edit an item. 
When you have finished, press ENTER to return to the task page. Once 
you have made the necessary changes to the task, press the CLOSE 
button (ESC) to return to the task list view. 

Tip: You can easily edit a task from the Today Screen by using the arrow 
keys to move to Task and press ENTER. When the Task details 
page opens, edit your information. 

Setting a Reminder for a Task 

1. From the task list, press ENTER on the selected task to open it.  

2. Press DOWN ARROW to move to the Due box and press 
ENTER. To set a due date, use the Date Selector Commands.  

3. Press ENTER again and use the DOWN ARROW to move to the 
Reminder combo box. Press ENTER and select Remind me. 
You will be reminded at 8:00 in the morning on the due date.  

4. Press ENTER again and change the reminder date by pressing 
ALT+D and changing the date. 

Note: To be automatically reminded of new tasks with a due date, in the 
task list view, press F2, move to Options and press ENTER. Use 
the SPACEBAR to check the "Set reminders for new items" check 
box. 

To choose how you are reminded, for example by a sound, go to the 
Start Menu (WINDOWS Key) and select Settings. On the Personal page, 
use the arrow keys to move to Sounds & Notifications and press ENTER. 
Adjust each control to your preference.  

Adding a Note to a Task 

You can add notes to a task.  
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1. In the task list, select the task and Press ENTER to open it.  

2. Press CTRL+TAB to move to the Notes page.  

3. Type in the additional information you want to include for that 
particular task. 

4. When finished, press the CLOSE button (ESC) to return to the 
task list view. 

Later, when you open your task, the additional information is available for 
you to read.  

Making a Task Recurring 

1. From the task list, select the task and press ENTER to open it.  

2. Press DOWN ARROW to move to the Occurs edit combo box 
and press ENTER. Select a pattern from the list or create a new 
pattern by choosing Edit pattern from the list. 

To create a new occurrence pattern: 

1. In the Occurs combo box, press ENTER on Edit pattern.  

2. On the first screen of the wizard, press TAB to move to the Start 
and Due date fields and change the dates as needed. Use LEFT 
and RIGHT ARROW to move between the week day, month, 
date, and year columns and use UP and DOWN ARROW to 
increase or decrease the values. You can also type in a value or 
press ALT+DOWN ARROW to open the Date Selector where 
you can select the date you want. Additionally, use the Duration 
Edit combo box to specify the length of time between the start 
and due dates. Changing this value will automatically change the 
date in the Due date field.  

3. Press ENTER on the Next button to move to the next screen.  

4. In the Select type of occurrence field, choose whether this task 
happens daily, weekly, monthly, or yearly, and then press TAB 
to move to the next control. If you use braille, note that when you 
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navigate between the options in this field, the braille highlight 
(enabled by default) is used to indicate the selected item instead 
of the cursor. You must ignore the location of the cursor when 
navigating in this field. If you have turned off the Highlight option 
in the Braille Settings dialog box, pressing INSERT+UP ARROW 
(the Say Line command) will read the currently selected item. 
You can also press the cursor router on the display associated 
with the particular option to select it.  

5. The remaining options you see on this screen depend on the 
type of occurrence you chose. Make the necessary selections 
then press ENTER on the Next button to move to the Next 
screen. If you are asked to select specific days of the week, such 
as Sunday or Monday, use the ARROW Keys to navigate 
through the days and press the SPACEBAR or ENTER to select 
the ones you want.  

6. Use the various controls on the last screen to specify when this 
pattern starts and ends. After making your selections, press 
ENTER on the Finish button to complete the wizard.  

Completing a Task 

As you navigate through the list of tasks, JAWS indicates active tasks as 
“not checked” and completed tasks as “checked.” To mark a task 
completed, in the task list view, press the SPACEBAR to check the box 
next to the selected task.  

Changing Tasks Options 

In the task list, press F2, move to Options and press ENTER.  

 To automatically be reminded when new tasks are due, select the Set 
reminders for new tasks check box.  

 To see the start and due dates for a task in the task list view, select 
Show start and due date.  

 To use the entry bar, select Show tasks entry bar. 
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Calendar 

Although very similar to Tasks, the Calendar is meant to help you with 
scheduling and keeping your appointments. The Calendar View, used for 
setting each appointment, lets you schedule for a day, a week, a month 
and a year. To remind you of your appointments, the PAC Mate Omni will 
play a sound and open a dialog box with your appointment information. 
You can choose to dismiss the appointment or be re-notified within a time 
interval that you can set. Appointments for the day can also be accessed 
on the Today screen. 

The Calendar is easy to use. You can access the Calendar from the 
Today Screen or directly from the Start Menu (WINDOWS Key), press C 
to move to Calendar and then press ENTER. Once you have opened 
Calendar you are in the Agenda list view, which lists the appointments 
you have created. If you have not created any appointments, you will 
hear "No Appointments." From the list view, you can preview your daily 
appointments for any particular day by pressing the LEFT or RIGHT 
ARROWS to view the appointments for the previous or next day.  

If you have scheduled any appointments as all day events, they are 
displayed in the All Day Events list view which is accessed by pressing 
TAB or SHIFT+TAB from the Agenda list view. Press TAB or 
SHIFT+TAB again to return to the Agenda list view. If there are no all day 
events scheduled, this list view is not available. However, if an all day 
event is scheduled for a particular day, you can move to the All Day 
Events list view from any day even though no all day events are 
scheduled for that particular day. In this case, the list will be empty. 

If you are in the Agenda list view and you move to a day that contains an 
all day event, you will be placed into the All Day list view. Similarly, if you 
are in the All Day Events list view and you move to a day that only has a 
regular timed appointment scheduled, you will be placed into the Agenda 
list view. Otherwise, you will remain in the currently open list view. 

Additionally, press ALT+S followed by a number 1 through 7 to jump to a 
specific day of the week. Appendix A lists all the commands for jumping 
to each day in the week. You must be in either the Agenda or All Day 
Event list view in order for these commands to work.  
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Creating or Editing an Appointment 

To create an appointment, press F2 and press ENTER on New 
Appointment. The appointment details page initially opens with the 
Subject edit combo box active. You can type in the subject of your 
appointment or use the arrow keys to use one of the items in the combo 
box. When you are done press ENTER to move out of the edit combo 
box. Next, press DOWN ARROW to move to the next edit field. Press 
ENTER again, but this time to move into the edit field. When you are 
done typing the appointment information, press ENTER again to move 
out of the field and press DOWN ARROW to move to the next field. You 
enter information about an appointment by using this command sequence 
of ENTER and DOWN ARROW.  

When you move to the "Start" and "End" items, press ALT+D to open the 
Date Selector. For more information on the commands associated with 
the Date Selector, please see Calendar, Using the Calendar View. 

To change the time in the "Start" and "End" items, press ENTER on the 
item and type in the new time or use the arrow keys to select a time. 

To add additional information about your appointment, press CTRL+TAB 
to move to the Notes page. When finished, press the CLOSE button 
(ESC) to return to the Agenda list view. 

Note: When entering a time, you can type military and abbreviated time 
forms, such as 2300 (becomes 11:00 PM), 913pm (becomes 9:13 
PM), 911 (becomes 9:11 AM), and 9p (becomes 9:00 PM). 

To edit an appointment, select it in the Agenda list view and press 
ENTER to open the Appointment. Use the arrow keys to move through 
the list of fields. Press ENTER to edit an item. When you have finished, 
press ENTER to return to the appointment page. Once you have made 
the necessary changes to the appointment, press the CLOSE button 
(ESC) to return to the Agenda list view. 

Viewing Appointments 

To see a list of available actions for an appointment, select the 
appointment in the Agenda list view and press the APPLICATIONS Key.  
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To view the details of an appointment, select it in the list view and press 
ENTER to open it. If you have both an all day event and one or more 
regular appointments scheduled on the same date, press TAB to move 
between the two list views. 

Note:  To quickly access your appointments for the day, press the 
WINDOWS Key and press ENTER on Today. 

Creating an All Day Event 

Appointments can span an hour, several hours, all day or even all week. 
Those that span all day or all week are considered an All Day Event. 
Examples include trade shows or training seminars. To schedule an all 
day event, follow the steps above to create an appointment or select and 
open an existing appointment from the appointment list. From the list of 
fields, press DOWN ARROW until you hear, "Type combo box." Press 
ENTER and use the arrow keys to select All Day. You can also schedule 
a birthday or anniversary as an all day event. However, for this you will 
want to press DOWN ARROW to move to the Status combo box, press 
ENTER and use the arrow keys to select Free. This way the time will not 
show as busy in your calendar.  

When you close the appointment details, you are placed into the All Day 
Events list view which displays your appointment. Press TAB to move to 
the Agenda list view. 

Making an Appointment Recurring 

Appointments that occur on a regular basis, such as a weekly team 
meeting can be entered once and set with a recurring pattern. To do this, 
follow the steps above to create an appointment or select and open an 
existing appointment from the appointment list. From the list of fields, 
press DOWN ARROW until you hear, "Occurs combo box." Press 
ENTER and use the arrow keys to select a pattern. If the default patterns 
in the list are not what you need, select <edit pattern…> to create your 
own pattern using the wizard. 

To create a new occurrence pattern: 

1. In the Occurs combo box, press ENTER on Edit pattern.  
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2. On the first screen of the wizard, press TAB to move to the 
Duration Edit combo box and specify the length of time between 
the start and end times. Changing this value will automatically 
change the time in the Ends field.  

3. Press ENTER on the Next button to move to the next screen.  

4. In the Select type of occurrence field, choose whether this task 
happens daily, weekly, monthly, or yearly, and then press TAB 
to move to the next control. 
 
If you use braille, note that when you navigate between the 
options in this field, the braille highlight (enabled by default) is 
used to indicate the selected item instead of the cursor. You 
must ignore the location of the cursor when navigating in this 
field. If you have turned off the Highlight option in the Braille 
Settings dialog box, pressing INSERT+UP ARROW (the Say 
Line command) will read the currently selected item. You can 
also press the cursor router on the display associated with the 
particular option to select it.  

5. The remaining options you see on this screen depend on the 
type of occurrence you chose. Make the necessary selections 
then press ENTER on the Next button to move to the Next 
screen. If you are asked to select specific days of the week, such 
as Sunday or Monday, use the arrow keys to navigate through 
the days and press the SPACEBAR or ENTER to select the 
ones you want.  

6. Use the various controls on the last screen to specify when this 
pattern starts and ends. After making your selections, press 
ENTER on the Finish button to complete the wizard.  

Setting a Reminder for an Appointment  

You can set a reminder for an appointment by following the steps above 
to create an appointment or by selecting and opening an existing 
appointment from the appointment list. From the list of fields, press 
DOWN ARROW until you hear, "Reminder combo box." Press ENTER 
and use the arrow keys to select Remind me. 
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You can change how many minutes before the appointment you are 
reminded. To do this, press ALT+T to access the Minutes combo box and 
use the arrow keys to make a selection. In addition, you can press ALT+I 
to modify the reminder interval from the default of minutes to hours, days, 
or weeks in advance of the appointment. 

Note:  To set a reminder for all new appointments in the calendar, press 
F2 in the appointment list, move to Tools and press ENTER. 
Press ENTER on Options and select "Set reminders for new 
items." 

If you want to be reminded about your appointments using a distinctive 
sound, go to the Start Menu (WINDOWS Key) and press ENTER on 
Settings. On the Personal tab select and press ENTER on Sounds & 
Notifications. Press CTRL+TAB to move to the Notification page. Press 
TAB until you hear, "Play Sound check box," then press the SPACEBAR 
to check this box. Last, press TAB again to move to the combo box that 
lists all the sounds available on your PAC Mate Omni. 

Adding a Note to an Appointment 

You can add additional information about an appointment if necessary.  

1. To add or edit a note, in the appointment list, select and press 
ENTER on the appointment.   

2. Press CTRL+TAB to move to the Notes page.  

3. Type in the additional information you want to include for that 
particular appointment. 

4. Press the CLOSE button (ESC) to close the notes page and 
return to the Agenda list view.  

Later, when you open your appointment, the additional information is 
available for you to read.  



 

 127 

Sending a Meeting Request 

Use Calendar to schedule meetings with people who use Outlook or 
Inbox. When attendees receive a meeting request, they can accept or 
decline the meeting. If they accept, the meeting is automatically added to 
their schedule. In addition, their response is sent back to you, and your 
calendar is updated.  

Note:  Before you can send a meeting request, you must enter e-mail 
addresses for the Contacts you want to include in the meeting and 
set up Messaging to send and receive messages.  

1. From the Appointment list you can either create a new 
appointment or edit an existing appointment. 

2. In the Appointment page enter or edit the information, then press 
DOWN ARROW until you hear, "Attendees and press ENTER." 

3. When the Attendees dialog box opens, you are in the Required 
Attendees list box. Press ENTER on Add Required Attendee to 
add a required attendee to the list. If you want to add an optional 
attendee, press TAB to move to the Optional Attendees list box 
and press ENTER on Add Optional Attendee to add an optional 
attendee to the list. 

4. After you choose to add a required or optional attendee, a list of 
those contacts containing e-mail addresses is displayed. Use the 
arrow keys to move to the contact in the list view you want to 
invite and press ENTER to select it and add it to the Required or 
Optional Attendees list box. If the selected contact has more 
than one e-mail address, you will be prompted to select the 
address you want to use. 

5. Since you can only add attendees one at a time, follow the steps 
above until you have added all of your attendees.  

6. When you are done press F1 to return to the Appointment details 
page. To close the Appointment details page and return to the 
Agenda list view, press the CLOSE button (ESC). 
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7. Before you return to the Agenda list view, you will be asked 
whether you want to send an e-mail to inform the attendees of 
the meeting. Press ENTER to activate either the Yes button or 
No button.  

Messaging automatically creates a meeting request along with any 
textual notes entered in the Notes page and sends it to the attendees the 
next time you synchronize with your PC.  

Note:  If you cannot synchronize with a PC, then you can send the 
meeting request through a connection to an ISP or the network. 
Press F2, move to Tools and press ENTER. Move to Options and 
press ENTER again. On the Appointments page, move to the 
"Send meeting requests via," and select the account you want to 
use to send the meeting request. 

Changing Appointment Options 

You can change Calendar options such as the first day of the week or the 
date and time you want to be reminded of a new appointment, etc. To 
enter the Options dialog box, press F2, move to Tools and select 
Options. Choose the settings that you want for your Calendar. 

Note:  The PAC Mate Omni does not support Appointment icon 
indicators.  

Using the Calendar View 

The Calendar View is a traditional style calendar in which you can easily 
check for appointments. The commands for Calendar View are listed in 
Appendix A. 

When navigating by the smaller date changes, if the month, year or day 
of week changes, that component of the date is spoken. The PAC Mate 
Omni announces when a date has an appointment associated with it. 

Press ENTER, TAB, or SHIFT+TAB while in the Calendar View to return 
to the Agenda list view on the new date. 
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Notes 

With Notes you can quickly capture your ideas and thoughts. In the Notes 
list view you can use the recording feature. You can also share your 
notes with others through e-mail, infrared, and synchronization with your 
PC.  

Note: To create documents with advanced formatting or templates, such 
as bulleted lists and tabs, use FSEdit. 

Appendix A lists the commands that are specific to the Notes program.  

Viewing Notes 

The Notes list view displays a list of your notes and recordings. If you 
have a long list, press CTRL+T (Sort By) and select the option you want 
to sort on. To open a note or play a recording, press ENTER on it. To see 
a list of available actions for a note or recording, select the note in the list 
view and press the APPLICATIONS Key. 

Creating or Editing a Note 

1. To create a note, press CTRL+N.  

2. Type your note. 

3. When finished, press the CLOSE button (ESC) to return to the 
Notes list view. The first line of text is always used to represent 
the title of each note in the list. 

Note:  You can insert the date in a note. In an open note, press the 
APPLICATIONS Key and then select Insert Date. 

To edit an existing note, select it from the Notes list view and press 
ENTER to open it. Make any necessary changes then press the CLOSE 
button (ESC) to close the note and return to the Notes list view. 
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Creating a Template 

1. Create a note as you normally would.  

2. In the Notes list view, move to the note with the arrow keys and 
select it with the SPACEBAR.  

3. Press the APPLICATIONS Key.  

4. On the menu, select Rename/Move.  

5. Press TAB to move to the Folder list box, select Templates. The 
template is stored in the Templates folder under the All Folders 
list.  

Creating a Note with a Template 

1. Press CTRL+Y to open the Show By menu and then select 
Templates.  

2. Press ENTER on the template you want to use and make your 
changes.  

3. Press the CLOSE button (ESC) to close the note.  

4. In the notes list, select the note and press the APPLICATIONS 
Key, choose Rename/Move. Enter a new name and location for 
the note.  

Note:  To create a new folder, in the Notes list view, press CTRL+Y to 
open the Show By Menu, then press ENTER on Add/Delete.  

If you want to store the item on a storage card, insert the card into your 
PAC Mate Omni and select Storage Card from the Location combo box in 
the Rename/Move dialog box. 
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Creating a Recording  

Your PAC Mate Omni has a voice recording feature that has multiple 
sound and transmission rate settings. These settings reflect the quality 
and size of the recording file. Typically, a high sample size (Bit) and rate 
(Hz), equals a larger file size, which equals better fidelity. Since the PAC 
Mate Omni has 128 MB of Flash memory, a recording set to 44,100 Hz, 
16 Bit, Stereo (172 KB/s) is going to give the best recording quality, but 
with the least amount of recording time.  

Tip: This setting is ideal if you are going to use audio editing software on 
the recording. 

You can synchronize recordings between your PAC Mate Omni and your 
desktop PC. If you are unable to play them on your desktop PC, it may be 
due to the setting on your PAC Mate Omni. In this situation, it is best to 
set your voice recording format to "8,000 Hz, 8 Bit, Mono (8 KB/s)." This 
gives you compatibility with your desktop sound player, acceptable voice 
recording fidelity and relatively small file sizes.  

Your PAC Mate Omni is also equipped with an internal microphone, 
which is the semicircular prominence above the PRINT SCREEN and 
SCROLL LOCK keys. If you are truly concerned about recording fidelity, 
you can also purchase a high quality external microphone to fit into the 
1/16 inch audio input jack. 

You can create a stand-alone recording from the Notes list view, using 
these recording commands. 

1. While in the notes list view, move the PAC Mate Omni's 
microphone near the source of sound.  

2. When you are ready, press ALT+V, R to record. You will hear a 
single audible indicator, which is your signal that recording has 
begun.  

3. When you are ready to stop, press S. You will hear two audible 
indicators, which indicates the recording has stopped.  

4. To play a recording, press ENTER on the recording in the Notes 
list view.  
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5. To stop playing the recording, press ALT+V, S.  

Or you can access the recording feature from anywhere on the PAC Mate 
Omni with the default hotkey command, INSERT+SPACEBAR, 1. No 
other commands are necessary as this immediately starts the stand-
alone recording. Press S when you want to stop the recording. Your 
recording is then saved in the Notes list view. To play the recording, just 
select it and press ENTER. To learn more about hotkey commands, 
please see Setting Up PAC Mate Omni, Buttons 

Find a Note 

You can find a note by using the Search Feature or by pressing CTRL+Y 
to open the Show By menu. Then select and press ENTER on the folder 
you want displayed. To show all folders again, select All Folders. For 
more information on the Search Feature, please see Using Windows 
Mobile with the PAC Mate Omni, Using the Search Feature. 

Attaching a Note to E-mail 

In the Notes list view; select the note or recording and press the 
APPLICATIONS Key. To select multiple notes or recordings, use the 
SHIFT+UP/DOWN ARROW. Then, press the APPLICATIONS Key. From 
the Context Menu, choose Send.  

A new e-mail message is created with the note attached.  

If you are working offline, the message with the attached note is moved to 
the Outbox folder and will be sent the next time you connect.  
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Calculator 

With the Windows Mobile Calculator you can do basic addition, 
subtraction, multiplication, and division equations.  

Entering Equations 

To enter an equation, type the first number, then type the operand 
followed by the second number. To hear the answer, press ENTER. 

For Example: 

8+10-2 would be typed 8+10-22. You then press ENTER for the answer.  

Note: Do not use the EQUALS key to get the answer as pressing this key 
will not announce the answer. 

Clearing the Calculator 

To clear the calculator for a new equation, simply press C. 
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Internet Explorer Mobile 

The World Wide Web has a lot to offer. On any given day, at any given 
moment you can connect to the web and find interesting articles about 
any subject, you can buy almost anything and you can visit nearly every 
country. With Internet Explorer Mobile, you can download files, post to a 
listserv, access multimedia files, and even share resources and ideas 
with people who are located at opposite ends of the world. 

To open Internet Explorer, go to the Start Menu (WINDOWS Key) and 
press I. When Internet Explorer opens, the PAC Mate Omni begins 
reading your home page. To silence speech, press CTRL. Your initial 
home page is a default page, which has links to Internet Explorer 
Mobile’s Online Help and links to various resources on 
FreedomScientific.com. To move about links on a page, press TAB or 
SHIFT+TAB and to open a page, press ENTER on the link.  

If you know the Web address of the site, then press G to go directly to the 
address bar and type in the address. When you are done press ENTER. 

Appendix A lists the PAC Mate Omni commands available for Internet 
Explorer Mobile. Many of these commands are layered so you can press 
the second command repeatedly without re-pressing the initial command.  

Reading and Moving through Web Pages 

The PAC Mate Omni can provide information about the structure and 
organization of web pages. Tables, headings, and alternate text for 
images are announced. This information helps you locate what you need 
quickly and take full advantage of web features. 

Text 

When you open a web page, the PAC Mate Omni announces the 
presence of frames, links, and headings then begins speaking the text on 
the screen. Reading and moving through web based text uses the same 
reading commands as those used for text in a document. For more 
information on moving through and reading text, please see PAC Mate 
Omni Basics, Working with Text. 
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Note:  If you start reading before a page completely loads, some of the 
page may not be available. 

Links  

Links allow you to move from one portion of a document to another or 
from one document to another. When reading a web page with the Virtual 
Cursor, the PAC Mate Omni places each link on its own line, even if 
Internet Explorer visually presents the link on a line with other text or 
additional links. 

 To move through the links on the page, press TAB for the next link, 
and SHIFT+TAB for the prior link. 

 To open a link, press ENTER. 

 To skip past a series of links, press N. The PAC Mate Omni moves to 
the first text of at least 25 characters that is not a link. 

When you move to a link with the Virtual Cursor, the PAC Mate Omni 
announces the type of link and the text of the link. The PAC Mate Omni 
announces the type of link as follows: 

 Link: This indicates a link that has not been visited. 

 Visited Link: This indicates a link that has been visited. 

 This Page Link: This indicates a link that moves you to another 
location on the same page. 

 Send Mail Link: This indicates a link that opens a new e-mail 
message using the Messaging program. The To field of the new e-mail 
is already filled out, and the Subject field is sometimes filled out as 
well. 

 FTP Link: This indicates a link that points to a FTP (File Transfer 
Protocol) server. Usually, these links are to files, and when you select 
them, Internet Explorer displays a dialog box asking if you want to 
save the file to your PAC Mate Omni. 
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The PAC Mate Omni announces when a graphic is used as part of a link. 
Image Map Links are also announced. Image map links are part of an 
image. A small section of the image is mapped out to represent a "hot 
spot" that is normally clicked with the mouse. The PAC Mate Omni moves 
to image map links the same way it does to other links. 

The PAC Mate Omni provides configuration settings for links, so you can 
determine what information and how much information you wish to hear: 

 By default, the PAC Mate Omni speaks the on screen text of a link, but 
you can set it to instead speak Title text, assigned by the page author 
within the HTML code. Title text normally provides supplemental 
information about the link. 

 By default, the PAC Mate Omni announces the link type, but you can 
disable this, so that same page links, send mail links, and ftp links are 
announced simply as "link," or "Visited Link." 

To change these settings temporarily, press INSERT+V. To change them 
permanently, press WINDOWS Key, S to open the Settings Dialog box, 
and change the HTML settings as appropriate. 

Use the Links List dialog box to quickly locate and select links on a web 
page. Press INSERT+F7 to open the Links List. Press UP ARROW or 
DOWN ARROW, or the first letter of a link's text to move through the list 
of links. You can also move through the controls in this dialog box by 
pressing TAB. There are buttons to move to the location of a link on the 
page or to open a link. Additionally, There are radio button groups to filter 
and sort the links that display in the list. 

Once you have selected a link, Press ENTER on the Activate Link button 
to open the selected link. Press ENTER on the Move to Link button to 
have the cursor moved to that particular link on the page. You can then 
press ENTER to open the link or continue reading the Web page. 
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Headings 

In HTML, headings are used to indicate the start of sections and 
subsections of a page so that the relationship between information within 
sections and subsections is clear when reading the page. When viewing 
all headings on a page, if the headings are used properly, the hierarchy 
of the heading levels indicates how the page is structured. This makes it 
easier to find information and understand the relationships within the 
information. To view a table with all the commands that allow you to 
navigate by headings, go to Appendix A. 

The PAC Mate Omni recognizes headings at levels 1 through 6 and 
announces them as you move through the page or read using Say All. 
Press H to move to the next heading, or press SHIFT+H to move to the 
prior heading. To move to the first heading on the page, press 
CTRL+HOME, H. To move to the last heading, press CTRL+END, 
SHIFT+H. 

The Headings List dialog box, INSERT+F6, lists headings on the current 
page and indicates the heading level. Press UP or DOWN ARROW to 
move through the list. Press TAB to move to the other controls in the 
dialog box. 

Press ENTER on the Move to Heading button to move to the location of 
the selected heading on the web page. Additionally, one set of radio 
buttons allow you to sort the headings list alphabetically or in tab order 
while another set lets you display the headings of a particular level. For 
example, you could choose to only list the level two headings on a page. 
The default is to show all headings. 

Headings are announced as you navigate through a web page, but if you 
want, you can turn this announcement off. To temporarily turn off heading 
announcement, press INSERT+V to open the Verbosity dialog box and 
move to Indicate Headings. Press SPACEBAR to turn off this setting. 

To permanently change this setting: 

1. Press the WINDOWS Key to open the Start Menu. 

2. Press S to open the Settings Dialog box. 
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3. Press H to move to HTML Settings and press ENTER. 

4. Press TAB until you reach the combo box labeled "Headings 
Verbosity." 

5. Press UP or DOWN ARROW to select the setting you want. 

6. Press the CLOSE button (ESC) to close the HTML Settings 
Dialog box. 

The HTML heading navigation features are extremely useful on pages 
that use headings as they are intended. However, many web pages are 
written that do not properly use headings. The heading navigation 
features may not be as useful on these pages. 

Tables 

The PAC Mate Omni provides commands that allow you to move within 
tables. In addition, when you use table navigation commands you can get 
information about the position of table cells and the structure of tables on 
a page.  

When you move through a web page, the PAC Mate Omni announces 
the start of tables, and the number of columns and rows, and reads the 
summary, if a summary is available.  

A table summary provides information about the purpose of the table. If a 
summary is provided, the PAC Mate Omni says, "Summary," and reads 
the summary text. 

When you navigate tables using standard reading commands, the PAC 
Mate Omni reads the cells in order from left to right and behaves as if 
each table cell begins on a new line. The PAC Mate Omni does not 
identify table headers or provide information about table structure when 
you navigate in this manner. 

To hear information about the current table cell, press ALT+CTRL+C. 
The PAC Mate Omni announces the row and column position, the current 
row and column headers, and the contents of the cell. 
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When you move to the next or prior cell in the same row using table 
navigation commands such as ALT+CTRL+RIGHT ARROW or 
ALT+CTRL+LEFT ARROW, the PAC Mate Omni reads the column 
header, the data in the cell, and the column number. 

To move to the cell above or below the current cell, press 
ALT+CTRL+UP ARROW or ALT+CTRL+DOWN ARROW. The PAC 
Mate Omni reads the row header, the data in the cell, and the row 
number.  

Note:  The PAC Mate Omni does not identify row or column headers 
when you navigate tables using standard reading commands with 
the Virtual Cursor or when using Say All. 

Forms 

HTML forms on web pages allow you to enter information and send it to 
another computer. Examples of forms include shopping carts, feedback 
forms, and web-based e-mail and bulletin boards. 

Forms are collections of controls such as check boxes, combo boxes, 
edit fields, and radio buttons. Use the following commands to move 
through form fields on a web page. 

 Press F to move to the next form control or press SHIFT+F to move to 
the previous form control.  

 Press INSERT+CTRL+HOME To move to the first form control or 
press INSERT+CTRL+END to move to the last form control.  

 Press B to move to the next button or press SHIFT+B to move to the 
previous button.  

 Press C to move to the next combo box or press SHIFT+C to move to 
the previous combo box.  

 Press E to move to the next edit field or press SHIFT+E to move to the 
previous edit field.  

 Press R to move to the next radio button or press SHIFT+R to move to 
the previous radio button.  
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 Press X to move to the next check box or press SHIFT+X to move to 
the previous check box.  

To enter text into a form field, move the Virtual Cursor to a form field, and 
press ENTER to switch to Forms Mode. The PAC Mate Omni says, 
"Forms Mode On," the information and the name of the control you are 
on. When you press ENTER to go into Forms Mode, the PC cursor is 
activated on the current control. If the field is an edit field, the cursor is 
placed at the top of the field. 

To navigate within an edit field while in Forms Mode, use the UP, DOWN, 
LEFT and RIGHT ARROWS as you normally would. To move to the next 
form field while in Forms Mode, press TAB. To move to the previous 
field, press SHIFT+TAB. 

To exit Forms mode, press INSERT+X. 

To check a check box or radio button on a form, press ENTER when the 
Virtual Cursor is on the item. If you are on a check box, the state of the 
check box is toggled. If you are on a radio button that is unchecked, the 
radio button is checked, however, if it was already checked, it remains 
unchanged. 

If you enter Forms Mode in a Combo box, the first item is selected. To 
change the selection, press UP or DOWN ARROW. 

Tip:  In some forms, changing the selection in a combo box opens a new 
page automatically. To work with these combo boxes, press 
ALT+DOWN ARROW to open the list of choices. Then move to 
an item and press ENTER to make your selection. 

The PAC Mate Omni attempts to associate each form field with a textual 
prompt. The PAC Mate Omni can identify when a prompt is specifically 
associated with a control, and speaks the correct prompt when you move 
to that control. If no prompt is specifically associated with a control, the 
PAC Mate Omni attempts to identify text positioned near the control as 
the prompt. This is most accurate when the text is directly to the left or 
right of the form control. 
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Forms on some web pages are not written with accessibility in mind, and 
the PAC Mate Omni cannot obtain enough information to read the form 
controls properly. If the PAC Mate Omni does not read form controls 
correctly while you are in Forms Mode, reading the form with the Virtual 
Cursor may provide additional helpful information. press ENTER to turn 
Forms Mode on and fill in a form field. Next press INSERT+X to exit 
Forms Mode and continue reading the form with the Virtual Cursor. 

Frames 

Frames allow more than one document to be displayed on a web page at 
the same time. The frames on a page may be arranged vertically, 
horizontally, or mixed so that, for example, one frame appears on top with 
two frames side by side below it. In this way, frames provide structure 
visually on a page and allow text on one portion of the page, such as a 
listing of navigation links, to remain the same while another portion 
changes. 

You move through a page containing frames just as you would any other 
Web page. As you navigate, The PAC Mate Omni announces the 
beginning and end of frames, reading the frame title if one is available. If 
no frame title is available, the PAC Mate Omni reads the frame name. 

Changing Your Home Page 

If you want another web page as your home page, press G to move to 
the Address Bar and type in the address of the page. When you are 
done, press ENTER to go to that page. 

Next, press F2 to open the menu, and press ENTER on Tools. With the 
Tools Menu open, press ENTER on Options. The first controls in the 
Options dialog box are two buttons, one labeled Use Current and one 
labeled Use Default. To have the web page currently opened as your 
home page, press ENTER on the Use Current button.  
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Changing Security Options 

Internet Explorer Mobile supports the security protocols used by secure 
pages. When accessing a secure page, you can send personal 
information safely. To determine if a page is secure, press F2, press 
ENTER on Tools, and select Properties.  

To change security settings, press F2, move to Tools, and press ENTER. 
Go to Options and press SHIFT+TAB to move to the General tab, then 
press the RIGHT ARROW to move over to the Security page.  

Cookies contain information about your identity and preferences so that a 
page can tailor information to your needs. To prevent Internet Explorer 
Mobile from accepting cookies, use the SPACEBAR to uncheck the Allow 
cookies check box. Press ENTER on the Clear Cookies button to erase 
any cookies currently stored on your PAC Mate Omni. 

Synchronizing Favorite Links 

In ActiveSync on your PC, press ALT+T to open the Tools Menu. press 
ENTER on Options. In the Options dialog box list view, move to Favorite 
and place a check in the box.  

In Internet Explorer on your PC, save or move favorite links to the Mobile 
Favorites subfolder in the Favorites list.  

Connect your PAC Mate Omni to your PC. If synchronization does not 
start automatically, in ActiveSync on your PC, press ALT+F and press 
ENTER on Synchronize.  

Note:  If you add or delete a favorite link in the Mobile Favorites folder on 
your PAC Mate Omni, the next time you synchronize, the same change is 
made on the PC. 

Viewing Favorites 

If favorite pages are not synchronized using a schedule for 
synchronization, in Internet Explorer on your PC, go to Tools (ALT+T) 
and select Synchronize.  
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On the PAC Mate Omni, press F2, move to Favorites, and press ENTER. 

Use the arrow keys to select the page that you want to view and press 
ENTER.  

Note:  If you get a message that the page is not available, you must 
download the page to your device through synchronization or connect to 
the Internet. 

To stop pictures from downloading, which saves memory as well as 
making the page open faster, press F2, press ENTER on View, move to 
Show Pictures, and press ENTER. If you do not hear JAWS say 
"checked," this option is disabled and pictures are not downloaded when 
a Web page is displayed. 

Note: This option is off by default so you should not need to change it. 

Adding/Deleting a Favorite Link 

Go to the page you want to add. press F2 and press ENTER to open the 
Favorites page. Press CTRL+TAB to move from the Open page to the 
Add/Delete page. Press TAB to move to the Add button and press 
ENTER. If you do not want to change the default name of your new 
favorite or save it in a different folder, press ENTER on the Add button 
again. 

Note:  To add a new folder, go to the Add/Delete page; press ENTER on 
the New Folder button. Enter a name for the folder, and press 
ENTER on the Add button. 

To delete a link, the steps are the same except that you first select the 
link that you want to delete in the Add/Delete page, then move to the 
Delete button and press ENTER. The link is then deleted. 

Note:  Only the link to the page is deleted, not the page content stored on 
your PAC Mate Omni. To delete the page itself, press F2 move to 
Tools, and press ENTER. Select Options. Press CTRL+TAB to 
move to the Memory page and press ENTER on the Delete Files 
button. 
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FSEdit 

FSEdit is a word processing application that you can use to create and 
edit documents. Unlike Word Mobile or Notes, FSEdit was created 
specifically for the blind user. Among its friendly and convenient features, 
you will find FSEdit provides a robust editing environment, complete with 
a spell checker, and offers the facility to emboss all supported file 
formats. 

The default location for FSEdit is the Programs submenu (WINDOWS 
Key, P). In the Program submenu press F until you hear FSEdit and then 
press ENTER. When you first open FSEdit, it automatically creates a new 
document. If necessary you may also create a new document by pressing 
ALT and then ENTER on the File Menu. In the File Menu, press N and 
ENTER again. This will also create a new blank document. 

To view all the commands available in FSEdit, please see Appendix A: 
PAC Mate Omni Commands. 

Saving a Document 

If the file you want to save has the correct name, is in the correct file 
format, and in the correct folder, you can simply press CTRL+S and your 
file will be saved.  

If, however, you want to save the file with another name, with a different 
file format, or in another folder, you will have to open the File Menu and 
select Save As. In the Save As dialog box you can change any parameter 
of the file. Use the TAB command to navigate this dialog box. Below lists 
the options available in each combo box in the Save As dialog box. 

Folder combo box: The default is None, which means that your file will be 
saved in the default folder, My Documents. The other folder options, 
listed below, are subfolders of the My Documents folder. 

 None 

 Business 
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 Personal 

 Templates 

File Type combo box: FSEdit offers a nice variety of file types that easily 
match your working needs. In addition, FSEdit’s own file type, .fsd, allows 
for synchronization to your PC, storage of additional information such as 
grade of braille (contracted or uncontracted), cursor location, mark 
location, and contracted back translation for easy conversion between the 
other file types supported by FSEdit.  

 *.fsd 

 *.brf 

 *.rtf 

 *.psw 

 *.txt 

Location combo box: 

 Main Memory 

 Storage Card (if one is inserted) 

 Hard Disk (if a USB thumb drive is connected) 

Revert To Saved  

This menu item reloads the last saved version of the document and 
discards any succeeding editorial changes. 

Opening a Document  

1. To launch the Open File dialog box, press CTRL+O. 

2. Press TAB to move into the list view of files, and then use the 
arrow keys to make your selection. 
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3. When you find the file you want, press TAB to move over to the 
OK button and then press ENTER. 

4. If the file is not stored in the current folder, press TAB until you 
hear, "Folder list box," then use the arrow keys to choose the 
folder in which the file is stored. 

5. If the folder is not in the current location, press TAB until you 
hear, "Location list box," then use the arrow keys to choose the 
location in which the folder is stored. 

6. If the file is of another file type, press TAB until you hear, "Type 
list box," then use the arrow keys to choose the file type.  

Note: FSEdit remembers the file and folder location after you open a file. 
This becomes the default, so that the next time you open a file, 
the Open File dialog box starts using this file and folder location. 

Opening a Second Document 

To have two FSEdit files open simultaneously, you must have two FSEdit 
sessions open.  

To open an FSEdit session and file, do the following:  

1. From the Start menu, choose the Programs menu and press 
ENTER. (You may use the shortcut letter P to choose the 
Programs menu.)  

2. Press the F key until you hear "FSEdit," and then press ENTER.  

3. Press CTRL+O to launch the Open File dialog box.  

4. Press TAB to move into the List of files, and use the arrow keys 
to select a file. Note that if the file does not appear in the list, use 
the Folder combo box, the Location combo box, or the Type 
combo box to locate the file.  

5. To open a second FSEdit session and file, repeat steps 1-4. 
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To toggle between documents, refer to Switching Between Two Open 
FSEdit Files.  

Switching Between Two Open FSEdit Files 

The following describes how to toggle between two open FSEdit files. For 
information about having two FSEdit files open, refer to Opening a 
Second Document.  

1. Press ALT+TAB.  
The Recent Applications menu appears, which shows a list of 
open dialog boxes and files. The second FSEdit document, 
which does not have focus, appears in the list.  

2. Press the F key.  
If FSEdit is the only application open that begins with the letter F, 
the PAC Mate Omni automatically switches to the second FSEdit 
session and file. It also announces the file name.  
If another application that begins with the letter F is open, 
continue to press F until you hear the PAC Mate Omni announce 
FSEdit and the second FSEdit file name.  

Braille Input 

If you turn on Braille input mode (INSERT+SHIFT+F9), when you open a 
new document, you are asked, “Would you like to make your new file a 
Grade 2 Braille document?” If you choose Yes, the file opens as a 
contracted braille document. At this point, you can write text in the current 
file using contracted braille. If you choose No, the file opens as a 
Computer braille document and you must write in computer Braille even 
though you can use contracted braille in other applications. 

If you later wish to make it a Grade 2 document, do the following: 

1. Press ALT to open the menu.  

2. Select File, then press ENTER.  

3. Choose Save As and save the file with a BRF extension.  
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Continuous Braille Mode 

Use Continuous Braille mode when layout and formatting are not 
important to you, such as when reading an e-book. Continuous Braille 
mode ignores hard carriage returns within a paragraph. It shows the 
carriage return as a blank space and continues the flow of text instead of 
leaving the remainder of the braille display blank.  

To turn on Continuous Braille mode, press CTRL+R. Use this command 
again to turn it off. 

Connecting to an Embosser 

Before you can emboss a document, you must first select your embosser 
type in the Properties dialog box, which is accessed from the Emboss 
dialog box.  

When you select your embosser, many of the fields in the Properties 
dialog box automatically populate with your embosser’s default settings. 
This means you can immediately begin embossing your document or you 
can change the embossing settings.  

To launch the Properties dialog box: 

1. Open the File Menu. 

2. Use the arrow keys to move to Emboss and press ENTER to 
launch the Emboss dialog box.  

3. Use TAB to move to the Properties button and press ENTER to 
open the Properties dialog box. 

4. When this dialog box opens, your cursor is placed in the 
Embosser combo box. This combo box lists embossers that are 
compatible with FSEdit. Use your UP or DOWN ARROW keys to 
select your embosser. 



 

 149 

5. If you are satisfied with the automatic settings of your embosser, 
press ENTER on the OK button to return to the Embosser dialog 
box. Otherwise, press TAB to move to each field and adjust the 
setting. When you are done, move to the OK button and press 
ENTER. 

6. In the Embosser dialog box, press TAB until you hear, 
"Connection button" and press ENTER. 

7. Use your UP or DOWN ARROW keys to select the port 
connecting your embosser.  

8. If you select Windows Device, press TAB to move to the 
Location edit box. Type in the network path of the embosser. For 
example: \\server\my embosser. If you select IRDA, please see 
Embossing Using an Infrared Connection for more information. 

9. Press ENTER on the OK button to return to the Emboss dialog 
box. 

Embossing a Document 

Embossing a document is initiated from the Emboss dialog box. To 
launch the Emboss dialog box you must open the File Menu and select 
Emboss (E). With the Emboss dialog box open, you have several controls 
that allow you to change the way your document is embossed. If you do 
not want to change any of the parameters and are ready to emboss, 
press TAB until you reach the OK button and then press SPACEBAR. 

Number of Copies 

Unless you specify the number of copies embossed, FSEdit will only 
emboss one copy of a document.  

To emboss more than one copy of a document: 

1. From the file menu, press E to open the Emboss dialog box.  

2. Press TAB until you hear "Number of copies one."  



 

150 

3. Type in the number of copies to be embossed. 

4. Once you have selected your number, you can change more 
emboss parameters or press TAB to move to the OK button. 
Press ENTER to print your document. 

Emboss Settings 

Depending on your needs, you may want to emboss on different size 
paper. Changes made to the embossing settings are retained until you 
change them or reset them to their defaults. 

For 8.5 x 11 inch paper, use the following settings:  

Cells Per Line: 34 
Lines Per Page: 25 
Top Margin in lines: 0 
Max Cells Per Line of Embosser: 34 
Max Lines Per Page of Embosser: 27 

For 11.5 x 11 inch paper, use the following settings:  

Cells Per Line: 40 
Lines Per Page: 25 
Top Margin in lines: 0 
Max Cells Per Line of Embosser: 42 
Max Lines Per Page of Embosser: 27 

Changing Emboss Settings 

1. From the file menu, press E to open the Emboss dialog box.  

2. Use TAB to move to the Properties button and press ENTER to 
open the dialog box. 

3. Press TAB to move to the Set Cells Per Line To edit box. Type 
the number of braille cells you want in each line. 

4. Press TAB to move to the Set Lines Per Page To edit box. Type 
the number of lines you want on each page.  
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5. Press TAB to move to the Set Top Margin in lines to edit box. 
Type the number of lines you want to set for your top margin.  

6. Press TAB until you hear, "Max Cells Per Line of Embosser edit 
box." Type the absolute maximum number of cells you want on 
each line.  

7. Press TAB to move to the Max Lines Per Page of Embosser edit 
box. Type the absolute maximum number of lines you want on 
each page.  

8. Press TAB to move to the Margins for Interpoint check box, use 
the SPACEBAR to place a check in the box. 

9. Press TAB to move to the Pages for Interpoint check box, use 
the SPACEBAR to place a check in the box. 

10. Press ENTER on the OK button to emboss your document. 

Embossing Using an Infrared Connection 

In order to emboss to a braille device from your PAC Mate Omni using 
infrared data transfer, you will need to obtain a powered, IRDA-compliant 
printer adapter. In addition to the power connection, this adapter will have 
an infrared port on a cable that you can locate in a convenient place. You 
can connect the adapter to any of the braille embossers supported by the 
PAC Mate Omni. 

After connecting the adapter and selecting your embosser, align the IR 
port of your PAC Mate Omni with that of the adapter and select Emboss 
from the FSEdit File menu. Your document will be transferred using the 
IR ports and embossed on the braille embosser. 

Notes: You cannot use infrared to transfer files to a braille embosser if 
you are embossing over a network. Go to Connecting to an 
Embosser for more information. 

Most IRDA-compliant printer adapters are pass-through devices; that is, 
once connected to the parallel port of your braille embosser, you can then 
connect the cable from a desktop or laptop computer to the adapter and 
emboss from both that device and the PAC Mate Omni. 
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Resetting the Embosser’s Default Settings 

1. From the file menu, press E to open the Emboss dialog box.  

2. Use TAB to move to the Properties button and press ENTER to 
open the dialog box. 

3. When this dialog box opens, your cursor is placed in the 
Embosser combo box. Use your UP or DOWN ARROW keys to 
select another embosser. 

4. Reselect your embosser. The default settings will repopulate 
each field. 

5. Press ENTER on the OK button to return to the Emboss dialog 
box. 

Printing Documents 

There are two ways to launch the print dialog box. The easy way is to 
press CTRL+P from within any document. The other way is to open the 
File Menu (ALT, ENTER) and select Print (P). Unless you want to change 
print parameters or you have more than one printer, you can immediately 
press ENTER or select the Ok button to print a single copy of your 
document. The default margin set for the top, bottom, left, and right page 
edge is 1 inch.  

Number of Copies 

Unless you specify the number of copies printed, FSEdit prints only one 
copy of a document. 

To print more than one copy of a document: 

1. Press CTRL+P to open the Number of Copies page. 

2. After you hear "Number of copies one," type in the number of 
copies to be printed. 
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3. Once you have entered the number of copies you want printed, 
press ENTER on the OK button, followed by ENTER again to 
print your document. To select a different printer, or change how 
the document is printed, use the controls in the Print dialog box 
to make more changes. 

Changing Printers 

FSEdit supports a wide variety of printers. Depending on the printer you 
are using, you first need to select the appropriate printer type before you 
can print. 

To change printers: 

1. Press CTRL+P to open the Number of Copies page. 

2. Navigate beyond the number of copies edit page by pressing 
ENTER on the OK button. 

3. When the Print dialog box opens, the Printer combo box is 
active. Use your UP or DOWN ARROW keys to select a printer. 

4. Press ENTER to print your document. 

Choosing Port Settings 

Currently FSEdit supports printing to printers on a network, that are 
infrared or Bluetooth compatible, and that are attached via a USB 
connection. If you select network because you are printing to a network 
printer, you must enter the printer's UNC path in the Net Path edit field. 
You must also enter this information in File Explorer. When using a USB-
attached printer, be sure to select LPT1 in the printer port list. 

To print to a Bluetooth printer, make sure you have set up a Bluetooth 
partnership with the printer and added COM2 as an outgoing COM port. 
Then, select COM2: Bluetooth in the printer port list. 

Once you have selected the port, you can change more print parameters 
or press ENTER to print your document. 
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Choosing Paper Size 

The default paper size setting for FSEdit is Letter (8.5 x 11 inches). 

To choose another paper size: 

1. Press CTRL+P to open the Print dialog box. 

2. Navigate beyond the number of copies edit page by pressing 
ENTER on the OK button. 

3. When the Print dialog box opens, move to the Paper Size combo 
box. This combo box lets you select a different paper size. Use 
your UP or DOWN ARROWS to make your selection. 

4. Once you have selected your new page size you can change 
more print parameters or press ENTER to print your document. 

Selecting a Print Range 

The Print Range area of the Print dialog box is composed of two radio 
buttons: All and Selection. Use the arrow keys to select either radio 
button. Unless you specify a selection, FSEdit will print all pages 
contained within a document. 

To specify a selection: 

1. Select the text you want to print with the selecting commands. 

2. Press CTRL+P to open the Print dialog box. 

3. Navigate beyond the number of copies edit page by pressing 
ENTER on the OK button. 

4. Move to the Print Range radio buttons and use the arrow keys to 
choose Selection. 

5. Press ENTER to print your selected text. 
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Page Orientation 

The Orientation area of the Print Setup dialog box is composed of two 
radio buttons: Portrait and Landscape. 

To change the page orientation: 

1. Press CTRL+P to open the Print dialog box. 

2. Navigate beyond the number of copies edit page by pressing 
ENTER on the OK button. 

3. Next, press TAB until you hear "Page Orientation." Use the 
arrow keys to make your selection. 

4. Once you have selected the page orientation, you can change 
more print parameters or press ENTER to print your document. 

Draft Mode 

On by default, the Draft Mode check box in the Print dialog box uses less 
ink, but reduces the sharpness and quality of print on paper. To improve 
print sharpness and quality, press the SPACEBAR to uncheck this box. 

Uncontracted Braille vs. Contracted Braille 

Regardless of whether you created a braille file or one of the other 
supported file formats, FSEdit's default setting sends text to your 
embosser in contracted braille. If necessary, you can emboss a file in 
uncontracted braille.  

To emboss an uncontracted braille file in uncontracted braille: 

1. From the file menu, press E to open the Emboss dialog box.  

2. Press TAB until you hear, "Grade 2 checked." A check in this 
box means the document will emboss in contracted braille. To 
emboss in uncontracted braille, press SPACEBAR to uncheck 
this box. 
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3. Once you have specified the grade of braille, you can change 
more emboss parameters or press TAB to move to the OK 
button and then press ENTER to emboss your document. 

Mark Emphasis Text 

Emphasis text is text that is bold, underlined and/or in italics. This item 
(enabled by default and only available when embossing in contracted 
braille) indicates when text has emphasis.  

Disabling Mark Emphasis Text 

1. From the file menu, press E to open the Emboss dialog box.  

2. Press TAB until you hear, "Mark Emphasis Text." 

3. A check in this box means bold, underline and/or italic text is 
marked.  

4. If you want to emboss without marking Emphasis Text, press 
SPACEBAR to uncheck this box. 

5. To emboss your document, press TAB to move to the OK button 
and then press ENTER.  

Selecting Text vs. Marking Text 

While these two features, selecting text and marking text, use very 
different approaches, they do perform virtually the same function. The 
difference, however, is that with Marking Text you can accurately mark 
text and have the added advantage of being able to freely read your 
document until you find the word(s) you want to mark inclusively. 
Whereas when you select text, you must move linearly in a fixed 
increment until the block of text you want is selected. This may result in 
more editing, as some unwanted text might get selected. 
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Marking Text 

1. Set the mark at the location of the cursor by opening the Edit 
Menu and pressing ENTER on Set Mark or by pressing ALT+E, 
M. 

2. Move the cursor to a different location in the document. 

3. Choose Select to Mark from the Edit Menu or press ALT+E, S to 
select all the text between the mark and the cursor. 

Trading Mark and Cursor Positions 

On occasion you may find it helpful to review the information you have 
selected. Or you may find that you want to select text that is beyond the 
marked end. To do this easily, swap the position of the mark and cursor. 
You can find this feature in the Edit Menu or simply press ALT+E, W. 

Selecting Text 

In addition to all the selecting commands available in the PAC Mate 
Omni, FSEdit has its own Quick Select commands. The Quick Select 
commands let you select text in five different increments. You can find 
these options in the Edit Menu under the Quick Select submenu or you 
can press the shortcut commands.  

Cut Text 

Cutting selected text places it on the clipboard and removes it from the 
document. Once you have selected the text you want to cut, press 
CTRL+X. If you are cutting text from a contracted braille document, it is 
placed on the clipboard as computer braille. You can then paste the text 
into another part of the open document, into a new document, or into 
another application such as Word Mobile. 

If you would prefer to have the text placed on the clipboard as is, without 
any back-translation, press ALT, choose Edit, then select Cut. However, 
you should use the CTRL+X keystroke if you are cutting and pasting from 
a contracted braille document to a computer braille file. 
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Copy Text 

Copying selected text places it on the clipboard without removing it from 
the document. Once you have selected the text you want to copy, press 
CTRL+C. If you are copying text from a contracted braille document, it is 
placed on the clipboard as computer braille. You can then paste the text 
into another part of the open document, into a new document, or into 
another application such as Word Mobile. 

If you would prefer to have the text placed on the clipboard as is, without 
any back-translation, press ALT, choose Edit, then select Copy. 
However, you should use the CTRL+C keystroke if you are copying and 
pasting from a contracted braille document to a computer braille file. 

Paste Text 

Choose Paste when you want to insert text from the clipboard into your 
document. Find the location where you want the text inserted, then press 
CTRL+V. The text is inserted into the document. When pasting into a 
contracted braille document, the text is also inserted as contracted braille. 

If you would prefer to paste the contents of the clipboard as is, without 
any translation, press ALT, choose Edit, and select Paste. When copying 
and pasting text between two contracted braille documents or within the 
same document, you should only use this method if you have selected 
Cut or Copy from the Edit menu, which places the text on the clipboard 
as it appears in the document without any back-translation. Additionally, if 
you are copying and pasting from a computer braille document into a 
contracted braille document, you should not use this method as no 
translation occurs and text is pasted as computer braille. 

Delete Text 

Unlike cutting selected text from a document, deleting does not copy the 
text to the clipboard. Once you use the delete command, the selected 
text is permanently deleted and cannot be pasted. Press CTRL+Z to 
undo the delete. 
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Find 

The Find feature is a very handy tool that lets you search for a word or 
phrase within an open document quickly. When you press ALT+E, F, 
FSEdit launches the Find dialog box with the cursor in the Find What edit 
box. Type in the word or phrase you want to find. Use the TAB key to 
navigate the dialog box. Other controls in this dialog box that are 
available are Find Whole Words Only, Match Case, and Search Direction.  

When you are ready, press ENTER on the Find Next button.  

Replace  

The Replace menu item (ALT+E, R) is similar to the Find feature in that it 
searches for words or phrases within a document, but it has the 
additional feature of replacing words or phrases with alternative text. Its 
dialog box is similar to the Find dialog box but has two additional buttons. 
The Replace button replaces one instance of the word or phrase, and the 
Replace All button replaces all instances of the word or phrase in the 
document.  

Formatting a Document 

FSEdit makes formatting a document very easy. Most formatting options 
available can be directly accessed from the two submenus in the Format 
Menu.  

To format a document: 

1. Press ALT, then F twice to move to the Format menu and press 
ENTER to open the Format menu. 

2. On the Format menu you have two choices: Font and 
Paragraph. Each opens a submenu when you press ENTER. 

3. The Font submenu options include: bold, italic, underline, 
strikethrough, and more options. In order to use the bold, italic, 
underline and strikethrough options you must first select the text 
using one of the three methods available: 
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 Windows standard. Hold down the SHIFT key and press the 
ARROW keys. 

 Select specific unit. Choose one of the following items from 
the Edit/Select submenu: Word, sentence, paragraph, line, 
and entire document. 

 Mark method. 

4. The Paragraph submenu options include: align left, align center, 
align right, justify, increase indent, and decrease indent. 

5. If you select more from the Font submenu you launch a Font 
dialog box. From here you can select a different font type, font 
style, font size, and font effect. 

Inserting Text 

These two items can be found in the Insert Menu. To select a format for 
the Date/Time Stamp, go to the Tools Menu and select Options.  

 Insert File Text: Lets you grab the text from another file and paste it 
into your FSEdit document. 

 Date/Time Stamp: Lets you insert the date in the format you have 
chosen from the Options dialog box. (F12 or ALT+I, D) 

Checking Spelling 

You can check the spelling of a specific word, or of all the words in a 
document. If a word is spelled correctly, but not recognized, you can add 
the word(s) to FSEdit’s online dictionary. To launch the Spell Checker 
dialog box, press F8. If you have selected one or more words, when you 
begin the spell check, selected text is checked first. When finished, you 
will be asked if you want to continue checking the rest of the document. 
Selecting Yes will continue with the spell check while selecting No will 
return you to the document. 
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Once the Spell Checker dialog box opens, your cursor is in the Change 
To field on a word from the Suggestions List. At this point, you have 
several options to choose from. Use the TAB key to navigate this dialog 
box and press ENTER on the button that performs the particular action 
you want. The following controls are available: 

 Change To: By default, this edit field contains the suggestion that is 
the most likely replacement for the misspelled word. If you know the 
correct spelling, you can press BACKSPACE to clear this field and 
type the word you want.  

 Suggestions: This list box offers a list of suggested replacement 
words for the misspelled word. Use the UP or DOWN ARROW keys to 
select the word you want.  

 Change: Activating this button causes the current misspelled word to 
be replaced with the word you selected from the Suggestions list or 
entered into the Change To field.  

 Change All:  Activating this button causes all occurrences of the 
misspelled word to be replaced in the document.  

 Ignore: Activating this button causes the selected misspelled word to 
be skipped. If the same word is encountered later in the document, it 
will be displayed again.  

 Ignore All: Activating this button causes every occurrence of the 
selected misspelled word to be skipped.  

 Add: Activate this button to add the word to the user dictionary. Select 
Add if you are sure the word is spelled correctly so it will be 
considered correct in future spell checks.  

 Close:  Activate this button to close the spell checker and return to 
your document. You only need to use this button if you need to stop 
the spell check before it reaches the end of the document.  

Note:  Press INSERT+C while in the Spell Checker to have the PAC 
Mate Omni read the line containing the misspelled word so you 
can hear it in context. 
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Editing the User Dictionary 

Use the User Dictionary to store words that are not recognized by the 
Spell Checker, but that you know to be spelled correctly. To modify the 
dictionary, press ALT, T, navigate to Edit User Dictionary, and press 
ENTER. When this dialog box opens, the cursor is placed in the list of 
words. Press TAB to move through the controls in this dialog box. 

To add a word, select Add. Type the word into the edit field and press 
ENTER to add it. New words are appended to the end of the list. To sort 
the list in alphabetical order, choose Pre-sort. 

To edit the spelling of a word already in the dictionary, use the arrow keys 
to select the word and then choose Edit. Enter your changes and press 
ENTER. 

To remove a word from the dictionary, use the arrow keys to select it from 
the list and then choose Remove. 

Select Close when you are finished editing the dictionary. 

Word Count  

When you want to know the number of words in a document, press ALT, 
move to Tools and press ENTER. Then move to and press ENTER on 
Word Count  

Cursor Position  

The Cursor Position feature lets you hear the current location of the 
cursor by its line and column position relative to the total number of lines 
in the document.  

To find the cursor’s position, use the CTRL+SHIFT+W keystroke.  

The PAC Mate Omni reports the current line number out of the total 
number of lines in the document. It also lists the cursor’s column position. 
For example, you may hear the cursor’s position reported as line 11 out 
of 19, column 6.  
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Move Cursor Position  

The Move Cursor Position feature allows you to move the cursor forward 
or backward in a document based on character, line, or word position.  

To move the cursor, type CTRL+SHIFT+G X Y,  
where X is a negative number, indicating how far back the cursor will 
move, or a positive number, indicating how far forward the cursor will 
move, and Y is the letter C for character, L for line, and W for word, which 
indicates the type of cursor movement.  
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FSCalc 

FSCalc is a scientific, engineering, and financial calculator. The calculator 
includes functions for statistics, metric conversions and physical 
properties and constants.  

Note: When using FSCalc, the PAC Mate Omni speaks and displays 
results one line at a time. For example, when you press ENTER to 
calculate a mathematical operation, your PAC Mate Omni speaks 
and displays the result. FSCalc clears the previous value that 
appeared on the line and replaces it with the new result.  
 
To review the history of how you derived the result, use the UP 
ARROW key to scroll backwards to previous lines, and use the 
DOWN ARROW key to scroll forward and return to the current 
line. If you are using a refreshable braille display, you can pan left 
and right within a line using the display’s Whiz Wheels®. 
However, you cannot use the Whiz Wheels to pan from one line to 
another or for Sentence mode or Paragraph mode. 

Entering Equations and Expressions 

You can choose to enter an equation or expression using the menu 
(ALT) or by typing it with the keyboard. Anytime you solve an equation or 
expression, you must follow conventional math rules such as the order of 
operations. 

 Parenthesis and Brackets: Simplify the inside of parenthesis and 
brackets before you deal with the exponent (if any) of the parenthesis 
or remove the parenthesis. 

 Exponents: Simplify the exponent of a number or of a parenthesis 
before you multiply, divide, add, or subtract it. 

 Multiplication and Division: Simplify multiplication and division in the 
order they appear from left to right.  

 Addition and Subtraction: Simplify addition and subtraction in the 
order they appear from left to right. 



 

 165 

Variables can be any combination of letters (a-z) and digits (0-9). 
Standard operations are entered in the form a+b, with no spaces. For 
example, x=7, y=9, x+y, f+10. 

Operators modify the value stored in a variable. 

Expressions are any combinations of numbers, variables, operators and 
functions.  

Functions consist of a name followed by a comma-separated list of 
arguments enclosed in parentheses. If you choose to type the function 
instead of selecting it from the menus, be sure that you type it without 
spaces. 

Once you have entered the equation or expression, press ENTER for the 
result. 

If you select a function from the Functions Menu, anything selected on 
the current line is treated as an argument, i.e., placed in parentheses. 

When you press ENTER to calculate an operation, the PAC Mate Omni 
speaks and selects the result. If you type a new number or entry, it 
replaces the result with the new entry. If you type an operator, the result 
becomes part of the new operation and the insertion point is placed at the 
end of the operation, ready for you to finish your calculation. 

Reviewing the History 

Once you have entered a calculation(s) you can sequentially review the 
steps taken or the equations entered by pressing the UP ARROW to 
move backward or DOWN ARROW to move forward. 
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Saving the Calculation 

At anytime, while working through a calculation, you can save your work 
as a .txt file. Press CTRL+S to save the file in the current folder with the 
current name in the current location or open the File Menu and select 
Save As. Type a new file name, use TAB to move to the Folder combo 
box, and press the down arrow to select a folder. Press TAB again to 
move to the Location combo box and press the down arrow to select a 
location.  

Clearing the Calculator 

With FSCalc you can clear three items in the calculator: clear current line 
(ALT+S, C), clear the history (ALT+S, H), or clear the variables (ALT+S, 
V). You can find these three items in the Edit Menu as well. 

Arithmetic Examples 

Algebra Question: Simplify the following expression 2+(3-1)*3^2.  

 Following the order of operations, simplify the term inside the 
parenthesis first. In the edit window of FSCalc, type 3-1, then press 
ENTER. 

 Next, type p w r ( 3,2 ) or press ALT, F, ENTER to open the Functions 
Menu, then press ENTER on the Trig submenu and select Pwr. Pwr(2) 
will show automatically in the edit window so all you need to do is 
press the LEFT ARROW twice and type 3,. When you are done, press 
ENTER. 

 The next order of operations to solve for is the answer from step 2 
multiplied by the answer from step 1, which is (2)*9. To do this, press * 
and type the answer "2." (If you cannot remember the answer from 
step 1, you can use UP ARROW to review each step taken in this 
expression. Use the DOWN ARROW to move to the last answer, 
which was 9.) When you are done, press ENTER. 

 The last step to simplifying this expression is to add 2 to18. Press + so 
expression now becomes 18+ and type 2, ENTER. (Answer = 20) 

 Review the calculations for any errors by pressing the UP ARROW.  
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 Press ALT, F, ENTER and choose Save As to name and save this 
calculation as a .txt file.  

 Press ALT+S, H to clear the history. 

Arithmetic Question: You are shopping for a new desktop computer and 
have found one for $875.00. The computer store salesman tells you that 
the special going on is 35% off all computers storewide. How much is the 
computer you picked out? 

 In the edit window type 875*35%. 

 When you are done press ENTER.  

 Now, subtract $306.25 from $875.00 (Answer = $568.75) 

Volatile and Non-Volatile Memory 

FSCalc supports up to 32 non-volatile, or permanent, memory locations 
and 200 volatile, or erasable, memory locations.  

The following applies to FSCalc's non-volatile memory: 

Non-volatile memory locations are labeled as m00 through m31.  

To assign a value to a specific memory location, type the memory location 
and give it a value. For example, to assign m00 a value of 10, type m00=10 
and press ENTER. The value 10 appears.  

To recall a value, enter the memory location and press ENTER. The 
memory location's value appears. For example, if you type m00 and press 
ENTER, the value 10 appears.  

To use a memory location, just insert it into an equation. For example, type 
20+m00 and press ENTER, the value 30 appears.  

FSCalc always saves the result of the last calculation under the variable 
name LR. For example, the result of the last calculation (20+m00) is 30. If 
you type 10+lr and press ENTER, the result is 40, which is also the new 
value of lr.  
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Since non-volatile memory is retained when the PAC Mate Omni is turned 
off, use the clear permanent memory function to erase all non-volatile 
memory locations. For example, from the General menu, select the Memory 
submenu, and then select ClearPermMem. Press ENTER and when asked if 
you want to clear the permanent memory locations, select OK. All non-
volatile memory locations now have the value of 0.  

You can also use the Clear All Memory function to erase all non-volatile and 
volatile memory locations.  

The following applies to FSCalc's volatile memory locations. 

FSCalc has 200 volatile memory locations. An error message appears if you 
try to exceed this limit.  

Memory location names, or variables, are user defined, and must begin with 
a letter followed by any combination of letters and numbers. Examples of 
valid names are B, ab123, x, train1, and so on.  

Memory location names are not case sensitive. Therefore, train1, TRAIN1, 
and trAin1 are valid names that refer to the same memory location.  

To assign a memory location a value, type the memory location and give it a 
value. For example, type train1=47 and press ENTER. The variable train1 is 
47.  

To recall a value, enter the memory location and press ENTER. The 
memory location's value appears. For example, if you type train1 and press 
ENTER, the value 47 appears.  

To use a memory location, just insert it into the equation. For example, type 
3+train1 and press ENTER. The value 50 appears.  

To clear volatile memory locations, use the clear volatile memory function. 
For example, from the General menu, select the Memory submenu, and 
then select ClearVolatMem. Press ENTER and when asked if you want to 
clear the volatile memory locations, select OK.  

FSCalc always saves the result of the last calculation under the variable 
name LR. For example, the result of the last calculation (3+train1) is 50. If 
you type 10+lr and press ENTER, the result is 60, which is also the new 
value of lr.  



 

 169 

Volatile memory locations are not permanent and are erased when FSCalc 
is closed.  

Conversion Example 

Conversion Question: The winter of 2002-2003 is reputed to be one of 
the coldest winters on record. To substantiate this your friends from 
Syracuse, New York call to tell you that the temperature outside is -25 
degrees Celsius and the wind is blowing at 10 miles per hour. What is the 
temperature in Fahrenheit and the wind chill factor? 

1. Press ALT, F, ENTER. From the Functions Menu select and 
press ENTER on Conversions. In the submenu select and press 
ENTER on Celsius to Fahrenheit. 

2. Type -25 and ENTER. (Answer = -13 degrees Fahrenheit) 

3. Next, go back into the Conversions submenu and press ENTER 
on Wind Chill. The edit window now has wc(-13). 

4. Press RIGHT ARROW once to move inside the parentheses and 
type ,10 and press ENTER. (Wind Chill = -37.2555 degrees 
Fahrenheit) 

Statistical Example 

Statistical Question: Find the average, standard deviation and sum from 
the following data. Data Set (6,8,9,10,2) 

1. Type a v g ( 6,8,9,10,2 ) and press ENTER. Or press ALT, F, 
ENTER. With the Functions Menu opened move to the Stat 
submenu and press ENTER. Press ENTER again on Avg. Now 
type 6,8,9,10,2 and press ENTER. (Answer = 7) 

2. Use the UP ARROW and SHIFT+HOME, CTRL+C to move, 
select and copy (6,8,9,10,2). Press the DOWN ARROW once 
and BACKSPACE over the 7, then paste the selected text. 
Move to the beginning of the line with the HOME Key and type s 
t d d e v. When you are done press ENTER. (Answer = 2.82843) 
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3. Clear the current line, 2.82843, with ALT+S, C. Press CTRL+V 
and HOME to paste the selected text that is still on the clipboard 
and move to the beginning of the line. Type s u m and press 
ENTER. (Answer = 35) 

Financial Examples 

Financial Question: Your financial advisor is recommending that you 
invest $5000.00 in a particular fund for 10 years. He says that the annual 
rate of return is 7.18%. In order to make an informed decision, you need 
to find out how much your money would be worth in 10 years. 

To solve this problem you need to have some knowledge of the 
relationship between the rate of interest (r), time (t), the present value 
(pv) and the future value (fv) of the dollar. The relationship is as follows: 

fv=pv*(1+r/n)^nt 

pv = 5000 r = 0.0718 n = 1 t = 10 years fv = ? 

To help with the concept, open Notes and take the variables above and 
plug them into the formula: fv = 5000*(1+.0718/1)^(1)(10). You can solve 
this problem using the order of operations or you can use the financial 
functions in FSCalc. 

Using the order of operations: 

1. Solve 1+.0718 first.  

2. Press ALT, F, ENTER to open the Functions Menu. From the 
Trig Menu select and press ENTER on Pwr.  

3. The edit window now reflects the following: pwr(1.0718). 
Because the cursor is outside the parentheses, you need to 
press the RIGHT ARROW once and finish the function by 
pressing ,10 and ENTER. (Answer = 2.0005) 

4. Last, solve for fv by multiplying the future value factor, (1+r/n)^nt 
= 2.0005, and the present value = $5000.00. (Answer = $10,000) 

Using FSCalc: 
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Note: When using the financial functions of FSCalc, you must list your 
known variables in the following order: fv(r,n,t,pv), pv(r,n,t,fv), 
pmt(r,n,t,pv), loan(r,n,t,pmt), install(r,n,t,pv)and rate(n,pv,fv). 
Where: 
pv = the present value or initial value 
fv = the future value 
r = the annual interest rate 
t = time 
n = number of compound periods in a year 

1. First clear the history with ALT+S, H. 

2. Press ALT, F, ENTER. From the Functions Menu, open the 
financial submenu and press ENTER on fv. 

3. The edit window now has fv(). Inside the parentheses, type 
.0718,1,10,5000. When you are done press ENTER. (Answer = 
$10,0002.5) 

Financial Question: You are interested in buying a home. You want to 
know what your monthly payment will be if you take a 15 year bank note 
for $120,000 at rate of 4.75% compounded monthly. 

Using Notes, list your known variables.  

pmt = ? r = .0475 n = 12 t = 15 pv = 120,000 

1. Press ALT, F, ENTER. From the Functions Menu, open the 
financial submenu and press ENTER on payment. 

2. The edit window now has pmt(). Inside the parentheses, type 
.0475,12,15,120000. When you are done press ENTER. 
(Answer = $933.52) 

Financial Question: You are concerned about your retirement. You want 
to know how much you have to invest today in order to accumulate $1 
million dollars by the time you are ready to retire. You have found an 
annuity that is paying 10% return compounded monthly. You figure that 
you will retire in about 35 years.  

Using Notes, list your known variables. 
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fv = $1 million r = 0.10 n = 12 t = 35 years pv = ? 

1. Press ALT, F, ENTER. From the Functions Menu, open the 
financial submenu and press ENTER on pv. 

2. The edit window now has pv(). Inside the parentheses, type 
.10,12,35,1000000. When you are done press ENTER. (Answer 
= $30,637.25) 

In the above question, how much money do you have to deposit each 
month if the annuity is compounded bi monthly? 

In Notes reevaluate your variables. The rate is reconfigured because it is 
compounded bimonthly. If the rate is compounded quarterly you would 
use 4. 

fv = $1 million pv = $30,637.25 r = .10 n = 24 t = 35  

1. Press ALT+S, C to clear the line and then press ALT, F, 
ENTER. From the Functions Menu, open the financial submenu 
and press ENTER on installment. 

2. The edit window now has install(). Inside the parentheses, type 
.10,24,35,1000000. When you are done press ENTER. (Answer 
= $130.72) 

Financial Question: You need to take out a 5 year loan for some small 
home improvements. According to your budget you can afford to spend 
$50.00 monthly to pay back the loan. Bank rates on a 5 year loan are 6% 
compounded monthly. Given these parameters how much money can 
you borrow? 

Using Notes, list your known variables. 

loan = ? r = .06 n = 12 t = 5 pmt = 50 

1. Press ALT, F, ENTER. From the Functions Menu, open the 
financial submenu and press ENTER on loan. 
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2. The edit window now has loan(). Inside the parentheses, type 
.06,12,5,50. When you are done press ENTER. (Answer = 
$2586.28) 

Financial Question: You receive quarterly statements from your mutual 
fund company on your IRA. As you watch your fund's performance you 
wonder what the rate of return is on your IRA. Your initial investment two 
years ago was $2000.00 and your most recent statement shows a 
balance of $3829.52. The IRA is compounded daily. 

Using Notes, list your known variables. 

rate = ? pv = $2000.00 fv = $3829.52 n = 365 

1. Press ALT, F, ENTER. From the Functions Menu, open the 
financial submenu and press ENTER on rate. 

2. The edit window now has rate(). Inside the parentheses, type 
365,2000,3829.52. When you are done press ENTER. (Answer 
= .00178 x 100 = .178%) 

Operator and Function Tables 

The following tables describe the following FSCalc functions: 

 Operators 

 General Functions – Display 

 General Functions – Memory  

 Trigonometric Functions 

 Hyperbolic Functions 

 Math Functions 

 Statistical Functions 



 

174 

 Base Conversion Functions 

 Conversion Functions 

 Financial Functions 

Operators 

Name Symbol 

Addition +  

Subtraction -  

Multiplication *  

Division /  

Percentage %  

Assignment =  

General Functions - Display 

Function Menu Function Description 

setNoPrecis() No Fixed Precision 

Sets the display to 
decimal, but with no 
required fixed decimal 
length. For example, the 
integer 3 appears as 3. 
The square root of 3 
appears as 1.732051.  
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Function Menu Function Description 

decfract() Decimal/Fraction 
Toggles between Decimal 
and Fraction mode. Hot 
key = CTRL+SHIFT+F. 

decSciNot() Decimal/SciNotation 
Toggles between Decimal 
and Scientific Notation 
mode.  

setPrecis(n)  

  

where n is the 
number of 
decimal places 

SetPrecision 

Sets the fixed decimal 
precision. All numbers 
show up with a decimal 
portion. For example, if 
precision is set to 5, the 
integer 3 appears as 
3.00000. The square root 
of 3 appears as 1.73205.  

General Functions - Memory  

Function Menu Function Description 

clrAllMem() ClearAllMem 

Clears all previously 
defined memory locations 
including the permanent 
memory locations. Hot key 
= CTRL+SHIFT+A. 

clrPermMem() ClearPermMem 

Clears only the permanent 
memory locations (memory 
locations 00 to 31 - m00 to 
m31). Hot key = 
CTRL+SHIFT+P. 
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Function Menu Function Description 

clrVolatMem() ClearVolatMem 
Clears only the volatile 
memory locations. Hot key 
= CTRL+SHIFT+V. 

dumpCalcMem() DumpCalcMem 

When selected, this option 
creates a text file containing 
a snapshot of all the non-
zero permanent memory 
locations and all the volatile 
memory locations. Hot key 
= CTRL+SHIFT+D.  

Trigonometric Functions  

This table shows FSCalc's trigonometric functions. The first column 
shows the function as an equation. The second column shows the 
function as it appears on the menu. The third column describes the 
function. Following the table are examples using the function in an 
equation. 

Function Menu Function Description 

raddeg()  Toggle 
Rad/Degrees  

Toggles from radians to 
degrees. Hot key = 
CTRL+SHIFT+R.  

Example One:  

Press CTRL+SHIFT+R to toggle the input type to radians. Then type 
sin(pi), and press ENTER. The answer is 0.  

Example Two: 

Type acos(4/5), then press ENTER. The answer is 0.643501 radians.  
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Example Three: 

Press CTRL+SHIFT+R to toggle the output to degrees. Type acos(4/5), 
then press ENTER. The answer is 36.86898 degrees.   

Function Menu Function Description 

acos(n)  ArcCosine  Calculates the arccosine of 
variable 'n'.  

Example One:  

Make sure the output type is set to degrees. Type angle1=acos(4/5), then 
press ENTER. The answer is 36.869898.  

Example Two: 

Type angle2=acos(3/5), then press ENTER. The answer is 53.130102.  

Example Three: 

Now type angle1+angle 2 and press ENTER. The answer is 90.   

Function Menu Function Description 

asin(n)  ArcSine  Calculates the arcsine of 
variable 'n'.  

Example One:  

Make sure the output type is set to degrees. Type angle1=asin(3/5), then 
press ENTER. The answer is 36.869898.  

Example Two: 

Type angle2=asin(4/5), then press ENTER. The answer is 53.130102.  
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Example Three: 

Now type angle1+angle 2 and press ENTER. The answer is 90.   

Function Menu Function Description 

atan(n)  ArcTangent  Calculates the arctangent 
of variable 'n'.  

Example One:  

Make sure the output type is set to degrees. Type angle1=atan(3/4), then 
press ENTER. The answer is 36.869898.  

Example Two: 

Type angle2=atan(4/3), then press ENTER. The answer is 53.130102.  

Example Three: 

Now type angle1+angle 2 and press ENTER. The answer is 90.   

Function Menu Function Description 

atan2(y,x)  Atan2  Calculates the arctangent 
of y/x.  

Example One:  

Make sure the output type is set to degrees. Type angle1=atan2(3,4), 
then press ENTER. The answer is 36.869898.  

Example Two: 

Type angle2=atan2(4,3), then press ENTER. The answer is 53.130102.  
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Example Three: 

Now type angle1+angle 2 and press ENTER. The answer is 90.   

Function Menu Function Description 

cos(n)  Cosine  Calculates the cosine of 
'n'.  

Example One:  

Toggle the input to radians. Type cos(pi/4), and press ENTER. The 
answer is 0.707107.  

Example Two: 

Toggle the input to degrees. Type cos(45), and press ENTER. The 
answer is 0.707107.   

Example Three: 

Type cos(90) and press ENTER. The answer is 0.   

Function Menu Function Description 

cot(n)  Cotangent  Calculates the cotangent of 
'n'.  

Example One:  

Toggle the input to radians. Type cot(pi/4), and press ENTER. The 
answer is 1.  

Example Two: 

Toggle the input to degrees. Type cot(45), and press ENTER. The 
answer is 1.  
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Example Three: 

Type cot(90) and press ENTER. The answer is 0.   

Function Menu Function Description 

deg2rad(n)  Degrees to Radians  Converts the variable 'n' 
from degrees to radians.  

Example One:  

Type deg2rad(45) and press ENTER. The answer is 0.785398.  

Example Two: 

Type deg2rad(90) and press ENTER. The answer is 1.570796.  

Example Three: 

Type deg2rad(180) and press ENTER. The answer is 3.141593.   

Function Menu Function Description 

rad2deg(n)  Radians Degrees  Converts the variable 'n' 
from radians to degrees.  

Example One:  

Type rad2deg(pi/4) and press ENTER. The answer is 45.  

Example Two: 

Type rad2deg(pi/2) and press ENTER. The answer is 90.  

Example Three: 

Type rad2deg(pi) and press ENTER. The answer is 180.   
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Function Menu Function Description 

sin(n)  Sine  Calculates the sine of 'n'.  

Example One:  

Toggle the input to radians. Type sin(pi/4), and press ENTER. The 
answer is 0.707107.  

Example Two: 

Toggle the input to degrees. Type sin(45), and press ENTER. The 
answer is 0.707107.  

Example Three: 

Type sin(90) and press ENTER. The answer is 1.   

Function Menu Function Description 

tan(n)  Tangent  Calculates the tangent 
of 'n'.  

Example One:  

Toggle the input to radians. Type tan(pi/4), and press ENTER. The 
answer is 1.  

Example Two: 

Toggle the input to degrees. Type tan(45), and press ENTER. The 
answer is 1.  

Example Three: 

Type tan(90) and press ENTER. The answer is undefined.  

Function Menu Function Description 
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Function Menu Function Description 

fmod(n1,n2) Fmod 
Calculates the floating 
point modulus of 
n1%n2. 

Example One:  

Type fmod(13,2), then press ENTER. The answer is 1. 

Example Two: 

Type fmod(13.1,2), then press ENTER. The answer is 1.1. 

Example Three: 

Type fmod(14.14,7), then press ENTER. The answer is 0.14. 

Function Menu Function Description 

log(n) NaturalLog 
Calculates the natural 
logarithm of 'n'.  

Example One:   

Type log(1), then press ENTER. The answer is 0. 

Example Two:   

Type log(.01), then press ENTER. The answer is -4.65107. 

Example Three:   

Type log(100), then press ENTER. The answer is 4.65107. 
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Hyperbolic Functions  

This table shows FSCalc's trigonometric hyperbolic functions. The first 
column shows the function as an equation. The second column shows 
the function as it appears on the menu. The third column describes the 
function. Following the table are examples using the function in an 
equation. 

Function Menu Function Description 

cosh(n) HyperbolicCosine 
Calculates the hyperbolic 
cosine of 'n'. 

Example One:  

Type cosh(0), then press ENTER. The answer is 1.  

Example Two: 

Type cosh(10), and press ENTER. The answer is 11013.23292.  

Example Three: 

Type cosh(5), then press ENTER. The answer is 74.209949.  

Function Menu Function Description 

sinh(n) HyperbolicSine 
Calculates the hyperbolic 
sine of 'n'. 

Example One:  

Type sinh(0), then press ENTER. The answer is 0. 
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Example Two: 

Type sinh(10), and press ENTER. The answer is 11013.232875. 

Example Three: 

Type sinh(5), then press ENTER. The answer is 74.203211. 

Function Menu Function Description 

tanh(n) HyperbolicTangent 
Calculates the hyperbolic 
tangent of 'n'. 

Example One:  

Type tanh(0), then press ENTER. The answer is 0. 

Example Two: 

Type tanh(10), and press ENTER. The answer is 1. 

Example Three: 

Type tanh(5), then press ENTER. The answer is .999909. 

Math Functions  

This table shows FSCalc's math functions. The first column shows the 
function as an equation. The second column shows the function as it 
appears on the menu. The third column describes the function. Following 
the table are examples using the function in an equation. 

Function Menu Function Description 

fabs(n) Abs 
Finds the absolute value of 
'n'. 

Example One:  

Type fabs(-14.14), then press ENTER. The answer is 14.14. 



 

 185 

Example Two: 

Type fabs(14), then press ENTER. The answer is 14. 

Example Three: 

Type fabs(-1114), then press ENTER. The answer is 1114. 

Function Menu Function Description 

avg(n1, ..., nx) Avg 
Finds the average of n1 
through nx. 

Example One:  

Type avg(1,2,3), then press ENTER. The answer is 2. 

Example Two: 

Type avg(3,2,1,1,2,3), then press ENTER. The answer is 2. 

Example Three: 

Type avg(14,14,14), then press ENTER. The answer is 14. 

Function Menu Function Description 

div(n1,n2) Div 
Performs whole number 
division on n1/n2.  

Example One:  

Type div(3,4), then press ENTER. The answer is 0. 

Example Two: 

Type div(5,4), then press ENTER. The answer is 1. 
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Example Three: 

Type div(10,4), then press ENTER. The answer is 2. 

Function Menu Function Description 

exp(n) Exp Calculates e to the n power. 

Example One:  

Type exp(1), then press ENTER. The answer is 2.71282. 

Example Two: 

Type exp(2), then press ENTER. The answer is 7.389056. 

Example Three: 

Type exp(3), then press ENTER. The answer is 20.085537. 

Function Menu Function Description 

fact(n) Factorial 
Calculates 1*2*3*...*n. By 
convention, fact(0) equals 1. 

Example One:  

Type fact(5)=5*4*3*2*1. The answer is 120. 

Example Two: 

Type fact(6), then press ENTER. The answer is 720. 

Example Three: 

Type fact(3), then press ENTER. The answer is 6. 
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Function Menu Function Description 

log10(n) Log10 
Calculates the base 10 log 
of 'n'. 

Example One:  

Type log10(10), then press ENTER. The answer is 1. 

Example Two: 

Type log10(1000), then press ENTER. The answer is 3. 

Example Three: 

Type log10(100000000), then press ENTER. The answer is 8. 

Function Menu Function Description 

pwr(n1,n2) Pwr 
Calculates n1 to the power 
of n2. 

Example One:   

Type pwr(2,3), then press ENTER. The answer is 8. 

Example Two:   

Type pwr(3,2), then press ENTER. The answer is 9. 

Example Three:   

Type pwr(16,2), then press ENTER. The answer is 256. 

Function Menu Function Description 

recip(n) Recip 
Computes the reciprocal of 
'n'.  
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Example One:   

Type recip(2) and press ENTER. The answer is .5. 

Example Two: 

Type recip(5) and press ENTER. The answer is .2.  

Example Three: 

Type recip(10) and press ENTER. The answer is .1.   

Function Menu Function Description 

myRand() Random 
Generates a number 
between 0 and 1.  

Example One:   

Type myrand(), then press ENTER. A random number between 0 and 1 
will be displayed. 

Function Menu Function Description 

root(n1,n2) Root Computes the n2 root of n1. 

Example One:   

Type root(8,3), then press ENTER. The answer is 2. 

Example Two:   

Type root(16,2), then press ENTER. The answer is 4. 

Example Three: 

Type root(24,3), then press ENTER. The answer is 2.884499.   

Function Menu Function Description 
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Function Menu Function Description 

round(n) Round 
Rounds 'n' off to the nearest 
whole number.  

Example One:   

Type round(1.732501), and press ENTER. The answer is 2. 

Example Two:   

Type round(1.49999), and press ENTER. The answer is 1.  

Example Three:   

Type round(.9), then press ENTER. The answer is 1.  

Function Menu Function Description 

sqrt(n) Sqrt 
Computes the square root 
of 'n'.  

Example One:   

Type sqrt(16), then press ENTER. The answer is 4. 

Example Two:   

Type sqrt(4), then press ENTER. The answer is 2. 

Example Three:   

Type sqrt(256), then press ENTER. The answer is 16. 

Function Menu Function Description 

trunc(n) Trunc 
Truncates 'n' down to the 
next integer.  

Example One:   
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Type trunc(1.732501), and press ENTER. The answer is 1. 

Example Two:   

Type trunc(1.49999), and press ENTER. The answer is 1.  

Example Three:   

Type trunc(.9), then press ENTER. The answer is 0.  

Statistical Functions  

This table shows FSCalc's statistical functions. The first column shows 
the function as an equation. The second column shows the function as it 
appears on the menu. The third column describes the function. Following 
the table are examples using the function in an equation. 

Function Menu Function Description 

avg(n1, ..., nx) Avg 
Calculates the average of 
n1 through nx. 

Example One:   

Type avg(1,2,3,4,5), then press ENTER. The answer is 3. 

Example Two:   

Type avg(2,4,3,1,5), then press ENTER. The answer is 3. 

Example Three:   

Type avg(-100,-10,1,3,5), then press ENTER. The answer is -20.2. 

Function Menu Function Description 

max(n1, ..., nx) Max 
Calculates the maximum 
value of n1 through nx. 

Example One:   
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Type max(1,2,3,4,5), then press ENTER. The answer is 5. 

Example Two:   

Type max(2,4,3,1,5), then press ENTER. The answer is 5. 

Example Three:   

Type max(-100,-10,1,3,5), then press ENTER. The answer is 5. 

Function Menu Function Description 

median(n1, ..., nx) Median 
Calculates the median value 
of n1 through nx. 

Example One:   

Type median(1,2,3,4,5), then press ENTER. The answer is 3. 

Example Two:   

Type median(2,4,3,1,5), then press ENTER. The answer is 3. 

Example Three:   

Type median(-100,-10,1,3,5), then press ENTER. The answer is 1. 

Function Menu Function Description 

min(n1, ..., nx) Min 
Calculates the minimum 
value of n1 through nx.  

Example One:   

Type min(1,2,3,4,5), then press ENTER. The answer is 1. 

Example Two:   

Type min(2,4,3,1,5), then press ENTER. The answer is 1. 

Example Three:   
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Type min(-100,-10,1,3,5), then press ENTER. The answer is -100. 

Function Menu Function Description 

stddev(n1, ..., nx) Std Deviation 
Calculates the standard 
deviation of n1 through nx. 

Example One:   

Type stddev(1,2,3,4,5), then press ENTER. The answer is 1.414214. 

Example Two:   

Type stddev(2,4,3,1,5), then press ENTER. The answer is 1.414214. 

Example Three:   

Type stddev(-100,-10,1,3,5), then press ENTER. The answer is 
40.236302. 

Function Menu Function Description 

sum(n1, ..., nx) Sum 
Calculates the sum of n1 
through nx. 

Example One:   

Type sum(1,2,3,4,5), then press ENTER. The answer is 15. 

Example Two:   

Type sum(2,4,3,1,5), then press ENTER. The answer is 15. 

Example Three:   

Type sum(-100,-10,1,3,5), then press ENTER. The answer is -101. 
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Base Conversions  

This table shows FSCalc's base conversion functions. The first column 
shows the function as an equation. The second column shows the 
function as it appears on the menu. The third column describes the 
function. Following the table are examples using the function in an 
equation. 

 

Function Menu Function Description 

D2h(n) Dec to Hex 
Converts 'n' from decimal to 
hexadecimal. 

Example One:   

Type d2h(14), then press ENTER. The answer is 'E'. 

Example Two:   

Type d2h(255), then press ENTER. The answer is 'FF'. 

Example Three:   

Type d2h(256), then press ENTER. The answer is 100. 

Function Menu Function Description 

d2o(n) Dec to Oct 
Converts 'n' from decimal to 
octal. 

Example One:   

Type d2o(14), then press ENTER. The answer is ''16. 

Example Two:   

Type d2o(255), then press ENTER. The answer is 377. 
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Example Three:   

Type d2o(256), then press ENTER. The answer is 400. 

Function Menu Function Description 

d2b(n) Dec to Bin 
Converts 'n' from decimal to 
binary. 

Example One:   

Type d2b(14), then press ENTER. The answer is ''1110. 

Example Two:   

Type d2b(255), then press ENTER. The answer is 11111111. 

Example Three:   

Type d2b(256), then press ENTER. The answer is 100000000. 

Function Menu Function Description 

h2d(n) Hex to Dec 
Converts 'n' from 
hexadecimal to decimal.  

Example One:   

Type h2d(14), then press ENTER. The answer is ''20. 

Example Two:   

Type h2d(255), then press ENTER. The answer is 597. 

Example Three:   

Type h2d(1ab), then press ENTER. The answer is 427. 

Function Menu Function Description 
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Function Menu Function Description 

o2d(n) Oct to Dec 
Converts 'n' from octal to 
decimal.  

Example One:   

Type o2d(14), then press ENTER. The answer is ''12. 

Example Two:   

Type o2d(255), then press ENTER. The answer is 173. 

Example Three:   

Type o2d(1234), then press ENTER. The answer is 668. 

Function Menu Function Description 

b2d(n) Bin to Dec 
Converts 'n' from binary to 
decimal.  

Example One:   

Type b2d(1111), then press ENTER. The answer is ''15. 

Example Two:   

Type b2d(1010101), then press ENTER. The answer is 85. 

Example Three:   

Type b2d(100100100), then press ENTER. The answer is 292. 

Conversion Functions  

This table shows FSCalc's conversion functions. The first column shows 
the function as an equation. The second column shows the function as it 
appears on the menu. The third column describes the function. Following 
the table is an example using the function in an equation. 
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Function Menu Function Description 

cel2fahr(n) Cels to Fahr 
Converts temperature 'n' 
from Celsius to Fahrenheit. 

Example One:   

Type cel2fahr(22), then press ENTER. The answer is 71.6. 

Function Menu Function Description 

fahr2cel(n) Fahr to Cels 
Converts temperature 'n' 
from Fahrenheit to Celsius. 

Example One:   

Type fahr2cel(71.6), then press ENTER. The answer is 22.  

Function Menu Function Description 

cm2in(n) Cms 
Converts 'n' from 
Centimeters to inches.  

Example One:   

Type cm2in(2.538071), then press ENTER. The answer is 1.  

Function Menu Function Description 

in2cm(n) Inches 
Converts 'n' from inches to 
centimeters. 

Example One:   

Type in2cm(1), then press ENTER. The answer is 2.538071. 
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Function Menu Function Description 

m2ft(n) Meter to Feet 
Converts 'n' from meters to 
feet. 

Example One:   

Type m2ft(1), then press ENTER. The answer is 3.28.  

Function Menu Function Description 

ft2m(n) Feet to Meter 
Converts 'n' from feet to 
meters. 

Example One:   

Type ft2m(3.28), then press ENTER. The answer is 1.  

Function Menu Function Description 

m2yd(n) Meters to Yards 
Converts 'n' from meters to 
yards. 

Example One:   

Type m2yd(1), then press ENTER. The answer is 1.096313. 

  

Function Menu Function Description 

yd2m(n) Yards to Meters  
Converts 'n' from yards to 
meters. 

Example One:   

Type yd2m(1), then press ENTER. The answer is 0.9144. 
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Function Menu Function Description 

km2miles(n) Kms to Miles 
Converts 'n' from kilometers 
to miles. 

Example One:   

Type km2miles(1), then press ENTER. The answer is .621. 

Function Menu Function Description 

miles2km(n) Mile to Kms 
Converts 'n' from miles to 
kilometers. 

Example One:   

Type miles2km(55), then press ENTER. The answer is 88.495.  

Function Menu Function Description 

gal2lt(n) Gal to Ltr 
Converts 'n' from gallons to 
liters. 

Example One:   

Type gal2lt(1), then press ENTER. The answer is 3.785.  

Function Menu Function Description 

lt2gal(n) Ltr to Gal 
Converts 'n' from liters to 
gallons. 

Example One:   

Type lt2gal(2), then press ENTER. The answer is .528. 
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Function Menu Function Description 

lb2kg(n) Lbs to Kgm 
Converts 'n' from pounds to 
kilograms. 

Example One:   

Type lb2kg(100), then press ENTER. The answer is 45.4.  

Function Menu Function Description 

kg2lb(n)  Kgm to Lbs  
Converts 'n' from kilograms 
to pounds. 

Example One:   

Type kg2lb(50), then press ENTER. The answer is 110.132159.  

Function Menu Function Description 

oz2gm(n) Ounce to Gram 
Converts 'n' from ounces to 
grams. 

Example One:   

Type oz2gm(1), then press ENTER. The answer is 28.35. 

Function Menu Function Description 

gm2oz(n) Gram to Ounce 
Converts 'n' from grams to 
ounces. 

Example One:   

Type gm2oz(100), then press ENTER. The answer is 3.57. 
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Function Menu Function Description 

wc(n1, n2) Wind Chill 

Calculates the wind chill 
factor when n1 equals the 
temperature in Fahrenheit 
and n2 equals the wind 
speed in miles per hour. 

Example One:   

Type wc(32,5), then press ENTER. The answer is 28.89. 

Financial Functions  

This table shows FSCalc's financial functions. The first column shows the 
function as an equation. The second column shows the function as it 
appears on the menu. The third column describes the function. Following 
the table is an example using the function in an equation. 

Function Menu Function Description 

PV (r, n, t, FV) Present Value 

Calculates the present value 
of dollars. There are 4 
variables: 'r' is the annual 
interest rate, 'n' is the 
number of compound 
periods in a year, 't' is the 
number of years, and 'fv' is 
the future value of the 
dollar. 

Example One:   

Determine the present value of an investment that is expected to yield 
10,000 dollars. The interest rate is 5 percent, compounded monthly over 
10 years. 
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Type pv(.05,12,10,10000), then press ENTER. The answer is 6071.61 
dollars. 

Function Menu Function Description 

FV (r, n, t, PV) Future Value 

Calculates the future value 
of dollars. There are 4 
variables: 'r' is the annual 
interest rate, 'n' is the 
number of compound 
periods in a year, 't' is the 
number of years, and 'pv' is 
the present value of the 
dollar. 

Example One:   

Calculate the future value of 6,000 dollars invested at 5 percent, 
compounded monthly over 10 years. 
Type fv(.05,12,10,6000), then press ENTER. The answer is 9882.06 
dollars. 

Function Menu Function Description 

PMT (r, n, t, PV) Payment 

Calculates the payment 
required to pay back a loan 
at a specific interest rate. 
There are 4 variables: 'r' is 
the annual interest rate, 'n' 
is the number of compound 
periods in a year, 't' is the 
number of years, and 'pv' is 
the amount of dollars 
borrowed. 



 

202 

Example One:   

Calculate the payment required to borrow 10,000 dollars at 5 percent 
compounded monthly for 10 years. 

Type pmt(.05,12,10,10000), then press ENTER. The answer is 106.07 
dollars.  

Function Menu Function Description 

LOAN (r, n, t, 
PMT) 

Loan 

Calculates the amount you 
can borrow using a fixed 
payment and interest rate. 
There are 4 variables: 'r' is 
the annual interest rate, 'n' 
is the number of compound 
periods in a year, 't' is the 
number of years, and 'pmt' 
is the payment amount. 

Example One:   

Calculate how much you could borrow for a 10 year loan at 6% interest 
and a monthly payment of 500 dollars. 
Type loan(.06,12,10,500), then press ENTER. The answer is 45036.73 
dollars. 
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Function Menu Function Description 

INSTALL (r, n, t, 
FV) 

Installment 

Calculates how many 
dollars you need to put 
away to end up with a future 
value, invested at a specific 
interest rate. There are 4 
variables: 'r' is the annual 
interest rate, 'n' is the 
number of compound 
periods in a year, 't' is the 
number of years, and 'fv' is 
the expected future value of 
the account. 

Example One:   

If you want to retire with 1 million dollars in 25 years, and your bank offers 
3.5 percent interest compounded monthly: 
Type install(.035, 12, 25, 1000000), then press ENTER. the amount you'd 
need to put away each month is 2089.57 dollars. 

Function Menu Function Description 

RATE (n, PV, FV) Rate 

Calculates the rate of return 
on a one year investment. 
There are 3 variables: 'n' is 
the number of compounds 
in 1 year, 'pv' is the present 
value of the investment, 'fv' 
is the expected future value 
of the investment. 
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Example One:   

You borrow 100 dollars from a friend. The friend says you need to pay 
him 120 dollars at the end of the year. What is the interest rate your 
friend is charging to loan you 100 dollars for one year? 
type rate(1, 100, 120), then press ENTER. the answer is 20 percent. 
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FSReader 

Freedom Scientific's basic training materials are now in a digital format 
called DAISY (Digital Accessible Information System) or DTB (Digital 
Talking Books). Because this training is in digital (or electronic) format, 
navigation between sections of a book or other digital documents is much 
easier than using audio cassettes. In previous JAWS basic training, you 
had to press the fast forward or rewind keys until you heard an audible 
"beep" which let you know you were at the beginning of the next section. 
With DAISY, navigation is much quicker. 

There are many kinds of DAISY books, ranging from audio only, like the 
books available from RFB&D, to text only, such as the books available 
from Bookshare.org. Full text and full audio offers the fullest and richest 
reading experience.  

Beginning with version 6.5, FSReader is built directly into PAC Mate 
Omni. It is no longer necessary to install a separate application in order to 
access DAISY material. To launch FSReader, open the Programs menu 
(WINDOWS Key, P), navigate to FSReader, and press ENTER. 

The FSReader User Interface 

The FSReader user interface has a title bar, a menu bar, and two panes. 
The top pane is a tree view for navigation, and the bottom pane contains 
the text of the book, if there is text available. In the tree view, you can 
navigate up and down the tree by using the UP and DOWN ARROW 
keys. To expand a chapter or topic, press RIGHT ARROW and to close a 
chapter or topic, press LEFT ARROW. To begin reading when there is 
text available, press the TAB key to move to the document pane and use 
the standard JAWS reading commands. To play narrated audio if it is 
available, press CTRL+P. You can press CTRL+P again to pause the 
audio if there is audio available. 

Opening a File in FSReader 
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To open a file in FSReader, press CTRL+O or choose Open from the 
FSReader File menu. FSReader searches through all the files on all 
storage media attached to your PAC Mate, including CompactFlash and 
USB storage, as well as internal Flash memory. It then displays the titles 
of any DAISY books that it finds. This feature makes it easy to select the 
book you want to read without searching through the many individual files 
that comprise a typical DAISY book. To open a book, use the ARROW 
keys to select it from the list and press ENTER. 

Exploring the Menus 

File Menu 

The File menu allows you to open a file or exit the program, as well as 
view a history of the last five books opened. Number one in the list is the 
most recently opened book. 

There is also an item in the File menu called "Add UAK." UAK stands for 
User Authorization Key. A user authorization key is what allows content 
providers to protect their materials, and select which individuals have 
access to it. In order to access protected content, you must have an 
authorization key. The content provider issues this key. To authorize 
FSReader to play the protected materials, choose "Add UAK..." from the 
file menu. The file open dialog box appears. Select the UAK file given to 
you by the distributor of the book and open it. From there, follow the on 
screen instructions. You may be asked to enter a validation code. This 
code will have been provided to you by the producer of the UAK file. 
Once the UAK file has been successfully processed, FSReader will be 
able to read the protected book. 

Audio Menu 

The Audio menu contains the following commands that allow you to 
control the playback of audio content: 

 Play/Pause (CTRL+P). 

 Stop (CTRL+S). 

 Rewind (COMMA). 
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 Fast Forward (PERIOD). 

 Rate submenu 

 Increase (CTRL+PAGE UP). 

 Decrease (CTRL+PAGE DOWN). 

 Normal (CTRL+SHIFT+N). 

Navigation Menu 

The Navigation menu provides the following commands for setting and 
moving to bookmarks, jumping to other pages, and searching text: 

 Bookmarks submenu 

 Set Bookmarks (CTRL+B). 

 View Bookmarks (CTRL+K). 

 Go To Page (CTRL+G). 

 Search Submenu. Note that search features are only available from 
the text area. 

 Find (CTRL+F). 

 Find Next (F3). 

 Find Previous (SHIFT+F3). 
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Help Menu 

This menu allows you to view which version of FSReader you are using 
as well as open the Getting Started with FSReader DAISY book. 

Reading RFB&D Books 

Recording for the Blind & Dyslexic offers a broad range of DAISY books 
for pleasure and education. You can read these books with FSReader if 
you are a member of RFB&D and have a UAK. UAK stands for User 
Authorization Key. Contact RFB&D at 1-800-221-4792 for a UAK and you 
will receive a CD with an application that, when run, will authorize 
FSReader to read the RFB&D books. Once FSReader is authorized to 
read RFB&D content, you can open the book from the File menu. If you 
have an older RFB&D book that you wish to open, you will be prompted 
to enter a pin code before the book will open. You should have received 
this code from RFB&D when you received the book. 

Other DAISY Books 

Some DAISY books are available in both text and audio versions. These 
books offer the fullest and richest reading experience. To store audio 
books it is strongly recommended that you do so on external media, such 
as CompactFlash or USB storage. 

Links to DAISY books from Freedom Scientific can be found on the 
Freedom Scientific Web site at 
http://www.freedomscientific.com/downloads/training/training-
downloads.asp. 
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Stopwatch 

The PAC Mate Omni Stopwatch can measure both elapsed and 
countdown time. Use the elapsed timer to measure the amount of time it 
takes to complete an event. Use the countdown timer to mark the time 
remaining in an event.  

To use the Stopwatch, go to the Start Menu (WINDOWS Key) and press 
P for Programs, then S for Stopwatch. 

To view a list of commands specific to the Stopwatch program, please 
see Appendix A: PAC Mate Omni Commands.  

Using the Elapsed Timer 

When the program opens, the elapsed timer is ready for you to press the 
ENTER key. When you do, the PAC Mate Omni announces "Starting 
Stopwatch" and upon every passing minute announces the current 
elapsed time. 

To stop or pause the elapsed timer, press ENTER. To resume timing, 
press ENTER again. 

To reset the timer, press TAB to move to the Reset button and press 
ENTER. 

Using the Countdown Timer 

To use the countdown timer, move to the Countdown button and press 
ENTER. This opens a dialog box where you type in the minutes in the 
edit box, then press TAB to move to the next edit box and type in the 
seconds. When you are done, press ENTER. This returns you to the 
main Stopwatch dialog box where the PAC Mate Omni starts the count 
down. The PAC Mate Omni announces remaining time at every one-
minute interval. With fifteen seconds remaining, the PAC Mate Omni 
announces each second until zero is reached. 
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To stop or pause the countdown timer, press ENTER. To resume timing, 
press ENTER again. To reset the timer, press TAB to move to the Reset 
button and press ENTER. 

Reading the Timer 

To read elapsed or remaining time at any point, press TAB or 
SHIFT+TAB to move to the time edit box, then use any of the reading 
commands to read the time information.  
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Windows Media Player 

Windows Media Player allows you to play sound files on your PAC Mate 
Omni. It supports a wide range of audio file formats (.wma, .asf, .mp3, 
.wav, and .wmp) including streaming audio, which is used primarily by 
Internet radio. You find Windows Media Player in the Programs Menu by 
pressing WINDOWS Key, P and using the arrow keys to locate Windows 
Media. 

Overview of the screens and menus 

Windows Media Player Mobile has three primary screens: 

 Playback screen. The screen that displays the playback controls 
(such as Play, Pause, Next, Previous, and Volume).  

 Now Playing screen. The screen that displays the Now Playing 
playlist. This special playlist indicates the currently playing file and any 
files that are queued up to play next.  

 Library screen. The screen that lets you quickly find your audio files 
and playlists. It contains categories such as My Music, My Video, My 
TV, and My Playlists. It also includes a link that lets you switch to the 
Now Playing screen.  

Each screen contains a menu accessed by pressing F2. The commands 
on this menu change depending on the screen that is active. 

Overview of the Playback screen commands 

When you are viewing the Playback screen, the following menu options 
are available. 

Option Description 

Library Displays the Library screen so 
you can choose a file to play. 

Play/Pause Starts or pauses playback. 
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Option Description 

Stop Stops playback. 

Shuffle/Repeat > Shuffle Plays the items in the Now 
Playing playlist in a random order. 

Shuffle/Repeat > Repeat Plays the items in the Now 
Playing playlist repeatedly. 

Full Screen When a video is playing, displays 
it by using the entire screen (not 
used since the PAC Mate Omni 
has no screen). 

Options Lets you adjust various Windows 
Media Player Mobile options, 
including network, playback, and 
hardware button options. 

Properties Displays information about the 
currently playing file. 

About Displays information about 
Windows Media Player Mobile, 
such as the version number. 

Overview of the Now Playing screen commands 

When you are viewing the Now Playing screen, the following menu 
options are available. 

Option  Description   

Library  Displays the Library screen so 
you can choose a file to play.   

Move Up  Moves the selected item up in the 
playlist order.   

Move Down  Moves the selected item down in 
the playlist order.   
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Option  Description   

Remove from Playlist  Removes the selected item from 
the playlist.   

Shuffle/Repeat > Shuffle  Plays the items in the Now 
Playing playlist in a random 
order.   

Shuffle/Repeat > Repeat  Plays the items in the Now 
Playing playlist repeatedly.   

Save Playlist  Saves the items in the Now 
Playing playlist as a new playlist.   

Clear Now Playing  Removes all items from the Now 
Playing playlist.   

Error Details  Displays error information about 
the selected item (an exclamation 
mark appears before the item 
name if error details are 
available).   

Properties  Displays information about the 
selected file.  

Overview of the Library screen commands 

When you are viewing the Library screen, the following menu options are 
available. 

Option  Description   

Queue Up  Adds the selected item to the end 
of the current (Now Playing) 
playlist.   

Delete from Library  Deletes the selected item from the 
library   

Now Playing  Displays the Now Playing 
playlist.   
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Option  Description   

Library > Library Name  Lets you switch between libraries, 
such as between My Device and 
Storage Card.   

Update Library  Adds new items to the library by 
searching your device or storage 
card.   

Open File  Lets you find and play files that 
are stored on your device or 
storage card but that are not in 
the library.   

Open URL  Lets you play a file on a network, 
such as the Internet.   

Properties  Displays information about the 
selected file.  

Switch between screens 

To switch between the Playback, Now Playing, and Library screens, do 
the following: 

 To switch from Playback to Library, press F2, navigate to Library, and 
press ENTER.  

 To switch from Playback to Now Playing, press F1.  

 To switch from Now Playing to Library, press F2, navigate to Library, 
and press ENTER.  

 To switch from Now Playing to Playback, press the CLOSE button 
(ESC).  

 To switch from Library to Now Playing, press F2, navigate to Now 
Playing, and press ENTER.  

 To switch from Library to Playback, press the CLOSE button (ESC).  
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Copying Sound Files to Your PAC Mate Omni 

You can copy sound files to your PAC Mate Omni by synchronizing them 
with ActiveSync. Additionally, if you have Windows Media Player 10 or 
later on your computer you can use the Sync feature in Windows Media 
Player. For more information on this feature, please see the online Help 
for Windows Media Player on the computer. After synchronizing or 
copying files to the PAC Mate Omni, open up Windows Media Player and 
you will be on the Library screen.  

The library is a database that contains links to your audio files and 
playlists. As in the desktop Player, it lets you sort your content by criteria 
such as artist name, album title, or genre. 

Unlike the desktop Player, the Pocket PC Player can have multiple 
libraries. Each library represents an available storage location. For 
example, if you store some content directly on your PAC Mate Omni, the 
My Device library contains links to those files. If you also store content on 
removable CompactFlash storage cards, you will have additional libraries 
for each of those cards. On the Library screen, you can switch between 
the My Device library and any other libraries that are available to your 
PAC Mate Omni. 

By default, Windows Media Player Mobile automatically searches the 
internal storage location of your PAC Mate Omni for compatible digital 
media files. If it finds any, they are added to the My Device library. 
Similarly, when you insert a CompactFlash card into your PAC Mate 
Omni, Windows Media Player Mobile automatically searches it for content 
and adds it to a Storage Card library. If the Player does not detect new 
files that you copy to your PAC Mate Omni, you can manually update the 
library by using the Update Library option available on the Library menu. 

Once you locate the file in your library that you want to listen to, you can 
press ENTER or F1 to begin playing it. You can also press the 
APPLICATIONS Key for a list of available actions. 

Note:  To listen to a file that is not in your library, you can use the Open 
File option, located on the Library menu, or open it through File 
Explorer. 
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Listening to Sound 

With Windows Media Player you can listen to music on the PAC Mate 
Omni while reading e-mail or editing a file. To do this, simply open 
Windows Media Player and you will be placed in the Library. Navigate to 
the song you want to play, and then press ENTER. Next, open the 
program you want to work in. If you want to listen to the whole playlist, 
just open Windows Media Player and press ENTER. To pause or stop the 
audio file, you must leave the program you are working in and return to 
Windows Media Player for the pause (ENTER) and the stop commands 
to work. To stop playing a song, from the Playback screen, press F2, 
move to Stop, and press ENTER. 

To disable Background Play, from the Windows Media main screen, 
press F2 and press ENTER on Options. On the Playback page of the 
Options dialog box, press TAB to move to the "Pause playback while 
using another program" check box and press the SPACEBAR to select it. 
When you are done, press the CLOSE button (ESC) to close the dialog 
box. Now when you move into another program to work, Windows Media 
Player will automatically pause the audio file. Pressing ALT+TAB 
switches to Windows Media Player and play resumes.  

To decrease or increase the volume, use the UP or DOWN ARROW 
keys.  

To view the list of commands available in Windows Media Player, please 
see Appendix A: PAC Mate Omni Commands. 

To open a Web site to listen to Internet radio, from the Library screen, 
press F2 and press ENTER on Open URL. In the Edit Combo box, type in 
the URL of the Web site and then press F1. 

For more information on how to use the features of Windows Media 
Player, please see the online help for Windows Media Player. 



 

 217 

Word Mobile 

Word Mobile is a word processing program designed for Windows 
Mobile. Word Mobile allows for synchronization of documents between 
your desktop computer and your PAC Mate Omni so that you have the 
most up-to-date content in both locations. 

To open Word Mobile, go to the Start Menu (WINDOWS Key), press O 
for Office Mobile, and then press W to open Word Mobile. The first time 
you open Word Mobile, it opens by default to a blank document so you 
can immediately begin typing.  

After you have created a document, Word Mobile will then open first to a 
list view where you can choose the document you want to open or create 
a new document. To select a document in the list view, use the arrow 
keys to move to the document and then press ENTER. To create a new 
document, press F1. 

Word Mobile has several templates you can use as a default document. 
These templates contain preformatted text so much of the work is already 
done for you. To select a template, from the list view, press F2 and press 
ENTER on Options. Press TAB to move to the Default Template combo 
box, and use the arrow keys to select a template type. 

In Word Mobile you can open only one document at a time. When you 
open a second document, the first one is saved and closed automatically. 
You can save a document you create or edit in a variety of formats, 
including Word (DOC), Rich Text Format (RTF), and Plain Text (TXT).  

Note:  The .psw format used in prior versions of Windows Mobile is no 
longer supported in Windows Mobile 6.0, which is on the PAC 
Mate Omni. 
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To save a document, press F2 and move to File. From the File Menu, 
press ENTER on Save As. In the Name edit field type a name for your 
file. If you want your document to get saved in a particular folder, press 
TAB to move to the next control and use the arrow keys to select a 
folder. The next control allows you to change the documents format. 
Since this is also a combo box, use the arrow keys to select a file format. 
The last control in this dialog box designates where you want to save 
your file. You have a choice of using the Main Memory or Storage Card. 
To close this dialog box and save your file, press ENTER on the Save 
button. Otherwise, press ENTER on Cancel. 

Note:  If you need to open and save contracted braille documents, which 
use the BRF extension, you should use the FSEdit program. For 
details, please see FSEdit 

As you continue to create, synchronize and edit documents, you may find 
that having all files appear in the list view too cumbersome to navigate. 
To have your files show in the list view by their respective folders, press 
CTRL+Y to open the Show By Menu. Next, select the folder that contains 
the file you want to open or add a new folder by selecting the Add/Delete 
option from the menu.  

In addition to showing files by their respective folders, you can sort files 
by date, name, size and type. To do this, press CTRL+T to open the Sort 
By Menu. Use the arrow keys to make your selection. 

To delete, copy, rename or move, use the editing commands such as 
DELETE; CTRL+X or CTRL+C. For more information on these 
commands, please see PAC Mate Omni Basics, Working with Text, 
Editing. 

To e-mail a document, open the list view of Word Mobile and select the 
file then press the APPLICATIONS Key. From the context menu use the 
arrow keys to select the appropriate action.  
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Synchronizing Word Mobile Documents 

Word Mobile documents can be synchronized with Word documents on 
your PC. To synchronize files of any type, you must first open ActiveSync 
on your PC and from the Tools Menu (ALT+T) select Options. In the 
Mobile Device list view place a check in the Files’ check box. When you 
select Files, a PAC Mate Omni My Documents folder is created on your 
PC's desktop. Place all files you want to synchronize with the PAC Mate 
Omni in this folder. Password-protected files cannot be synchronized.  

All Word Mobile files stored in My Documents and its subfolders are 
synchronized with the PC. ActiveSync converts documents during 
synchronization.  

For more information on synchronization or file conversion, see 
ActiveSync Help on the PC. 

Note:  When you delete a file on either your PC or your PAC Mate Omni, 
the file is deleted in the other location the next time you synchronize. 

File Conversion 

Word documents (.doc) and templates (.dot) created in Word 6.0 or later 
on the PC are converted to Word Mobile documents during file 
synchronization.  

Word Mobile documents are converted to Word documents when they’re 
synchronized back to the PC. During conversion from Word to Word 
Mobile, most simple text and paragraph formatting are retained and 
displayed, although some formatting attributes may be changed or lost. 
For more information, see ActiveSync Help on the PC. 

Note:  To use your new document as a template, move the document to 
the Templates folder. 

The section below lists conversion behavior between Word Mobile and 
Word. 

 Borders and shading are not displayed in Word Mobile, but are 
restored when converted back to a Word document. Shading is not 
restored when used in a table, but simple borders are restored.  
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 Character formatting such as bold, italic, strikethrough, superscript, 
subscript, and hidden text are retained and displayed. Other effects 
are changed or removed.  

 Colors are retained and mapped to colors available on your device.  

 Fonts and font sizes not supported by PAC Mate Omni are mapped to 
the closest font available. The original font will be listed on your PAC 
Mate Omni. When converted back to Word, the data is displayed in the 
original font.  

 Page formatting such as headers, footers, footnotes, columns, page 
setup information, and style sheets are removed during conversion to 
Word Mobile. Word Mobile supports built-in headings.  

 Paragraph formatting such as tabs, alignment, bullets, indentation, 
simple numbered lists, and paragraph spacing are retained and 
displayed in Word Mobile.  

 Pictures are removed during conversion.  

 Table of contents, text and some formatting are preserved. However, 
any text set at right-aligned tab stops may wrap to the next line.  

 Index text and some formatting are preserved.  

 Table formatting is removed, but text is preserved.  

 OLE objects are removed during conversion.  

 Revision marks are visible but cannot be changed.  

 Annotations and comments are removed during conversion. 
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Finding and Replacing Text 

Within Word Mobile is a Find/Replace Feature that is very similar to the 
Find/Replace Feature in Word. With this feature you can search for 
strings of text or a single word and replace it with other text. To use the 
Find/Replace Feature press F2, move to Edit, and press ENTER. From 
the Edit Menu select Find/Replace. Type the text you want to find. Press 
TAB to move to the Find button and press ENTER. If you’re replacing 
text, TAB to the Replace button and press ENTER. Type the replacement 
text. With this feature you can match case and match whole words. Use 
the SPACEBAR to check these options. When you are ready to Find a 
word(s) press ENTER on the Find button.  

Word Mobile selects the first instance of the text in the document and 
displays a window with buttons that allow you to find the next instance or 
replace the text.  

Formatting  

The formatting options available in the Word Mobile Format Menu are 
fairly robust. With it you can control point size and font type, determine 
text attributes such as bold, italic, underline etc., and align, bullet or 
indent text as needed.  

Of course, you can always use PAC Mate Omni’s formatting commands. 
For more information on these commands, please see PAC Mate Omni 
Basics, Working with Text. 

To format your document using Word Mobile’s Format Menu, press F2, 
move to Format and press ENTER. If you want to work with the font and 
alignment, move to Font and press ENTER. To work with paragraph 
alignment, bulleted lists and indentation, move to Paragraph and press 
ENTER.  

As you are working in Word Mobile, remember to select the text you want 
affected, then go into the menus and make your changes. For more 
information on selecting text, please see PAC Mate Omni Basics, 
Working with Text. 
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You can also insert the date if you want. To do this press F2, go to the 
Tools Menu and select Insert Date. The date is then placed into your 
document at the cursor location. 

Checking Spelling 

You can check the spelling of a specific word, or of all the words in a 
document. If a word is spelled correctly, but not recognized, you can add 
the word(s) to Word Mobile's online dictionary. To launch the Spell 
Checker, press F2, navigate to Tools, and press ENTER on Spelling. If 
you have selected one or more words, when you begin the spell check, 
selected text is checked first. When finished, you will be asked if you 
want to continue checking the rest of the document. Selecting Yes will 
continue with the spell check while selecting No will return you to the 
document. 

Unlike FSEdit, the Spell Checker in Word Mobile is not a dialog box. 
When a misspelled word is found, the PAC Mate Omni first speaks and 
spells it followed by reading the line in the document where it is located. 
A menu then displays containing several items. Use the UP and DOWN 
ARROWS to select an option and press ENTER to activate it. 

The first few items in the menu are the suggested replacement words. 
The number of suggestions available depends on the misspelled word. 
Press ENTER on the word you want and it will be changed in the 
document. 

The next two items after the last suggestion are Ignore and Ignore All. 
Choosing Ignore causes the selected misspelled word to be skipped. If 
the same word is found later in the document, it will be displayed again. 
Choosing Ignore All causes every occurrence of the selected misspelled 
word to be skipped. 

The last item in this menu is Add. If you know the current word is spelled 
correctly, select this option to have it added to Word Mobile's online 
dictionary so it will be considered correct in future spell checks. 

If you need to stop the spell check before it is complete, press the 
CLOSE button (ESC). 
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Saving, Renaming, Moving, and Deleting  

When you create a new document, the information you ENTER is saved 
automatically and named according to the first characters of text entered 
in the document. In an open document, you can:  

 Save a copy of the document. Press F2, go to the File Menu, and 
select Save As.  

 Rename the document. Press F2, go to the File Menu, and select 
Rename/Move. In the Name edit box, type the new name.  

 Move the document to a storage card or folder. Go to the File Menu, 
and select Rename/Move. Select the appropriate folder or location.  

 Delete the document. Go to the File Menu and select Delete.  

Note:  To move or delete multiple documents, in the list view, select the 
documents. Then, press the APPLICATIONS Key. From the menu, 
choose Rename/Move or Delete. 

Printing a Document 

You can print documents from Word Mobile if you download and install 
the PrintBoy utility.  

Attaching a Document to E-mail 

In the documents list view; select the document and press the 
APPLICATIONS Key. To select multiple documents, use the 
SHIFT+UP/DOWN ARROW. Then, press the APPLICATIONS Key. From 
the Context Menu, choose Send.  

A new e-mail message is created with the document attached.  

Changing Default Options 

You can change the defaults for creating and storing Word Mobile 
documents by going to the Tools Menu and selecting Options in the list 
view.  
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Select a template to be used for new documents. You can change this 
default when creating specific documents. Only documents saved in the 
Templates folder are listed.  

Select a location for storing documents. You can choose between main 
memory and a storage card, if you have one installed.  

Select the type of documents you want displayed in the document list 
view. 
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Excel Mobile 

With the PAC Mate Omni's support of Excel Mobile, many new and 
exciting possibilities await you. While a mini version of the desktop 
application, Excel Mobile retains many of the powerful features you need 
in a spreadsheet analysis program. 

Like other Windows Mobile applications, your Excel files are fully 
synchronizable with Excel on your PC. 

Excel Mobile files use the extension .pxl and .pxt. During synchronization, 
many items in your.xls file will not convert or are changed in your .pxl or 
.pxt files. For instance, cell comments and hyperlinks do not convert, 
while borders change to single lines in Excel Mobile. However, once you 
synchronize and convert back to .xls these items are restored. For more 
information on Conversion changes, please see Excel Mobile's online 
help in the PAC Mate Omni. 

You can find the Excel Mobile application in the Office Mobile submenu 
(WINDOWS Key, O, ENTER). The first time you open Excel Mobile, it 
opens by default to a blank spreadsheet so you can immediately begin 
entering data. 

To view all the commands available in Excel Mobile, please see 
Appendix A: Excel Mobile Commands.  

After you have created a workbook, Excel Mobile will then open first to a 
list view where you can choose the workbook you want to open or create 
a new workbook. To select a workbook in the list view, use the arrow 
keys to move to the workbook and then press ENTER. To create a new 
workbook, press F1. 

In Excel Mobile you can open only one workbook at a time. When you 
open a second workbook, the first one is saved and closed automatically. 



 

226 

To save a workbook, press F2, move to File and press ENTER. From the 
File Menu, press ENTER on Save As. In the Name edit field type a name 
for your file. If you want your workbook to get saved in a particular folder, 
press TAB to move to the next control and use the arrow keys to select a 
folder. The next control allows you to change the workbook's format. 
Since this is also a combo box, use the arrow keys to select a file format. 
The last control in this dialog box designates where you want to save 
your file. You have a choice of using the Main Memory or storage card (if 
one is available). To close this dialog box and save your file, press 
ENTER on the Save button. Otherwise, press ENTER on Cancel. 

Synchronizing Excel Mobile Workbooks 

Excel Mobile workbooks can be synchronized with Excel on your PC. To 
synchronize files of any type, you must first create a standard 
partnership. Then in ActiveSync on your PC go to the Tools Menu 
(ALT+T) and select Options. In the Mobile Device list view, place a check 
in the Files' check box. When you select Files, a PAC Mate Omni My 
Documents folder is created on your PC's desktop. Place all files you 
want to synchronize with the PAC Mate Omni in this folder. Password-
protected files cannot be synchronized. 

All Excel Mobile files stored in My Documents and its subfolders are 
synchronized with the PC. ActiveSync converts documents during 
synchronization.  

For more information on synchronization or file conversion, see 
ActiveSync Help on the PC. 

Note: When you delete a file on either your PC or your PAC Mate Omni, 
the file is deleted in the other location the next time you 
synchronize. 

Attaching an Excel Mobile File to E-mail 

In the list view; select the file and press the APPLICATIONS Key. To 
select multiple files, use the SPACEBAR+UP/DOWN ARROW. Then, 
press the APPLICATIONS Key. From the Context Menu, choose Send. 

A new e-mail message is created with the file attached. 
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PowerPoint Mobile 

Use PowerPoint Mobile to open and read PowerPoint presentations 
created on a desktop computer on your PAC Mate Omni. PowerPoint 
Mobile does not allow you to create presentations, they can only be 
viewed. Presentations must be created by you or someone running 
PowerPoint on a desktop or laptop computer. They can then be copied to 
the PAC Mate Omni using ActiveSync or beamed using Infrared from 
another device. You can also open presentations saved on a 
CompactFlash storage card or USB thumb drive. 

PowerPoint Mobile is located in the Office Mobile submenu (WINDOWS 
Key, O, P). When the program starts, you are placed in a list view 
containing all of the presentations stored on your PAC Mate Omni. To 
rename, delete, or e-mail a presentation, use the arrow keys to select the 
file and press the APPLICATIONS Key and select the appropriate option 
from the context menu. To open a presentation for viewing, select it from 
the list and press F1 to start the slide show. You are placed on the first 
slide in the presentation and JAWS will begin reading automatically. 

While in the slide show, use the standard reading commands to read the 
text of each slide. Press the SPACEBAR to move to the next slide and 
use BACKSPACE to go to the previous slide. On each slide, press 
ENTER to bring up a context menu where you can select the next or 
previous slide as well as go to a specific slide by selecting the slide 
number. To close the current presentation and return to the list view, 
press ENTER, move to End Show, and press ENTER again. 
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Windows Live Messenger 

Windows Live Messenger® is a communication (or "chat") program. 
Unlike e-mail where you send mail and wait for a reply, Windows Live 
Messenger allows active correspondence between you and another 
person. Similar to a chat room in that you can talk to several people at 
once, Windows Live Messenger is less "free wheeling" and more 
exclusive as you decide who to invite into a discussion.  

With PAC Mate Omni support, Windows Live Messenger really comes 
alive as the PAC Mate Omni speaks the messages you send and receive. 
In addition, the PAC Mate Omni audibly indicates when someone is trying 
to contact you.  

In short, this is a fun program and one that you and your friends should 
not be without! 

Gearing Up to Use Windows Live Messenger 

Before you can use Windows Live Messenger, there are a few things you 
have to do first.  

1. On your laptop or desktop computer go to either 
http://www.windowslive.com/ or www.hotmail.com and set up an 
account. 

2. On your PAC Mate Omni establish an Internet connection. 

To start Windows Live Messenger, open the Programs menu (WINDOWS 
Key, P), navigate to Messenger, and press ENTER. 

Signing In 

 To sign in and appear as Online to your contacts, press F1. To display 
a different status after signing in, press F2, press ENTER on Sign in 
As and select an option from the list such as busy or away, then press 
F1.  

 To sign out, press F2 and press ENTER on Sign Out.  

http://www.windowslive.com/
http://www.hotmail.com/
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Since Windows Live Messenger is tightly integrated with the Windows 
Live Service, the first time you sign in to Windows Live Messenger on the 
PAC Mate Omni, you will be prompted to accept the Windows Live Terms 
of Service and Privacy Statement as well as to configure other options 
such as whether Windows Live and the Windows Live Search bar are 
displayed on the Today screen and how your Windows Live contacts and 
e-mail are handled. Follow the instructions on each screen and Press F1 
to move to the next screen. In addition, you are asked to enter your 
Windows Live e-mail address and password. This information is only 
required the first time you sign in. 

Messaging 

Once you're signed in, Windows Live Messenger opens to a tree view 
where you navigate with the UP and DOWN ARROWS to view online and 
offline contacts. To send an instant message to a contact, select the 
contact and press ENTER. Press F2 to open the application menu. In this 
menu you can change your online status, change Windows Live 
Messenger options, and add, block, delete, and view the properties of a 
contact. 

The online help that comes with Windows Live Messenger is fairly 
comprehensive and easily explains the features of this program. To open 
Windows Live Messenger Help, press the WINDOWS Key and select 
Help from the Start Menu. When Help opens, press ALT, select Contents, 
and choose the topic "Using Windows Live Messenger." 
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Mundu Instant Messenger 

Mundu IM is an instant messaging application similar to Windows Live 
Messenger. It allows you to type back and forth and have a conversation 
with one or more people any where in the world. Mundu IM lets you 
access several messaging services including MSN, Yahoo, Google Talk, 
AOL, Jabber, and ICQ. You can be logged into as many services as you 
want simultaneously. 

With PAC Mate Omni support, Mundu IM really comes alive as PAC Mate 
Omni speaks the messages you send and receive. In addition, PAC Mate 
Omni audibly indicates when someone is trying to contact you.  

To download a five-day trial of Mundu IM, do the following: 

1. On your PAC Mate establish an Internet connection. 

2. Open the Start menu and choose Internet Explorer. Press G to 
move to the address bar and type http://www.mundu.com/im.  

3. Choose the Windows Mobile link to download the installation 
CAB file for Windows Mobile. The Download dialog box opens.  

4. Make sure the Open file after download completes check box is 
selected, then choose the Yes button to save the file to the My 
Documents folder. Choose Save As if you want to save the file to 
a location other than My Documents, such as a CompactFlash 
card.  

5. Once the file is downloaded, the installation will automatically 
begin. Follow the prompts to Install Mundu IM on your PAC Mate 
Omni.  

If you choose to purchase a full license for Mundu IM, from your main 
computer, go to http://www.mundu.com/im/windowsmobile and select the 
Buy link. 
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Gearing Up to Use Mundu IM 

Before you can use Mundu IM, there are a few things you have to do first.  

1. Using your regular computer, go to the Web site for the instant 
messaging service you want to use and sign up for an account. 
You can use MSN, Yahoo, Google Talk, AOL, Jabber, and ICQ.  

2. On your PAC Mate establish an Internet connection. 

To start Mundu IM, open the Programs menu (WINDOWS Key, P), 
navigate to Mundu IM, and press ENTER. 

Signing In 

When Mundu IM first starts, you are placed in a list of all the services you 
can connect to. Use the ARROW keys to locate the service(s) you want 
to log in to then press the SPACEBAR to select it. When you press the 
SPACEBAR on a service, a dialog box opens prompting you to enter 
your user id and password for the service. If you do not want to be 
prompted each time for your log in details, select the Remember me 
check box. Select the Auto login check box to have Mundu IM 
automatically log you in to the selected services when the program starts. 

Once you have selected one or more services, press TAB to move to the 
Login button and press ENTER. 

Messaging 

Once signed in, you are placed in a tree view containing all of your 
contacts regardless of what service they are on. Each contact name is 
proceeded by their status, such as whether they are offline or online. To 
send an instant message to a contact, use the ARROW keys to select the 
contact and press ENTER. 

For a complete list of Mundu keystrokes, please refer to the chart of 
keystrokes below. 
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For more information on using Mundu IM, you can download the User's 
guide in PDF format by going to 
http://www.mundu.com/im/windowsmobile from your main computer. 

Mundu IM Keystrokes 

Keystrokes for Mundu IM. 

Description Command 

Review Previous Messages ALT+M followed by 1 through 0 
(where 1 is the most recent 
message and 0 is the tenth most 
recent message) 

Display last 25 Messages in 
Virtual Viewer 

ALT+M, V 

Clear Message History ALT+M, C 

Message Layer Help ALT+M, INSERT+F1 
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AudiblePlayer 

What is Audible? 

Audible® (www.audible.com®) is a service that features audio content 
download and playback on personal computers, CD, or AudibleReady® 
computer-based mobile devices. 

You can now enjoy daily audio subscriptions of national newspapers, 
weekly business and science magazines, and more than 6,000 audio 
books available at Audible.com®.  

The AudiblePlayer for Windows Mobile lets you listen to pre-recorded 
audio books, time-shifted radio programs, audio magazines and 
newspapers as well as a whole variety of other spoken word audio 
programs on your PAC Mate Omni.  

Installing AudiblePlayer 

Ensure that ActiveSync is installed on your desktop computer, and that 
the PAC Mate Omni is connected to your computer with either a standard 
or guest partnership. On your PC, go to www.audible.com and select the 
Member Login link to login or sign up. Then download the AudiblePlayer 
software for Windows Mobile. Once installed, you find AudiblePlayer in 
the Programs submenu (WINDOWS Key, p). 

Note: AudiblePlayer automatically installs an additional application called 
AudibleAir, which also appears in the Programs submenu. This 
program is not supported by the PAC Mate Omni. Make sure you 
select AudiblePlayer when starting the program. 

 To view the list of commands available for AudiblePlayer, please go to 
Appendix A: PAC Mate Omni Commands 

Navigating between Audio Programs 

AudiblePlayer will automatically play the programs on your Pocket PC in 
alphabetical order. 
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If you would like to select from a list of all available audio programs on 
your Pocket PC, simply press F1 to open My Library. The audio program 
currently selected is highlighted. You can use the arrow keys to make 
your selection and then press F1 to start the selection. The playback 
position of the last audio program is automatically saved for future use.  

Navigating within Audio Programs 

It is easy to navigate within an audio program. Use the LEFT and RIGHT 
ARROW keys to rewind or fast forward through a program. You can also 
skip by sections or move to the next or previous titles by pressing F2 to 
open the menu and selecting the Navigation submenu.  

To manage bookmarks, press F2 to open the menu and select the 
Bookmarks submenu. To place a bookmark at your current location, 
choose Add Bookmark. Bookmarks you add will appear in this submenu. 
Press ENTER on the one you want to begin playback from that point. 
Select Edit Bookmark to bring up a list of your bookmarks. Use the arrow 
keys to select a bookmark and choose the Delete button to remove it, or 
Update button to change it. 

Storage Cards 

For long audio programs, you can place audio on a storage card using 
AudibleManager. The AudiblePlayer will present a consolidated list of 
your Audio programs, whether it is stored on Main Memory or the Storage 
Card. 

The online help that comes with AudiblePlayer is very comprehensive 
and easily explains all features of this program. To open AudiblePlayer 
Help, open the program, press WINDOWS Key and select Help from the 
Start Menu. 
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Resco Audio Recorder 

What is Resco Audio Recorder? 

Turn your PAC Mate Omni into a handy recorder with the Resco Audio 
Recorder. Use it to record notes, meetings, interviews or classroom 
lectures. With its digital Voice Activation System (VAS), Resco Audio 
Recorder records only when sound is detected. This increases recording 
time and is useful during lectures and meetings. When used with 
CompactFlash® storage cards you can extend available recording time 
for hours. Resco Audio Recorder supports the following file formats:  

 MP3 - 16, 32, 64 kbps audio encoding (strong audio compression) 

 MP1, MP2, and M3U 

 RAF - 22 and 44 kbps ADPCM audio encoding (middle audio 
compression) 

 WAV - most known standard wave format (pure audio compression) 

Installing Audio Recorder 

The following describes how to install the 14-day evaluation version of 
Resco Audio Recorder. This version is available on your PAC Mate Omni 
Documentation CD, or it can be downloaded from the Freedom Scientific 
Web site at 
http://www.freedomscientific.com/fs_products/Resco_Audio_Recorder.as
p. 

Perform the following procedures to install the Audio Recorder: 

1. Ensure that your PAC Mate Omni is connected to your computer 
with a standard or guest partnership using ActiveSync. 

2. Select Audiorec_pacmate.exe.  

3. Select the Run button when the File Download - Security 
Warning dialog box appears.  
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4. Select the Run button again if the Internet Explorer - Security 
Warning dialog box appears. 

5. The Resco Audio Recorder Installation dialog box appears. 
Choose Yes, and then choose Install when the second Resco 
Audio Recorder Installation dialog box appears.  

6. Choose Yes to install Resco Audio Recorder into the default 
directory. 

7. When the APPLICATIONS Download Complete dialog box 
appears, press ENTER to begin transferring the application to 
the PAC Mate Omni. 

8. Choose Finish to close the last Installation dialog box. 

9. On the PAC Mate Omni, the Welcome/Help dialog box appears 
once the installation is complete. Press the CLOSE button (ESC) 
to close the dialog box.  
Resco Audio Recorder is now installed on the PAC Mate Omni.  

Note: The Help system is still running in the background. To close it, use 
the Memory Manager to quit, or perform a warm reset of the PAC 
Mate Omni.  

To launch Audio Recorder, refer to Opening and Setting Up Audio 
Recorder for the First Time.  

To purchase Audio Recorder, refer to Purchasing Audio Recorder. 

Note: During the purchase process, be sure to enter the owner 
information exactly as it was entered into the PAC Mate Omni 
because the registration code for Audio Recorder is keyed to this 
information. This means that you must set a name in the Owner 
Information dialog box in Settings and use that name exactly, 
including upper and lower case, when registering. 

To register Audio Recorder, refer to Registering Audio Recorder.  
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Opening and Setting Up Audio Recorder for the 
First Time  

The first time you open Audio Recorder, you are asked if you want to 
make it the default player for several audio file formats. 

Do the following to open and configure the Audio Recorder: 

1. From the Start menu, select Programs, and choose Audio 
Recorder. 

2. A dialog box appears asking if you want to set Resco Audio 
Recorder as the default player for specific audio formats. Select 
Yes. (If you do not want to associate files with the Audio 
Recorder, select No, press the CLOSE button (ESC), and go to 
step 6.)  

3. The Options dialog box appears. From the Associated File 
Types list box, use the SPACEBAR to check specific audio 
formats from the list, or use the Select All button to choose all of 
the listed formats.  

4. Press TAB to move to the Associate button and press ENTER. 

5. A message indicating the file formats that have been selected 
appears. Press the CLOSE button (ESC) to dismiss it. 

6. Press the CLOSE button (ESC) again to exit the Settings dialog 
box. 

Before Using Audio Recorder 

Before using Resco Audio Recorder, you must first disable the current 
settings of the UP, DOWN, LEFT, and RIGHT ARROW hardware 
buttons. If you do not do this, you will lose the ability to change values in 
controls such as the date and time edit controls, combo boxes, list boxes, 
and so on.  

To disable these hardware buttons, do the following: 
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1. Press ALT to open the menus and select Tools. 

2. Navigate to the Settings command, and press ENTER to open 
this multipage dialog box. 

3. Press CTRL+TAB to move to the Buttons page.  

4. In the Hardware Buttons list, select the UP button.  

5. Press TAB to move to the Action combo box, and select the No 
Action item.  

6. Press TAB several times to return to the Hardware Buttons list.  

7. Repeat steps 4 through 6 to select and disable the DOWN, 
LEFT, and RIGHT buttons.  

8. After disabling all ARROW buttons, press the CLOSE button 
(ESC) to close the dialog box.  

Creating a Recording 

To create a recording: 

1. Press the WINDOWS Key to open the Start Menu, press P to 
open the Programs submenu, select Audio Recorder, and press 
ENTER. 

2. Press CTRL+R to begin recording. 

3. Press CTRL+S to stop recording. 

4. Press CTRL+P to start playing. 

Note: For recording meetings, lectures, etc., a directional external 
microphone with amplification is recommended. 
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Scheduling a Recording 

You can schedule a recording to begin at a specific time and even on a 
specific date. To do this: 

1. Open Audio Recorder. Press ALT to open the menus and select 
Tools. Select Scheduler from the Tools submenu. 

2. Press TAB to move to the date field. The date field is editable 
and is formatted as 9/3/04.  

3. When you move to this field, the day is active, type the day. 
Then LEFT ARROW to the month and type in the month.  

4. Press the RIGHT ARROW twice and this time, type in the year.  

5. Next, press TAB to move to the time field. The time field is a 
spinnable field and is formatted as 12:04:17 PM.  

6. When you move to this field, the hour is active. You can either 
use the UP and DOWN ARROWS to select the hour or type it in. 
Then press the RIGHT ARROW to move to the minutes. Follow 
the same steps listed to change the minutes and seconds.  

Note: In order to ensure that you can properly adjust the time and date 
settings, you must have highlighting turned on in the Braille 
Options if you are using an attached braille display and have 
muted speech output. 

Using the Voice Activation System 

The Voice Activation System (VAS) allows Audio Recorder to turn itself 
on when a predetermined sound level is detected. To set the external 
volume level, do the following: 

1. Press ALT to open the menu. Select Voice Activation System 
and press ENTER. 
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2. Use the LEFT ARROW and RIGHT ARROW keys to adjust the 
VAS level setting. The higher the value of this setting, the more 
sensitive VAS becomes and the lower the external volume level 
that is needed to cause recording to begin. 

3. Press ALT to open the menu, move to File List, and press 
ENTER to return to the main Audio Recorder window. 

Note: To turn off the VAS feature, open the VAS setting and set the value 
to zero. 

Tagging a Recording 

Tags are parts of a recording that can be processed separately. They can 
be exported to one or several files. You can listen to them separately 
from the original recording.  

To create tags, do the following while a recording is playing: 

1. In the Files List View dialog box of the Main File Panel, navigate 
to the file you want to hear, and then press ENTER to start 
playing the file.  

2. Press CTRL+INSERT+G to enter Tagging mode.  

3. Press B to mark the beginning of a new tag.  

4. Press E to mark the end of the tag.  

5. Repeat steps 3 and 4 to make additional tags.  

6. If necessary, press CTRL+S or TAB to navigate to the Stop 
button, and press ENTER to stop the file.  

 

 



 

 241 

Exporting Tags 

To export tags: 

1. Press CTRL+TAB to move to the Tags Panel.  
Use the UP ARROW to select the first tagged item in the Tags 
list box. If necessary, use the DOWN ARROW to move down the 
list and select another tagged item.  

2. Do one of the following to export single or multiple tagged 
segments:  

 To export one tagged segment and save it as a separate file, 
press TAB until you hear, "Export Selected Tags button." Press 
ENTER. The Export mode dialog box appears. 
...OR...  

 To select all tagged segments and export into a single file, use 
TAB to navigate to the Single/Multi Selection button and press 
ENTER.  

 Return to the tagged list and make sure that the first tagged 
segment in the list is selected. Next, press CTRL+SHIFT+END. 
This action selects all items in the list.  

Note: If you want to combine all tagged segments into a single tagged 
item, select the Merged button. A merged segment includes all 
material (even material that was excluded during the initial 
tagging) from the beginning of the very first tagged segment to the 
end of the very last tagged segment.  

 Press TAB until you hear, "Export Selected Tags button," and 
press ENTER. The Export mode dialog box appears.  

3. Use the DOWN or UP ARROWS to select an exporting mode 
format, for example, WAV, RAF, or MP3.  

Note: If you select MP3, press TAB and use the UP and DOWN 
ARROWS to configure the Quality and Exporting Mode Properties 
parameters.  
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4. Press TAB to choose the Export button, and press ENTER.  

5. In the Target File dialog box, press TAB and then provide a file 
name and storage location for the file.  

6. Press TAB to move to the Save button, and press ENTER.  
The export process begins. The duration of the export process 
varies based on the number of tagged segments. When the 
export is finished, focus returns to the Tags Panel. To move 
focus to the Main File Panel, press SHIFT+CTRL+TAB.  

Purchasing Audio Recorder 

Resco Audio Recorder for PAC Mate Omni is a powerful recording tool 
that is intended for use by students and professionals alike who need to 
record using their PDA. This version of Audio Recorder features a custom 
interface designed especially for the PAC Mate Omni, which takes all of 
the mystery out of using this powerful application. 

To Purchase Resco Audio Recorder: 

1. Go to: http://www.resco.net/buy/ar_for_blind.asp. An online 
shopping cart appears with the Resco Audio Recorder selected. 

2. Navigate to the Credit/Debit Card combo box, and select the 
type of credit card you are using to purchase Audio Recorder. 

3. Navigate to the Checkout button, and press ENTER. The 
Personal Information page appears. This page and all 
subsequent pages are secured Web pages. 

4. Fill in the required edit fields. Required fields are indicated by an 
asterisk (star). 

Note: The Intended Device combo box currently does not include the 
Freedom Scientific PAC Mate Omni as an option. Select another 
device, the type is not important.  

http://www.resco.net/buy/ar_for_blind.asp


 

 243 

Note: The “Pocket PC Owner Name” edit field requires the name you 
entered into the PAC Mate Omni’s Owner Information field. This 
allows you to obtain an Authorization code. You must enter your 
name exactly as it appears on your PAC Mate Omni’s Today 
Screen or the Authorization code will not work. 

5. Navigate to the Continue button, and press ENTER. The 
Payment Information page appears. Enter your credit card 
information. 

6. Navigate to the Continue button, and press ENTER. The Review 
Order page appears. Review your purchase information. If you 
find any errors you can press the Edit button and make any 
necessary changes. 

7. If the information on this page is correct, navigate to the 
Complete Purchase button, and press ENTER. The Confirmation 
page appears. You may wish to save the contents of this page 
for your records.  

Important: Do not download the version of Audio Recorder available 
from the Confirmation page. Instead, use the version provided by 
Freedom Scientific. This version is customized to provide a highly 
accessible PAC Mate Omni interface. 

Note: After purchasing Audio Recorder, an Authorization code is e-
mailed to you. Use this code to register and fully activate your 
version of the software. For registration procedures, refer to 
Registering Audio Recorder.  

8. Close your Web browser, and use the Freedom Scientific 
version of Resco Audio Recorder. It is available on your PAC 
Mate Omni User Documentation CD-ROM or can be 
downloaded from Freedom Scientific. 

Registering Audio Recorder 

An Authorization code is e-mailed to you shortly after purchasing Resco 
Audio Recorder. By registering and activating your software, you remove 
the 14-day evaluation limit.  
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Do the following to register Audio Recorder: 

1. Copy the Authorization code from your e-mail message.  

2. Open Audio Recorder.  

3. Press ALT, choose Tools, choose About, and press ENTER. 
The Registration form appears. 

4. Paste or type the Authorization code into the Code field, and 
press ENTER. 
Resco Audio Recorder is now registered and fully activated.  
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Remote Display Control 

Remote Display Control is free software that can be used with a PAC 
Mate Omni. This freeware allows teachers, parents, and other sighted 
people to see the PAC Mate Omni user interface on a computer monitor. 
With Remote Display Control, you can use a mouse, computer keypad, or 
the PAC Mate Omni keyboard to navigate menus, dialog boxes, and even 
enter text on the PAC Mate Omni "screen." 

Note: As you use the desktop or PAC Mate Omni keyboard to enter 
commands you will notice a 2 to 3 second delay in the screen 
response of Remote Display Control. Consequently, rapid 
command input may cause the program to hang. If this occurs, 
input the commands more slowly. 

Installing Remote Display Control 

Ensure that ActiveSync is installed on your desktop computer, and that 
the PAC Mate Omni is connected to your computer with either a standard 
or guest partnership. 

1. Insert the Documentation CD into your computer’s CD-ROM 
drive. 

2. Open the Start Menu and select Run.  

3. In the Open edit field, type the following path D:\Teachers and 
Trainers\RemoteDSP.exe, where D: is your CD-ROM drive. 

4. Follow the install wizard. 

This installs Remote Display Control on both your computer and PAC 
Mate Omni.  

1. Open the Start Menu and select Run.  

2. In the Open edit field, type the following path D:\Teachers and 
Trainers\Create.bat, where D: is your CD-ROM drive. 
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This creates a new folder on your computer's hard drive and copies 
several files that will be used when you run the application. 

Using the Program 

To use Remote Display Control for the first time, do the following:  

1. Open the Start Menu and select Run.  

2. In the Open edit field, type the following path 
D:\PMViewer\PMViewerInstall.exe, where D: is your CD-ROM 
drive. This action does two things: 

3. Starts a Remote Display Control session between your computer 
and PAC Mate Omni. 

4. Creates a PMViewer icon on your computer's desktop. 

In the future, all you need to do to start a Remote Display Control session 
is to create an ActiveSync session between your computer and any PAC 
Mate Omni, navigate to your computer's desktop and locate the 
PMViewer icon, and press ENTER to start a Remote Display Control 
session between your computer and the PAC Mate Omni. You do not 
need to follow the installation steps, above, since selecting the PMViewer 
icon on the desktop will install the Remote Display Control component to 
any PAC Mate Omni that does not already have it installed. 

Note: When Remote Display Control starts on your PAC Mate Omni, you 
may see a dialog box that must be dismissed by selecting the OK 
button. This may be followed by a dialog box giving you four 
options: select Hide to place the Remote Display Control 
application in the background on the PAC Mate Omni. 

The Pocket PC user interface should now be displayed on your PC 
monitor in the Remote Display Control window. You can now use your 
PC's mouse and keyboard or use the PAC Mate Omni keyboard to 
interact with Pocket PC. 
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Contacting Freedom Scientific 

Corporate Headquarters 

Freedom Scientific  
11800 31st Court North 
St. Petersburg, FL 33716-1805 
USA 

Telephone: (727) 803-8000 
Fax: (727) 803-8001 

The Freedom Scientific Website, www.FreedomScientific.com, is a 
comprehensive source of information regarding screen reader software, 
screen magnification software, training opportunities, application-specific 
cassette tutorials and the company that develops these products.  

The Freedom Scientific Web site is designed to be accessible by people 
with disabilities and includes a great deal of technical support information 
as well as online ordering capability, RealAudio descriptions of many 
products, and continuous product update and maintenance downloads. 

At Freedom Scientific, we strive to produce the highest quality 
documentation products, and welcome your feedback. If you have 
comments or suggestions about our online Help or printed guides, send 
your e-mail messages to documentation@FreedomScientific.com. 

Sales Department 

Sales Telephone: (800) 444-4443 
International Sales Telephone, including Canada: (727) 803-8000 
Sales Fax: (727) 803-8001 
Sales e-mail: Info@FreedomScientific.com 

To ensure that your request is handled promptly, include your complete 
address and telephone number. 
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Technical Support 

You must be a registered user to access Freedom Scientific support 
services. Freedom Scientific support services are subject to Freedom 
Scientific terms and conditions in place at the time the service is used.  

Reach Technical Support using the following options: 

Technical Support e-mail: Support@FreedomScientific.com 

Technical Support Telephone: (727) 803-8600  

When you call, be at your computer, have your documentation in hand, 
and be prepared to provide the following information: 

 Product serial number used for registration. 

 Product name and version number. 

 Type of computer hardware you are using. 

 Software version number of Windows. 

 Exact wording of any messages that appear on your screen. 

 What you were doing when the problem occurred. 

 How you tried to solve the problem. 
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Appendix A: PAC Mate Omni Commands 

In the PAC Mate Omni QX400 you have the option of using the CAPS 
LOCK Key and the INSERT Key as the JAWS Key or you can elect to 
use only the INSERT Key as the JAWS Key. The default option is set to 
use both as the JAWS Key. To change this option, open the Keyboard 
Settings dialog box found under Settings in the Start Menu.  

General Commands 

The following table lists general commands available from anywhere in 
the PAC Mate Omni. 

Description   Command    

Warm Reset  ALT+CTRL+DELETE   

Shortcut to Running Programs  ALT+CTRL+M   

Toggle Continuous Braille Mode  CTRL+R   

Close a dialog box or Program  Close button (ESC)   

Activate Menu Bar  ALT   

Activate Left Soft Key  F1   

Activate Right Soft Key  F2   

Announce Left and Right Soft Key 
Assignments  

ALT+F3   

Decrease System Volume  F6   

Increase System Volume  F7   

Open the Start Menu  WINDOWS Key   

List Recent Applications  ALT+TAB or INSERT+F10   

Backspace  BACKSPACE   
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Description   Command    

Enter  ENTER   

Tab  TAB   

Shift Tab  SHIFT+TAB   

Toggle Caps Lock On/Off  CAPS LOCK (press twice quickly 
when used as the JAWS Key)   

Activate Application Context 
Menu  

APPLICATIONS Key   

Read Window Type and Text  INSERT+TAB   

Read Entire Window  INSERT+B   

Refresh Screen  INSERT+ESC   

Toggle Embedded Num Pad  FN+ScrLk   

View Modem Connection Details  CTRL+SHIFT+M   

Read Window Title  INSERT+T   

Obtain Font Information  INSERT+F   

Read system Time  INSERT+F12   

Read System Date  INSERT+F12 twice quickly   

Toggle Keyboard Help  INSERT+1   

Toggle Keyboard Echo  INSERT+2   

Toggle the Braille Cursor Shape  INSERT+3   

Read Access Keys in Menus and 
dialog boxes  

INSERT+SHIFT+COMMA   

Open Dictionary Settings dialog 
box  

INSERT+D   
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Description   Command    

Start/Toggle ActiveSync Remote 
PAC Mate  

INSERT+SHIFT+F4   

Stop ActiveSync Remote PAC 
Mate  

INSERT+F4   

Obtain Help on Currently Selected 
Control  

INSERT+F1   

Obtain Context-sensitive Help  INSERT+F1 twice quickly   

Insert ASCII Value in Document  FN+SCRLK to activate THE 
embedded number pad followed 
by ALT and a number   

Cycle Between Reader Mode 
Options 

INSERT+SHIFT+R 

List General PAC Mate Omni 
Keystrokes  

INSERT+W   

Toggle Braille Input Mode INSERT+SHIFT+F9 

Quit Current Application (may not 
work in all Windows Mobile 
applications)  

CTRL+Q  

Quick Navigation Using Hardware Buttons 

You can assign up to 8 hardware buttons to quickly open commonly used 
applications on your PAC Mate Omni. The following table lists the 
keystrokes and the application assigned to each by default. For more 
information on setting hardware buttons, please see Buttons. 

Program   Command    

Record  INSERT+SPACEBAR, 1   

Calendar  INSERT+SPACEBAR, 2   

Contacts  INSERT+SPACEBAR, 3   
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Program   Command    

Tasks  INSERT+SPACEBAR, 4   

Messaging  INSERT+SPACEBAR, 5   

File Explorer  INSERT+SPACEBAR, 6   

FSEdit  INSERT+SPACEBAR, 7   

FSCalc  INSERT+SPACEBAR, 8  

Dialog Box Navigation Commands 

The following table lists the commands for navigating in dialog boxes. 

Description  Command   

Move to the Next Control  TAB   

Move to the Previous Control  SHIFT+TAB   

Read the Current Window Prompt 
and Text  

INSERT+TAB   

Move to the Next Page in a Multi-
page dialog box  

CTRL+TAB   

Move to the Previous Page in a 
Multi-page dialog box  

CTRL+SHIFT+TAB   

Read Default Button  INSERT+E   

Read dialog Box in Tab order  INSERT+B  

Information Layer Keystrokes 

The following table lists the keystrokes in the Information Layer 
(INSERT+I). 

Description  Command   
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Description  Command   

Obtain PAC Mate Omni Version 
Information  

INSERT+ENTER, A   

Query Battery Power Status  INSERT+ENTER, L   

Network Adapter IP Address 
Information  

INSERT+ENTER, N   

Read Window Title  INSERT+ENTER, T   

Read Entire Window  INSERT+ENTER, W   

Obtain Font Information  INSERT+ENTER, F   

Read the Default Button in a 
dialog box  

INSERT+ENTER, E   

Synthesizer and Braille Language 
Currently in Use  

INSERT+ENTER, C   

Synthesizer and Braille Language 
Configured as Primary  

INSERT+ENTER, P   

Synthesizer and Braille Language 
Configured as Secondary  

INSERT+ENTER, S  

Settings Layer Commands 

The following table lists the keystrokes in the Settings Layer (INSERT+S). 

Description  Command   

Increase Volume  INSERT+S, UP ARROW   

Decrease Volume  INSERT+S, DOWN ARROW   

Increase Speech Rate  INSERT+S, RIGHT ARROW   

Decrease Speech Rate  INSERT+S, LEFT ARROW   

Adjust Keyboard Echo  INSERT+S, K   
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Description  Command   

Adjust Screen Echo  INSERT+S, S   

Adjust Punctuation Level  INSERT+S, P   

Adjust Graphics Verbosity  INSERT+S, G   

Open Dictionary Settings dialog 
box  

INSERT+S, D   

Toggle Braille Study Mode  INSERT+S, B   

Toggle Keyboard Lock  INSERT+S, C   

Change Voice Language  INSERT+S, L   

Change Braille Language  INSERT+S, T 

Mute Speech  INSERT+S, M   

Start/Toggle ActiveSync Remote 
PAC Mate  

INSERT+S, R   

Exit Settings Layer after making a 
Change (volume, rate, graphics 
verbosity, keyboard echo, screen 
echo, and punctuation level)  

FN Key  

Keystrokes for Reading and Navigating Text 

The following table lists the keystrokes for reading and navigating text. 

Description  Command   

Prior Character  LEFT ARROW or INSERT+M   

Next Character  RIGHT ARROW or 
INSERT+PERIOD   

Current Character  INSERT+COMMA   

Current Character Phonetic  INSERT+COMMA twice quickly   
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Description  Command   

ASCII Value of Current Character INSERT+COMMA three times 
quickly   

PriorWord  CTRL+LEFT ARROW or 
INSERT+J   

Next Word  CTRL+RIGHT ARROW or 
INSERT+L   

Current Word  INSERT+K   

Spell Current Word  INSERT+K twice quickly   

Prior Line  UP ARROW or INSERT+U   

Next Line  DOWN ARROW or INSERT+O   

Current Line  INSERT+UP ARROW or 
INSERT+I   

Prior Sentence  INSERT+Y   

Next Sentence  INSERT+N   

Current Sentence  INSERT+H   

Prior Paragraph  CTRL+INSERT+U   

Next Paragraph  CTRL+INSERT+O   

Current Paragraph  CTRL+INSERT+I   

Page Up  PAGE UP   

Page Down  PAGE DOWN   

Move to Beginning of Line  HOME   

Move to End of Line  END   

Move to Top of File  CTRL+HOME   
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Description  Command   

Move to Bottom of File  CTRL+END   

Read from Beginning of Line  INSERT+HOME   

Read to End of Line  INSERT+END   

Read Selected Text  INSERT+SHIFT+A   

Read the Top Line of the Active 
Window or dialog box  

INSERT+SHIFT+Y   

Read the Bottom Line of the 
Active Window  

INSERT+SHIFT+N  

Say All Commands 

The following table lists the keystrokes that are available during a Say All. 

Description  Command   

Start Say All  INSERT+DOWN ARROW or 
INSERT+A   

Rewind  LEFT SHIFT or LEFT ARROW   

Fast Forward  RIGHT SHIFT or RIGHT 
ARROW   

Increase Speech rate  PAGE UP   

Decrease Speech Rate  PAGE DOWN   

Increase Speech Volume  HOME   

Decrease Speech Volume  END   

Stop Say All  CTRL  
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Selecting, Copying, and Pasting 

The following table lists the keystrokes for selecting, copying, and pasting 
text. 

Description  Command   

Select Prior Character  SHIFT+LEFT ARROW or 
INSERT+SHIFT+M   

Select Next Character  SHIFT+RIGHT ARROW or 
INSERT+SHIFT+PERIOD   

Select Prior Word  CTRL+SHIFT+LEFT ARROW or 
INSERT+SHIFT+J   

Select Next Word  CTRL+SHIFT+RIGHT ARROW or 
INSERT+SHIFT+L   

Select Prior Line  SHIFT+UP ARROW or 
INSERT+SHIFT+U   

Select Next Line  SHIFT+DOWN ARROW or 
INSERT+SHIFT+O   

Select Prior Paragraph  CTRL+SHIFT+UP ARROW   

Select Next Paragraph  CTRL+SHIFT+DOWN ARROW   

Select Page Up  SHIFT+PAGE UP   

Select Page Down  SHIFT+PAGE DOWN   

Select to Beginning of Line  SHIFT+HOME   

Select to End of Line  SHIFT+END   

Select to Top of File  CTRL+SHIFT+HOME   

Select to Bottom of File  CTRL+SHIFT+END   

Select One Item in Listview  SPACEBAR   
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Description  Command   

Select Multiple Items in Listview 
Going Down  

SHIFT+DOWN ARROW   

Select Multiple Items in Listview 
going up  

SHIFT+UP ARROW   

Select Non-contiguous Items in 
List view  

Press and hold CTRL and press 
UP or DOWN ARROW to move 
up and down the list. Press 
SPACEBAR to toggle the 
selection.   

Select All  CTRL+A   

Read Selected Text  INSERT+SHIFT+A   

Copy Selected Text to Clipboard  CTRL+C   

Cut Selected Text to Clipboard  CTRL+X   

Paste From Clipboard  CTRL+V   

Delete Selected Text/Item  DELETE  

Advanced Keystrokes 

These commands give you the ability to explore Windows Mobile 
applications, but are not necessary for ordinary use of the PAC Mate 
Omni. They can also help you access certain Windows Mobile 
applications that are not fully accessible out of the box. 

Description  Command   

Activate JAWS Cursor  INSERT+P   

Activate Invisible Cursor  INSERT+P twice quickly   

Activate PC Cursor  INSERT+SEMICOLON   
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Description  Command   

Cycle Between Restriction 
Settings for the JAWS or Invisible 
Cursor When Active  

INSERT+R   

Route JAWS to PC  INSERT+LEFT BRACKET   

Route PC to JAWS  INSERT+APOSTROPHE   

Say Active Cursor and Position  ALT+DELETE   

Left Click  INSERT+8   

Adjust Graphics Verbosity  INSERT+S, G   

Open Graphics Labeler  INSERT+G   

Toggle Between Standard and 
Active Graphics Modes  

INSERT+4   

Say Foreground and Background 
colors at Active Cursor  

INSERT+5   

Say Currently Active Script and 
Application  

INSERT+Q   

Re-initialize Currently Active 
Scripts (for script development 
only)  

CTRL+INSERT+ESC  

Home Row Utility Keystrokes 

These commands allow JAWS scripters to retrieve the necessary 
information they need in order to script Windows Mobile applications. 

Description  Command   

Toggle Home Row Mode  INSERT+EQUALS   

Route JAWS to Home Row  HOMEROW+INSERT+LEFT 
BRACKET   
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Description  Command   

Initialize Home Row Position  HOMEROW+F5   

Read Current Home Row 
Window  

HOMEROW+F8   

Read Output Information for 
Current Home Row Window  

HOMEROW+F1   

View Output Information for 
Home Row Window in 
Message Box  

HOMEROW+INSERT+F1   

Set Output Mode for Home 
Row Window  

HOMEROW+F3   

Next Home Row Window  HOMEROW+TAB   

Prior Home Row Window  HOMEROW+SHIFT+TAB   

First Child Home Row 
Window  

HOMEROW+F2   

Move to Parent Home Row 
Window  

HOMEROW+SHIFT+F2   

Visibility Status of Current 
Window  

HOMEROW+F7   

Toggle Speaking Window 
Visibility  

HOMEROW+F6   

First Requested Attribute in 
Home Row  

HOMEROW+CTRL+GRAVE   

Last Requested Attribute in 
Home Row  

HOMEROW+CTRL+SHIFT+GRAVE  

Next Requested Attribute in 
Home Row  

HOMEROW+GRAVE   

Prior Requested Attribute in 
Home Row  

HOMEROW+SHIFT+GRAVE   
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Description  Command   

Set Attribute Mode in Home 
Row  

HOMEROW+F4  

Online Help 

The following table lists the keystrokes for navigating the PAC Mate 
Omni's online help. 

Note:  All of the following keystrokes, except for the Forward command, 
are also available in Internet Explorer Mobile and will be repeated 
in that section. 

Description  Command   

Back a Page  ALT+LEFT ARROW   

Forward a Page  ALT+RIGHT ARROW   

Next Link  TAB   

Prior Link  SHIFT+TAB   

List Links  INSERT+F7   

Move to Next Non-Linked Text  N   

Move to Prior Non-Linked Text  SHIFT+N   

List Headings  INSERT+F6   

Next Heading  H   

Prior Heading  SHIFT+H   

Move to First Heading  CTRL+HOME, H   

Move to Last Heading  CTRL+END, SHIFT+H  
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Navigating Tables in Online Help 

The following table lists the keystrokes for navigating tables in Online 
Help. 

Description  Command   

Read Current Cell  ALT+CTRL+C   

Next Cell  ALT+CTRL+RIGHT ARROW   

Prior Cell  ALT+CTRL+LEFT ARROW   

Cell Above  ALT+CTRL+UP ARROW   

Cell Below  ALT+CTRL+DOWN ARROW   

First Cell  ALT+CTRL+HOME   

Last Cell  ALT+CTRL+END  

File Explorer 

The following table lists the keystrokes specific to File Explorer. 

Description  Command   

Prior File/Folder  UP ARROW   

Next File/Folder  DOWN ARROW   

Open File/Folder  ENTER   

Up One Folder Level  LEFT ARROW   

Show By  CTRL+Y   

Sort By  CTRL+T  

Contacts 

The following table lists the keystrokes specific to Contacts. 
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Description  Command   

Create New Contact  CTRL+N  

Calendar 

The following table lists the keystrokes specific to the Calendar. 

Description  Command   

Open Calendar View  ALT+V   

Next Day  RIGHT ARROW   

Prior Day  LEFT ARROW   

Jump to Day of Week  ALT+S followed by 1 through 7   

Change Start or End Date of 
Appointment  

ALT+D (while on the Start or End 
fields)   

Change Reminder Time of 
Appointment  

ALT+T (while on the Reminder 
field)   

Change Reminder Increment of 
Appointment  

ALT+I (while on the Reminder 
field)  

Calendar View 

The following table lists the keystrokes for navigating in the Calendar 
View. 

Description  Command   

Open Calendar View  ALT+V   

Back One Day  LEFT ARROW   

Forward One Day  RIGHT ARROW   

Back One Week  CTRL+LEFT ARROW   

Forward One Week  CTRL+RIGHT ARROW   
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Back One Month  UP ARROW   

Forward One Month  DOWN ARROW   

Back One Year  CTRL+UP ARROW   

Forward One Year  CTRL+DOWN ARROW   

Jump to Day of Week  ALT+S followed by 1 through 7   

Close Calendar View  CLOSE button (ESC)  

Tasks 

The following table lists the keystrokes specific to Tasks. 

Description  Command   

Change Reminder Date  ALT+D (when on the Reminder 
field)   

Change Status of Selected Task  SPACEBAR  

Messaging 

The following table lists the keystrokes specific to Messaging. 

Description  Command   

Open Contacts  ENTER or F11 while in the To, 
Cc, or Bcc fields   

Read Spelling Error and 
Suggestion  

INSERT+F8   

Show By  CTRL+Y   

Sort By  CTRL+T   

Switch to Next Account  RIGHT ARROW   
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Description  Command   

Switch to Previous Account  LEFT ARROW  

Notes 

The following table lists the keystrokes specific to Notes. 

Description  Command   

Create New Text Note  CTRL+N   

Record a Voice Note  ALT+V, R   

Play a Voice Note  ALT+V, P   

Stop Recording or Playing a Voice 
Note  

ALT+V, S   

Show By  CTRL+Y   

Sort By  CTRL+T  

Internet Explorer Mobile 

The following table lists the keystrokes specific to Internet Explorer 
Mobile. 

Description  Command   

Read Address Bar  A   

Go to Address Bar  G   

Back a Page  ALT+LEFT ARROW   

Adjust JAWS HTML Settings  INSERT+V  
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Web Page Navigation Commands 

The following table lists the keystrokes for navigating Web pages in 
Internet Explorer Mobile. 

Description  Command   

Next Link  TAB   

Prior Link  SHIFT+TAB   

List Links  INSERT+F7   

Move to Next Non-Linked Text  N   

Move to Prior Non-linked Text  SHIFT+N   

List Headings  INSERT+F6   

Next Heading  H   

Prior Heading  SHIFT+H   

Move to First Heading  CTRL+HOME, H   

Move to Last Heading  CTRL+END, SHIFT+H   

Turn On Forms Mode  ENTER (while on a form control)   

Turn Off Forms Mode  INSERT+X   

Next Form Field  F   

Prior Form Field  SHIFT+F   

Go to First Form Field  CTRL+INSERT+HOME   

Go to Last Form Field  CTRL+INSERT+END  

Next Button B 

Prior Button SHIFT+B 

Next Combo Box C 
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Description  Command   

Prior Combo Box SHIFT+C 

Next Edit Field E 

Prior Edit Field SHIFT+E 

Next Radio Button R 

Prior Radio Button SHIFT+R 

Next Check Box X 

Prior Check Box SHIFT+X 

Table Navigation Commands 

The following table lists the keystrokes for navigating tables on Web 
pages in Internet Explorer Mobile. 

Description  Command   

Read Current Cell  ALT+CTRL+C   

Next Cell  ALT+CTRL+RIGHT ARROW   

Prior Cell  ALT+CTRL+LEFT ARROW   

Cell Above  ALT+CTRL+UP ARROW   

Cell Below  ALT+CTRL+DOWN ARROW   

First Cell  ALT+CTRL+HOME   

Last Cell  ALT+CTRL+END  

FSEdit 

The following table lists the keystrokes specific to FSEdit. 

Description  Command   
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Description  Command   

Create New File  CTRL+N   

Open File  CTRL+O   

Save File  CTRL+S   

Print File  CTRL+P   

Insert Date-Time  F12   

Insert Text From File  ALT+I, F   

Spell Check Document  F8   

Read Misspelled Word in Context INSERT+C   

Read Misspelled Word and 
Suggestion  

INSERT+F7   

Editing and Formatting Commands 

The following table lists the keystrokes for editing and formatting text in 
FSEdit. 

Description Command 

Find CTRL+F   

Find Next F3 

Replace CTRL+H 

Undo CTRL+Z 

Query Cursor Position  CTRL+SHIFT+W   
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Description Command 

Move Cursor Position  CTRL+SHIFT+G, XY (where X is 
a positive number indicating how 
far forward the cursor will move, 
or a negative number indicating 
how far back the cursor will move, 
and Y is the letter C for character, 
W for Word, or L for line – 
indicating the type of cursor 
movement)   

Set Mark  ALT+E, M   

Select to Mark  ALT+E, S   

Swap Cursor and Marked 
Position  

ALT+E, W   

Quick Select Word  ALT+Q, W   

Quick Select Sentence  ALT+Q, S   

Quick Select Line  ALT+Q, L   

Quick Select Paragraph  ALT+Q, P   

Quick Select Entire Document  ALT+Q, D   

Bold ALT+F, B   

Italic ALT+F, I   

Underline ALT+F, U   

Strikethrough  ALT+F, S   

Center ALT+F, C   

Left Justify  ALT+F, L   

Right Justify  ALT+F, R   

Set Font CTRL+SHIFT+F  
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FSCalc 

The following table lists the Keystrokes specific to FSCalc. 

Description  Command   

Clear Current Display  ALT+0   

Clear History  ALT+S, H   

Clear Variables  ALT+S, V   

Save Calculations to a File  CTRL+S   

Load History From File  CTRL+O  

Word Mobile 

The following table lists the keystrokes specific to Word Mobile. 

Description  Command   

New Document  CTRL+N   

Read Misspelled Word and 
Suggestion  

INSERT+F8   

Open Find and Replace dialog 
box  

CTRL+F   

Find Next  ALT+N   

Replace  ALT+R   

Replace All Occurrences  ALT+A   

Cancel Find and Replace  ALT+C   

Bold  ALT+F, B   

Italic  ALT+F, I   
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Description  Command   

Underline  ALT+F, U   

Undo  CTRL+Z  

Excel Mobile 

The following table lists the keystrokes specific to Excel Mobile. 

Description  Command   

Move to Next Cell in Row  TAB or RIGHT ARROW   

Move to Prior Cell in Row  SHIFT+TAB or LEFT ARROW   

Move to Next Cell in Column  DOWN ARROW   

Move to Prior Cell in Column  UP ARROW   

Up One Screen  PAGE UP   

Down One Screen  PAGE DOWN   

Move to Next Worksheet  CTRL+PAGE DOWN   

Move to Previous Worksheet  CTRL+PAGE UP   

Go to First Cell in Data Region  CTRL+HOME   

Go to Last Cell in Data Region  CTRL+END   

Select Entire Worksheet  CTRL+A   

Select Entire Column  CTRL+SPACEBAR   

Manual Select  SHIFT+LEFT, RIGHT, UP, DOWN 
ARROW   

Edit Current Cell  INSERT+F2   

Format Cell  CTRL+1   

Autosum a Range of Cells  ALT+EQUALS   
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Description  Command   

Insert Date  CTRL+SEMICOLON   

Insert Time  CTRL+SHIFT+SEMICOLON   

Find  CTRL+F   

Replace  CTRL+H   

Go To  CTRL+G   

Formula Mode  EQUALS  

Stopwatch 

The following table lists the keystrokes specific to the Stopwatch. 

Description  Command   

Start/Stop  S   

Reset  R   

Say Last Time  L   

Say Current Time  T   

Open Count Down dialog box  C  

Windows Media Player 

The following table lists the keystrokes specific to Windows Media Player. 

Description  Command   

Play/Pause  ENTER or CTRL+P   

Stop CTRL+S 

Fast Forward  CTRL+E   

Rewind  CTRL+W   
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Description  Command   

Previous Track  LEFT ARROW or CTRL+B   

Next Track  RIGHT ARROW or CTRL+F   

Mute Player Independently of 
JAWS  

CTRL+M   

Increase Player Volume 
independently of JAWS  

UP ARROW or CTRL+UP 
ARROW   

Decrease Player Volume 
Independently of JAWS  

DOWN ARROW or CTRL+DOWN 
ARROW   

Open Media Guide  CTRL+G  

Windows Live Messenger 

The following table lists the keystrokes specific to Windows Live 
Messenger. 

Description  Command   

Toggle Announcement of the 
Message Sender's Name  

INSERT+SHIFT+V   

Activate Pending Contact 
Notification  

CTRL+SHIFT+N  

Read Last Received Message GRAVE Key 
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D-pad Simulation Commands 

The d-pad simulation keys simulate the four-way navigation control found 
on most mainstream PDA or windows mobile phone devices. They 
perform the functions down, up, next, and back. These keystrokes are 
designed to be used in unsupported applications where you must use the 
JAWS cursor to navigate screens and activate controls. They are also 
used in applications that contain a reading area where Reader mode is 
active so you can scroll the screen to access additional text. When 
pressed, these keystrokes are passed directly to the application and 
perform what ever function is specified by the particular application, as if 
you performed the command using an actual d-pad control. For instance, 
in one program, the Next and Back buttons might switch between 
different windows, while in another, they may move between pages in a 
text view area. The following table lists the d-pad simulation keystrokes. 

Description Command 

Back ALT+LEFT ARROW 

Next ALT+RIGHT ARROW 

Up ALT+INSERT+UP ARROW 

Down ALT+INSERT+DOWN ARROW 

Audible Player 

The following table lists the keystrokes specific to Audible Player. 

Description   Command     

Play/Pause   CTRL+P or ENTER   

Rewind  LEFT ARROW   

Fast forward  RIGHT ARROW   

Increase volume while program is 
playing 

UP ARROW 
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Description   Command     

Decrease volume while program is 
playing 

DOWN ARROW 

Announce elapsed time ALT+SHIFT+T 

Announce program length ALT+T 

Announce program title INSERT+K 
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Appendix B: Special Considerations 

Lithium Polymer Battery 

Warning: This device has no user-serviceable components. Any 
unauthorized attempt to service or replace internal components by 
opening the case will void the product warranty.  

Incorrect battery usage may lead to the leakage of battery fluid, a 
bursting of the battery, or ignition of the battery. To prevent such 
accidents, observe the following precautions: 

 Do not carry or store battery together with necklaces, hairpins or other 
metal objects. 

 Do not disassemble or modify the battery. The battery contains safety 
and protection devices, which if damaged, may cause the battery to 
generate heat, explode or ignite. 

 In the event the battery leaks and the fluid gets into your eye, do not 
rub the eye. Rinse well with water and immediately seek medical care. 
If left untreated, the battery fluid could cause damage to the eye. 

 The temperature range over which the battery can be used is -4 
Degrees F (-20 degrees C) to 140 degrees F (60 degrees C). Use of 
the battery outside this temperature range may damage performance 
of the battery or may reduce its life expectancy. 

 The temperature range over which the battery can be charged is 32 
degrees F (0 degrees C) to 113 degrees F (45 degrees C). Charging 
the battery at temperatures outside this range may cause severe 
damage to the battery or reduce battery life expectancy. 

 Do not place the battery in or near fire, or in direct sunlight. Heating 
the battery can damage the safety circuitry, which can cause 
additional heating, rupture or ignition of the battery. 
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 When charging the battery, either use a specified battery charger or 
otherwise ensure the battery charging conditions specified by 
Freedom Scientific are met. These are: (Model #SB-123A0F-11)(Input 
100 – 250V ~ 47 – 63Hz 0.8A)(Output 12V – 3.0A) 

 Immediately discontinue use of the battery if, while using, charging or 
storing the battery, the battery emits an unusual smell, feels hot, 
changes color or shape, or appears abnormal in any other way. 

 Contact Freedom Scientific if any of these problems are observed. 

Note: Freedom Scientific assumes no liability for problems that occur 
when the safety precautions and warnings listed above are not 
followed. 

Protecting Your Hearing 

Avoid using headphones/earphones in noisy environments where you are 
likely to increase the volume. Using headphones/earphones at high 
volumes can transmit loud, high frequencies that cause hearing damage.  

To prevent listening fatigue, rest the ears in silence after long sessions 
with headphones.  

If you experience a ringing in your ears, reduce the volume or discontinue 
use, and if ringing persists, consult a physician. 
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Appendix C: Unsupported Items 

 FSEdit - .brl file format 

 FSEdit - WinPrint 

 Programs - Games - Solitaire, Jawbreaker 

 Programs - Pictures 

 Settings - Buttons dialog box - Up/Down Control page 

 Settings - Input dialog box - Input Method page 

 Settings - Input dialog box - Word Completion page 

 Settings - Input dialog box - Options page - Default zoom level for 
writing 

 Settings - Input dialog box - Options page - Default zoom level for 
typing 

 Settings - Input dialog box - Options page - Scroll upon reaching the 
last line 

 Settings - Sounds & Notifications dialog box - Sounds page - Enable 
Sounds for Screen taps 

 Settings - Sounds & Notifications dialog box - Notifications page - 
Display message on screen and Flash light notifications  

 Settings - Today dialog box - Appearance page 

 Word Mobile – View Menu - Zoom 

 Windows Media Player – Options dialog box – Video page – Play 
video in full screen combo box 

 Windows Media Player – Options dialog box - Skins page 
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Appendix D: Alpha Braille Reference 

 

A DOT 1 

B DOTS 1-2 

C DOTS 1-4 

D DOTS 1-4-5 

E DOTS 1-5 

F DOTS 1-2-4 

G DOTS 1-2-4-5 

H DOTS 1-2-5 

I DOTS 2-4 

J DOTS 2-4-5 

K DOTS 1-3 

L DOTS 1-2-3 

M DOTS 1-3-4 
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N DOTS 1-3-4-5 

O DOTS 1-3-5 

P DOTS 1-2-3-4 

Q DOTS 1-2-3-4-5 

R DOTS 1-2-3-5 

S DOTS 2-3-4 

T DOTS 2-3-4-5 

U DOTS 1-3-6 

V DOTS 1-2-3-6 

W DOTS 2-4-5-6 

X DOTS 1-3-4-6 

Y DOTS 1-3-4-5-6 

Z DOTS 1-3-5-6 
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Appendix E: Numeric Braille Reference 

 

1 DOT 2 

2  DOTS 2-3  

3  DOTS 2-5  

4  DOTS 2-5-6   

5  DOTS 2-6  

6  DOTS 2-3-5  

7  DOTS 2-3-5-6  

8  DOTS 2-3-6  

9  DOTS 3-5  

0  DOTS 3-5-6  
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Appendix F: Grade 2 Braille Reference 

 

about  ab 

above  abv 

according  ac 

across  acr 

after  af 

afternoon  afn 

afterward  afw 

again  ag 

against  ag(st) 

ally  DOT 6, DOTS 1-3-4-5-6 

almost  alm 

already  alr 

also  al 
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although  al(th) 

altogether  alt 

always  alw 

ance  DOTS 4-6, DOTS 1-5 

and  DOTS 1-2-3-4-6 

ar  DOTS 3-4-5 

as  z 

ation  DOT 6, DOTS 1-3-4-5 

bb  DOTS 2-3 

be  DOTS 2-3 

because  (be)c 

before  (be)f 

behind  (be)h 

below  (be)l 

beneath  (be)n 
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beside  (be)s 

between  (be)t 

beyond  (be)y 

ble  DOTS 3-4-5-6 

blind  bl 

Braille  brl 

but  b 

by  DOTS 3-5-6 

can  c 

cannot  DOTS 4-5-6, DOTS 1-4 

cc  DOTS 2-5 

ch  DOTS 1-6 

character  DOT 5, DOTS 1-6 

child  DOTS 1-6 

children  (ch)n 
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com  DOTS 3-6 

con  DOTS 2-5 

conceive  (con)cv 

conceiving  (con)cvg 

could  cd 

day  DOT 5, DOTS 1-4-5 

dd  DOTS 2-5-6 

deceive  dcv 

deceiving  dcvg 

declare  dcl 

declaring  dclg 

dis  DOTS 2-5-6 

do  d 

ea  DOT 2 

ed  DOTS 1-2-4-6 
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either  ei 

en  DOTS 2-6 

ence  DOTS 5-6, DOTS 1-5 

enough  DOTS 2-6 

er  DOTS 1-2-4-5-6 

ever  DOT 5, DOTS 1-5 

every  e 

father  DOT 5, DOTS 1-2-4 

ff  DOTS 2-3-5 

first  f(st) 

for  DOTS 1-2-3-4-5-6 

friend  fr 

from  f 

ful  DOTS 5-6, DOTS 1-2-3 

gg  DOTS 2-3-5-6 
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gh  DOTS 1-2-6 

go  g 

good  gd 

great  grt 

had  DOTS 4-5-6, DOTS 1-2-5 

have  h 

here  DOT 5, DOTS 1-2-5 

herself  h(er)f 

him  hm 

himself  hmf 

his  DOTS 2-3-6 

immediate  imm 

in  DOTS 3-5 

ing  DOTS 3-4-6 

into  DOTS 3-5, DOTS 2-3-5 
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it  x 

its  (x)s 

itself  (x)f 

ity  DOTS 5-6, DOTS 1-3-4-5-6 

just  j 

know  DOT 5, DOTS 1-3 

knowledge  k 

less  DOTS 4-6, DOTS 2-3-4 

letter  lr 

like  l 

little  ll 

lord  DOT 5, DOTS 1-2-3 

many  DOTS 4-5-6, DOTS 1-3-4 

ment  DOTS 5-6, DOTS 3-4-5 

more  m 
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mother  DOT 5, DOTS 1-3-4 

much  m(ch) 

must  m(st) 

myself  myf 

name  DOT 5, DOTS 1-3-4-5 

necessary  nec 

neither  nei 

ness  DOTS 5-6, DOTS 2-3-4 

not  n 

o’clock o’c 

of  DOTS 1-2-3-5-6 

one DOT 5, DOTS 1-3-5 

oneself (one)f 

ong  DOTS 5-6, DOTS 1-2-4-5 

ou DOTS 1-2-5-6 
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ought  DOT 5, DOTS 1-2-5-6 

ound DOTS 3-6, DOTS 1-4-5 

ount  DOTS 4-6, DOTS 2-3-4-5 

ourselves (ou)rvs 

out  DOTS 1-2-5-6 

ow  DOTS 2-4-6 

paid  pd 

part  DOT 5, DOTS 1-2-3-4 

people  p 

perceive  p(er)cv 

perceiving p(er)cvg 

perhaps  p(er)h 

question  DOT 5, DOTS 1-2-3-4-5 

quick  qk 

quite  q 
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rather  r 

receive  rcv 

rejoice rjc 

rejoicing rjcg 

right  DOT 5, DOTS 1-2-3-5 

said sd 

sh  DOTS 1-4-6 

shall  DOTS 1-4-6 

should  (sh)d 

sion  DOTS 4-6, DOTS 1-3-4-5 

so  s 

some  DOT 5, DOTS 2-3-4 

spirit  DOTS 4-5-6, DOTS 2-3-4 

st  DOTS 3-4 

still  DOTS 3-4 
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such  s(ch) 

th  DOTS 1-4-5-6 

that  t 

the  DOTS 2-3-4 6 

their  DOTS 4-5-6, DOTS 2-3-4-6 

themselve
s  

(the)mvs 

there  DOT 5, DOTS 2-3-4-6 

these  DOTS 4-5, DOTS 2-3-4-6 

this  DOTS 1-4-5-6 

those  DOTS 4-5, DOTS 1-4-5-6 

through  DOT 5, DOTS 1-4-5-6 

thyself  (th)yf 

time  DOT 5, DOTS 2-3-4-5 

tion  DOTS 5-6, DOTS 1-3-4-5 

to  DOTS 2-3-5 
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today  td 

together  tgr 

tomorrow  tm 

tonight  tn 

under DOT 5, DOTS 1-3-6 

upon  DOTS 4-5, DOTS 1-3-6 

us  u 

very  v 

was  DOTS 3-5-6 

were  DOTS 2-3-5-6 

wh  DOTS 1-5-6 

where  DOT 5, DOTS 1-5-6 

which  DOTS 1-5-6 

whose  DOTS 4-5, DOTS 1-5-6 

will  w 
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with  DOTS 2-3-4-5-6 

word  DOTS 4-5, DOTS 2-4-5-6 

work  DOT 5, DOTS 2-4-5-6 

world DOTS 4-5-6, DOTS 2-4-5-6 

would Wd 

you Y 

young  DOT 5, DOTS 1-3-4-5-6 

your  yr 

yourself  yrf 

yourselves  yrvs 
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Appendix G: Computer Braille Reference 

 

: (Colon) DOTS 1-5-6 

; (SEMI COLON) DOTS 5-6 

( (LEFT 
PARENTHESIS) 

DOTS 1-2-3-5-6 

) (RIGHT 
PARENTHESIS) 

DOTS 2-3-4-5-6 

< (LESS THAN) DOTS 1-2-6 

> (GREATER 
THAN) 

DOTS 3-4-5 

{ (LEFT BRACE) DOTS 2-4-6 

} (RIGHT BRACE) DOTS 1-2-4-5-6 

[ (LEFT 
BRACKET) 

DOTS 7-2-4-6 

] (RIGHT 
BRACKET) 

DOTS 7-1-2-4-5-6 

/ (SLASH) DOTS 3-4 
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\ (BACKSLASH) DOTS 7-1-2-5-6 

* (ASTERISK OR 
STAR) 

DOTS 1-6 

# (NUMBER 
SIGN) 

DOTS 3-4-5-6 

$ (DOLLAR) DOTS 1-2-4-6 

? (QUESTION 
MARK) 

DOTS 1-4-5-6 

+ (PLUS) DOTS 3-4-6 

- (HYPHEN, 
DASH, MINUS) 

DOTS 3-6 

= (EQUALS) DOTS 1-2-3-4-5-6 

& (AND OR 
AMPERSAND) 

DOTS 1-2-3-4-6 

! (EXCLAIM) DOTS 2-3-4-6 

% (PERCENT) DOTS 1-4-6 

' (APOSTROPHE) DOT 3 

" (QUOTE) DOT 5 
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, (COMMA) DOT 6 

. (PERIOD) DOTS 4-6 

@ (AT) DOTS 7-4 

_ (UNDERLINE) DOTS 7-4-5-6 

^ (CARET) DOTS 7-4-5 

~ (TILDE) DOTS 4-5 

` (GRAVE 
ACCENT) 

DOT 4 
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Appendix H: PAC Mate Omni with a Braille 
Display 

Using PAC Mate Omni with a braille display offers tactile access to your 
PAC Mate Omni. This multi-sensory approach adds an essential 
dimension to your computer experience as you are able to navigate and 
read braille with your display. Currently PAC Mate Omni supports the 
PAC Mate Portable Braille Display and the Freedom Scientific Focus 
Series Display. 

To mute the synthesizer on the PAC Mate Omni QX, press INSERT+S, 
M. This setting is retained when you turn off the PAC Mate Omni. 

PAC Mate Portable Braille Display 

The PAC Mate Portable Braille display is detachable and USB-driven, 
allowing you to: 

 Use the braille display at your workstation with your desktop PC. 

 Use the braille display on the go with your laptop. 

 Remove the braille display and carry only the PAC Mate Omni or 
laptop when you want to travel light. 

To attach and detach the Braille Display: 

1. Reach for the latch on the underside of the unit with your right 
finger and pull toward the right side of the unit. This releases a 
catch allowing the bottom cover piece to be removed. 

2. Grasp the middle of the top cover of the PAC Mate Omni Braille 
Display in the indent just above the braille cells. This will release 
its top cover and you can pull it off the display. 

3. Align the newly exposed portion of the braille display with the 
opening in the QX400 and push them together until you hear the 
latch click into place. You now have an integrated braille display 
unit. 
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At this point, you may want to configure the Braille Settings dialog box in 
PAC Mate Omni. 

Display settings are quickly accessed with hotkeys and navigation is 
provided via Whiz Wheels, cursor routing buttons and left and right 
advance.  

Hotkeys 

The PAC Mate Omni Braille Display uses fourteen hotkeys to access 
various braille display options. The fourteen hotkeys are in the top row of 
buttons and consist of seven buttons on either side of the center mark. To 
help you locate and distinguish each hotkey there are markers on the 
display's surface furthest away from you. The buttons to the left of center 
are numbered from left to right as 1, 2, 3, 4, 5, 6, and 7 and the buttons to 
the right of center are numbered as 8, 9, 10, 11,12, 13, and 14. The 
remaining buttons to the left and right of the hotkeys are the advance 
buttons.  

The PAC Mate Omni Braille Display uses one and two layer command 
sequences to set braille display options. You must toggle into the second 
layer with hotkey 12 before and each time you execute a second layer 
command. While you are working with the display, you can turn on 
keyboard help (INSERT+F1, K) and review the function of each hotkey.  

The hotkeys are described in the table below.  

 

Hotkey First Layer Command  Second Layer Command 

1 

Turn On Braille Auto 
Advance Mode  
(Press any cursor routing 
button to turn off) 

 

2     
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Hotkey First Layer Command  Second Layer Command 

3 
Route Braille Cursor to 
PC Cursor 

  

4 Active Follows Braille   

5 Braille Follows Active 

Toggle Compressed 
Spacing  
(8 - Unlimited Pixels per 
Space) 

6 

Show Top of Active 
Window or 
Beginning of Structured 
Line  

Route JAWS Cursor to PC 
Cursor 

7 SHIFT TAB   

8 TAB   

9 
Show Bottom of Active 
Window or End of 
Structured Line  

Toggle 6 / 8 Cell Braille 

10 
Grade 2 (Contracted 
Braille) 

Toggle Line, Structured, 
and Speech Box Modes 

11 
Translate Word 
(Expand grade 2 symbol 
to edit word) 

  

12 
Toggle between Layers 1 
and 2 

Display Braille Layer Help 
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Hotkey First Layer Command  Second Layer Command 

13 
Decrease Auto Advance 
Rate 

  

14 
Increase Auto Advance 
Rate 

  

Whiz Wheels 

The braille display Whiz Wheels are used to quickly move through files, 
dialog boxes and menus. In addition, each wheel can be set 
independently for added functionality.  

Files 

In text files, the Whiz Wheels are used to move by line, sentence, or 
paragraph. Pressing down on either Whiz Wheel toggles it between line, 
sentence, and paragraph or panning mode. Rolling the Whiz Wheel 
towards you moves you downward, while rolling the Whiz Wheel away 
from you moves you upward. With panning mode, rolling the Whiz Wheel 
one "click" towards you pans right one-display length, while rolling the 
Whiz Wheel one "click" away from you pans left one-display length.  

Menus 

In menus, roll a Whiz Wheel toward you to move down through the menu 
or roll it away from you to move up through the menu. Press down on the 
Whiz Wheel to select a menu item. 

Dialog boxes 

In dialog boxes, rolling the wheel towards you moves you forward through 
the controls, while rolling the wheel away from you moves you backwards 
through the controls. Depending on the control, the Whiz Wheels function 
differently when pressed.  
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 For list views, combo boxes, radio buttons, tree views and check box 
control groups: pressing the Whiz Wheel down puts it in List Mode. In 
this mode, rolling the Whiz Wheel lets you scroll through the items. To 
exit List Mode, press down on the Whiz Wheel again. 

 For individual check boxes or buttons, pressing the Whiz Wheel down 
toggles the check box state or activates the button. 

Cursor Routing Buttons 

The display has cursor routing buttons, which is the row of buttons 
immediately above each braille cell. Press a cursor routing button to 
move the cursor to that point or select a link in a web page or e-mail 
message. To help you locate and route your cursor there are markers at 
every fifth cell along the display surface nearest you. 

Right and Left Advance 

The left and right advance allow you to move through your files one 
display length at a time. To advance left, press any of the buttons to the 
left of the hotkey area. To advance right, press any of the buttons to the 
right of the hotkey area.  

Focus Series Display 

The PAC Mate Omni interfaces with the Focus display through the Focus 
Braille Display Options dialog box. This dialog box, in addition to the 
Braille Settings dialog box, lets you configure PAC Mate Omni. 

Focus Braille displays have eight braille keys, a SPACEBAR, LEFT and 
RIGHT SHIFT keys, two advance bars, two programmable function 
buttons, and cursor routing keys. In addition, it features Whiz Wheels that 
allow for quick navigation in files, menus, and lists. 

The Focus Braille display also has commands that are separated into 
convenience commands, braille commands, Windows commands and 
JAWS commands.  
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Convenience Commands 

These commands are the most common functions and are performed 
right from the braille display. The tables below list the convenience 
commands available with Focus connected to PAC Mate Omni 

PAC Mate Omni and Windows Commands 

Description Braille Sign Braille Dot 
Positions 

Start Menu ST Sign DOTS 3-4 

Keyboard Help TH Sign DOTS 1-4-5-6 

ENTER ENTER ENTER 

BACKSPACE DOT 7 DOT 7 

the CLOSE button 
(ESC) 

Z DOTS 1-3-5-6 

Navigation Commands 

Description Braille Sign Braille Dot 
Positions 

TAB DOTS 4-5 DOTS 4-5 

SHIFT+TAB B DOTS 1-2 

PAGE UP K DOTS 1-3 

PAGE DOWN DOTS 4-6 DOTS 4-6 
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Description Braille Sign Braille Dot 
Positions 

HOME DOT 2 DOT 2 

END DOT 5 DOT 5 

Top Of File L DOTS 1-2-3 

Bottom of File DOTS 4-5-6 DOTS 4-5-6 

Next Document 
Window 
(CTRL+TAB) 

W DOTS 2-4-5-6 

Braille Next Line DOT 4 DOT 4 

Braille Prior Line A DOT 1 

Move Left on 
Current Line 

DOT 3 DOT 3 

Move Right on 
Current Line 

Capital Sign DOT 6 

Cursor Commands 

Description Braille Sign Braille Dot 
Positions 

PC Cursor P DOTS 1-2-3-4 

JAWS Cursor J DOTS 2-4-5 
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Description Braille Sign Braille Dot 
Positions 

Route Braille to 
Active Cursor 

R DOTS 1-2-3-5 
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Braille Commands 

Description Braille Sign Braille Dot 
Positions 

Tether Braille to 
Active 

T DOTS 2-3-4-5 

Braille Follows 
Active 

F DOTS 1-2-4 

Toggle Line, 
Structured, 
Speech Box Mode 

M DOTS 1-3-4 

Braille Commands 

These commands change the settings used to format, translate, or 
present information on your display. Press SPACEBAR first, hold it down, 
and then press the other key or keys that are part of the command. The 
table below lists the braille commands available with Focus and the PAC 
Mate Omni 

Description Braille Sign Braille Dot 
Positions 

Braille Top of 
Window 

L CHORD DOTS 1-2-3 
CHORD 

Braille Bottom of 
Window 

DOTS 4-5-6 
CHORD 

DOTS 4-5-6 
CHORD 

Adjust Braille 
Options 

B CHORD DOTS 1-2 
CHORD 
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Description Braille Sign Braille Dot 
Positions 

Grade 2 Expand 
Current Word 

T CHORD DOTS 2-3-4-5 
CHORD 

Grade 2 
Translation 

G CHORD DOTS 1-2-4-5 
CHORD 

Toggle Marking M CHORD DOTS 1-3-4 
CHORD 

Toggle 8 Pixels 
per Space 

P CHORD DOTS 1-2-3-4 
CHORD 

Toggle 8/6 Dot 
Braille 

8 CHORD DOTS 2-3-6 
CHORD 

Color Marking 
Assign 

C CHORD DOTS 1-4 
CHORD 

Change Cursor 
Shape 

SH Sign CHORD DOTS 1-4-6 
CHORD 

Restrict Braille 
Cursor 

R CHORD DOTS 1-2-3-5 
CHORD 

Windows Commands 

All Windows commands use the LEFT SHIFT key as part of the 
command. 

The tables below list all the Windows commands available with Focus 
and the PAC Mate Omni  
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Navigation and Editing Commands 

Description Braille Sign Braille Dot 
Patterns 

ALT+TAB LEFT 
SHIFT+DOTS 4-5 

LEFT 
SHIFT+DOTS 4-
5 

Paste from 
Clipboard 

LEFT SHIFT+V LEFT 
SHIFT+DOTS 1-
2-3-6 

Copy to Clipboard LEFT SHIFT+C LEFT 
SHIFT+DOTS 1-
4 

Cut to Clipboard LEFT SHIFT+X LEFT 
SHIFT+DOTS 1-
3-4-6 

Undo LEFT SHIFT+Z LEFT 
SHIFT+DOTS 1-
3-5-6 

Delete LEFT SHIFT+D LEFT 
SHIFT+DOTS 1-
4-5 

Selection Commands 

Description Braille Sign Braille Dot 
Patterns 

Select Next 
Character 

LEFT 
SHIFT+DOT 6 

LEFT 
SHIFT+DOT 6 
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Description Braille Sign Braille Dot 
Patterns 

Select Prior 
Character 

LEFT 
SHIFT+DOT 3 

LEFT 
SHIFT+DOT 3 

Select Next Line LEFT 
SHIFT+DOT 4 

LEFT 
SHIFT+DOT 4 

Select Prior Line LEFT 
SHIFT+DOT 1 

LEFT 
SHIFT+DOT 1 

Select to End of 
Line 

LEFT 
SHIFT+DOT 5 

LEFT 
SHIFT+DOT 5 

Select from Start 
of Line 

LEFT 
SHIFT+DOT 2 

LEFT 
SHIFT+DOT 2 

Select from Top LEFT SHIFT+L LEFT 
SHIFT+DOTS 1-
2-3 

Select to Bottom LEFT 
SHIFT+DOTS 4-
5-6 

LEFT 
SHIFT+DOTS 4-
5-6 

Select Next 
Screen 

LEFT 
SHIFT+DOTS 4-6 

LEFT 
SHIFT+DOTS 4-6 

Select Prior 
Screen 

LEFT SHIFT+K LEFT 
SHIFT+DOTS 1-3 

Select All LEFT 
SHIFT+FOR Sign 

LEFT 
SHIFT+DOTS 1-
2-3-4-5-6 
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Selecting with the Cursor Routing keys 

To select with the cursor routing keys, press and hold down LEFT SHIFT, 
then press the cursor routing key above the text where you wish to begin 
the selection. Release both keys. Move to where you wish to end the 
selection, and press LEFT SHIFT plus the cursor routing key at that 
location. Use any navigation commands to move from the begin point to 
the end point of the text you are selecting, even the Whiz Wheels, but if 
the window containing the text scrolls, this affects what information is 
selected. 

JAWS Commands 

All JAWS commands use the RIGHT SHIFT key as part of the command. 

The tables below list all the JAWS commands available with Focus and 
the PAC Mate Omni. 

General Commands 

Description Braille Sign Braille Dot 
Patterns 

Screen Sensitive 
Help 

RIGHT SHIFT+1 RIGHT 
SHIFT+DOT 2 

List System Tray 
Icons 

RIGHT SHIFT+K RIGHT 
SHIFT+DOTS 1-3 

Refresh Screen RIGHT SHIFT+Z RIGHT 
SHIFT+DOTS 1-3-
5-6 

Say Font RIGHT SHIFT+F RIGHT 
SHIFT+DOTS 1-2-
4 
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Description Braille Sign Braille Dot 
Patterns 

Window Keys 
Help 

RIGHT SHIFT+W RIGHT 
SHIFT+DOTS 2-4-
5-6 

Read Current 
Window 

RIGHT SHIFT+B RIGHT 
SHIFT+DOTS 1-2 

Default Button in 
Dialog box 

RIGHT SHIFT+E RIGHT 
SHIFT+DOTS 1-5 

Shut Down JAWS RIGHT SHIFT+4 RIGHT 
SHIFT+DOTS 2-5-
6 

Cursors 

Description Braille Sign Braille Dot 
Patterns 

Route JAWS to Pc RIGHT 
SHIFT+DOTS 3-6 

RIGHT 
SHIFT+DOTS 3-6 

Route PC to 
JAWS 

RIGHT 
SHIFT+ING Sign  

RIGHT 
SHIFT+DOTS 3-
4-6 
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Utilities 

Description Braille Sign Braille Dot 
Patterns 

Graphics Labeler RIGHT SHIFT+G RIGHT 
SHIFT+DOTS 1-
2-4-5 

JAWSFind RIGHT SHIFT+F 
CHORD 

RIGHT 
SHIFT+DOTS 1-
2-4 CHORD 

JAWSFind Next RIGHT 
SHIFT+DOTS 2-5 

RIGHT 
SHIFT+DOTS 2-5 

Whiz Wheels 

The Focus Whiz wheels are used to quickly move through files, dialog 
boxes, lists, and menus. In a file, move by line, sentence, or paragraph. 
In a dialog box, move between the available controls, and even interact 
with them. In a menu, move up and down through the menu items. 

Advance Bars 

The Focus advance bars are used to move forward or back through a file 
or while in line mode. Press the Left Advance bar to move left on a line or 
back through a document. Press the Right Advance bar to move right on 
a line or forward through a document. 

Cursor Routing Keys 

The Focus displays provide cursor routing keys above each braille cell. 
Press a cursor routing key to move the cursor to that point, or to select a 
link in a web page or e-mail message. In line mode, press a cursor 
routing key to open a menu or select menu items. 

Press the Right General Display button with a cursor routing key to 
simulate a right mouse click at that location.  
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